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Preface

This document describes the components of the Argus Safety Solution application.


Where to Find More Information


Oracle Help Center

The latest user documentation for Oracle Health Sciences products is available at http://docs.oracle.com/en/industries/health-sciences/.


My Oracle Support

The latest release notes, patches and white papers are on My Oracle Support (MOS) at https://support.oracle.com. For help with using MOS, see https://docs.oracle.com/cd/E74665_01/MOSHP/toc.htm.





Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.








1 Updated Documentation

To ensure that you have access to the most updated and relevant information, we have made the following changes to this guide:

	
Removed excessive introductory material, self- explanatory, and intuitive fields.


	
Restructured the overall flow of the guide from a menu-based organization to one that is task- based.


	
Put the procedures first in each section.


	
Removed unnecessary screenshots, and added relevant ones where needed.









2 Getting Started

­


Log In

	
Open Microsoft Internet Explorer and enter the Uniform Resource Locator (URL) for Argus Safety Web in the address bar.


	
When the Argus login screen opens, enter your username and password.


	
Select the appropriate database from the Database drop-down list and click Login.




	
The number of times a user is permitted to enter an incorrect password is configurable. The default is 3.


	
The date/time format reflects the 24-hour format used by the Web server.


	
Oracle recommends that you use the Application Access portlet to open the Argus Safety application for different enterprises, as it takes care of closing the previous enterprise before opening the new one.








Change Your Password

	
Hover over the Utilities menu and click Change Password.

[image: Surrounding text describes utilities.gif.]

	
Enter your current password in the Old Password field.


	
Enter the new password in the New Password field and confirm the new password by re-entering it.


	
Click OK to change your password.







	
Note:

When you log on to the system for the first time, change the password that has been assigned to you. LDAP users cannot change their passwords.











Know Your Basics


View your Personal Argus Status

The Personal Argus Status page displays a list of cases assigned, Contact Log entries, and Action Item entries for the logged-in user.

If the Personal Argus Status Page is not your default home page, hover over Utilities and click Personal Argus Status.

[image: Screen capture showing the Personal Argus Status page]


	Section Name	Field/ Control Name	Description
	Search Case	Case Quick Launch	Enables you to enter a case number when searching for a specific case.
	Cases Assigned/
Contact Log Entries/

Action Item Entries

	(Country) Case Number	Displays the name of the country the case belongs to. The Country is in brackets.









Use the Quick Launch Toolbar

The Quick Launch Toolbar is on the top right side of the screen.

[image: Surrounding text describes quicklaunchtbr.gif.]

Place the cursor over each icon to view the tool tip, which describes the role of each icon.




	
Note:

Shortcut keys are driven by a combination of common profile switches and menu access rights. For example, the Case Save shortcut/icon is visible only to users who have been granted access to save the case in the group configuration. If the menu option is disabled in the group configuration for a user, the respective shortcut /icon is also removed.
Certain shortcuts/icons such as Field Validation are enabled only through a common profile switch. Shortcuts/icons that are driven through common profile switches are global to all users and are not controlled by group permissions.










	Icon	Tool Tip	Description
	[image: Surrounding text describes newcaseform.gif.]
	
New Case from Image

	
Displays a new case from an image.


	[image: Surrounding text describes newcase.gif.]
	New Case	Displays the Initial Case Entry dialog box.
	[image: Surrounding text describes opencase.gif.]
	Open Case	Displays the Case Search dialog box.
	[image: Surrounding text describes closecase.gif.]
	Close Case	Closes the case.
	[image: Surrounding text describes printcase.gif.]
	Print Case	Displays the Case Print dialog box.
	[image: Surrounding text describes savecase.gif.]
	Save Case	Saves the case with any changes made.
	[image: Surrounding text describes forwardcase.gif.]
	Forward Case	Displays the Case Routing dialog box and enables you to forward the case.
	[image: Surrounding text describes returncase.gif.]
	Return Case	Displays the Case Routing dialog box and enables you to return the case.
	[image: Surrounding text describes worklist.gif.]
	
Worklist

	Displays the Worklist dialog box.
If no default Worklist option is defined, then Worklist - New is displayed.


	[image: Surrounding text describes lockcase.gif.]
	Lock Case	Displays the Case Lock or Case Unlock dialog box. This icon is enabled only for a Local PRPT Case and only if the case has been globally locked.
	[image: Surrounding text describes locking.jpg.]
	Local Lock	Displays the Local Lock or Local Unlock dialog box to allow a user to locally lock or unlock a case.
This icon is a toggle icon that allows users to do a Local lock or Local unlock depending on the global and local lock state of the case.

Note: This icon is visible only for a Local Potential Reportable case (Local PRPT case) and only if the case has been globally locked.


	[image: Surrounding text describes medicalreview.gif.]
	Medical Review	Displays the Medical Review dialog box.
	[image: Surrounding text describes codereview.gif.]
	Coding Review	Displays the Coding Review dialog box.
	[image: Surrounding text describes draftreport.gif.]
	Draft Report	Displays the report list of all Expedited reports.
	[image: Surrounding text describes icsrcheck.gif.]
	ICSR Check	Performs the function that prints the ICSR report - DTD Length Check Warnings and ICSR report - DTD Validation.
	[image: Surrounding text describes validacheck.gif.]
	Validation Check	Performs case validation.









Use Field Validations

	
Click the icon next to a field to view its corresponding Field Justification dialog box.


	
This dialog box asks the user for a justification to perform the selected action. To overwrite the warning:

	
Enter a specific reason.

OR


	
Select a standard reason from the message box.





	
Click OK to overwrite the field justification warning.

The orange icon changes to green.




The fields in the application are either required or optional. Each field type displays with a different colored icon:

	
A red icon signifies that a mandatory validation check has not been met.You need to correct the data entry before being able to save a case.


	
An orange icon signifies that an optional validation check has not been met. You need to enter justification but can then continue to save the case.








Use Field-Level Help

To get information about a particular field on the Case Form, double-click the label associated with the field.

For instance, on the Case Form, you can double-click the Country label to obtain information about the field.





Acceptable Date Formats

Several fields in the Argus Safety user interface enable you to enter dates. Fields that accept full dates appear in the dd-mmm-yyyy format.

Appropriate formats for entering English dates are as follows:

	
DDMMMYYYY where MMM is the three-character abbreviation for the month (such as MAR, APR, JUN, and so on.)


	
DDMMMYY where MMM is the three-character abbreviation for the month and YY is the two-digit numeric value for the year (such as 09, 10, and so on.)


	
DDMMYYYY where MM is the two-digit value identifying the month (such as 01 = January, 02 = February, etc.) and YYYY is the four-digit value for the year.




The dot (.), dash (-) and backslash(/) are acceptable separators.





Enter Reasons for Missing (Null Flavor) Data

Null Flavors are used to describe the reason for missing data. ICH E2B (R3) and regional agencies such as CBER, EMA, and PMDA have published guidelines on the allowed Null Flavors for various fields that are part of the E2B (R3) report. A Null Flavor set is a collection of Null Flavors. Sets are provided by default for various combinations of Null Flavors in the Flexible Re-categorization Codelist.

Null Flavor data can be selected for fields in the Case Form by clicking on the Null Flavor button ( [image: graphic]) next to the fields. On clicking the button, a drop-down list appears and allows you to select Null Flavor data as configured in the Field Properties Configuration in the Argus Console. The background color of the NF button changes (from grey to blue) when a Null Flavor is selected from the drop-down list.

When the Case Form field has data and the user clicks the button, the system displays a warning message that data will be cleared on switching to the Null Flavor field. The data is cleared or retained based on user confirmation. When data pertaining to the field is received, Null Flavor data can be overwritten by actual data by clicking the NF button.





Use Other (than English) Language Text

Certain fields on the Case Form let you enter text in languages other than English. The non-English text that is entered in these fields can also appear on Expedited reports.

To enter text in a language other than English:

	
Click the English language icon.


	
Use the pane associated with English to enter the English language text. Select the required language from the Select Language drop-down list to enter text in that language.


	
After completing text entry, you can perform a spell-check for the text.




The table below displays icons representing different languages.


	Icon	Language
	[image: Surrounding text describes english.gif.]
	



English
	[image: Surrounding text describes japaneseflagicon.gif.]
	



Japanese
	[image: Surrounding text describes globalflagicon.gif.]
	



Language other than English or Japanese









Case Form User Preferences

The application lets you return to the same location on the tab after you tab to a different form. For example, you are on the 8th reporter in the Reporter Section on the General tab and move to another location in the application. When you return to the General tab, you are automatically directed to the 8th Reporter as it was the last Case Form location that you accessed before moving out of the Case Form.

User preferences are only applicable during the same session for a case, irrespective of the case status (read-only or editable). If you exit from the case and open a new case, the user preferences are reset.


Quick Navigation

Each page displays the navigation flow to access the page.


	Shortcut Key	Output
	CTRL+SHIFT+#	Directs to the tab indicated by the # entered. (1=General tab, 2=Patient tab, etc.)
	ALT+SHIFT+#	Directs to the sub-tab as indicated by the # entered (= Product 1, Product 2, etc.)
Note: The maximum # for the sub entities is 10 which pertains to ALT+SHIFT+1 for the first entity within the tab till ALT+SHIFT+0 for the 10th entity within the tab.











Dynamic Workflow Indicator

Dynamic workflow indicators track the amount of elapsed time it takes to complete a workflow step.

	
The first number represents the time left or exceeded for a given workflow step.


	
The second number indicates the time left until the reporting deadline.


	
Time is expressed in days (d), hours (h), and minutes (m) respectively.




The icon changes based on the amount of elapsed time for the workflow step.


	Icon	Denotes
	Traffic Light	No status can be indicated. For example, when no timing is defined in the workflow.
	Red Traffic Light	The timing has been exceeded.
	Yellow Traffic Light	The timing is in danger of being exceeded.
	Green Traffic Light	The timing is in good standing.






If the time to complete the case process exceeds the allocated time, the value is displayed in red with the time displayed as a negative value. Only archived, locked cases do not display the dynamic workflow indicator.







View the User Login List

To view a list of all current users and their security levels, hover over the Utilities menu and select User Login List.

This screen also displays a list of all currently logged in users.

	
To sort the displayed records, click a column heading.

By default, the list appears in the ascending order based on the Login time.


	
To reset a user, select a user, and click Reset User. All selected users in the list are reset.


	
You cannot reset your login username.








Clear Cache

To remove all previously stored information, hover over the Utilities menu and select Clear Cache.





Integrate with Argus Insight

Argus Safety has the following integration points with Argus Insight. All these integration points operate within the same enterprise for both Argus Safety and Argus Insight.




	
Note:

This integration is available only to Argus Enterprise Edition users.







	
Case Series Sharing: In case of multi-tenant installations, Argus Safety > Case Actions > Case Open screen > Result from Argus Insight imports the active case series for the user from the same enterprise partition of Argus Insight which is currently opened in Argus Safety.


	
Argus Insight Application Launch: The Argus Insight button in the main Argus Navigation bar opens the same enterprise partition of Argus Insight which is currently opened in Argus Safety.





Sharing a Case Series in Argus Safety with Argus Insight

	
In the Case Search dialog box, search for and select a case in Argus Safety.


	
Open Argus Insight.

The system writes the case series belonging to the alert to the Argus case-sharing table.


	
Check Make Active from Argus to make the Case Search dialog box case series active in Argus Insight.


	
If Argus Insight was already open, the Active Case series in Argus Insight is replaced with cases from Argus.





Sharing a Case Series in Argus Insight with Argus Safety

A case series can be made available from Argus Insight through Active Case series. To share a case series in Argus Insight with Argus Safety:

	
Hover over the Case Actions menu and click Open.


	
Click Result from Argus Insight to create a search result with the same cases as the Active Case series in Argus Insight.











3 Enter Case Data


Create a New Case

When your company receives new adverse event data, you need to enter this information and check for duplicates before saving a case in Argus Safety.

You can create a new case using either of the following:

	
Case Actions > New


	
Case Actions > New case from Image


	
Worklist > Intake





Enter a New Case

From the Initial Case Entry form, you can decide to bookin a case before entering further case information in the Case Form.


To enter a new case:

	
On the Home page, hover over the Case Actions menu and click New.

[image: Surrounding text describes newcase.jpg.]

	
On the Initial Case Entry page, enter the mandatory information (fields with a red flag) and click Continue.


	
Click Search to confirm this is not a duplicate case.


	
A list of cases that match the criteria you entered on the form is displayed. Review the search results for a duplicate case.

If a duplicate case exists, open the case to enter further information related to the existing case. Click the link associated with the case.


	
If a duplicate case does not appear, click Continue in the Initial Case Entry form to display the BookIn and Attachments and References sections.

When a duplicate search is performed, the system remembers the results until the user logs out of the system or performs a duplicate search again. When the Bookin screen is opened, the search results from the last search are displayed again.


	
Enter relevant information in the following sections:

	
Under Reported Causality, select the reporter's assessment of causality. The causality relationship is the causal relationship between the clinically most important event and the suspect drug that is entered in the Initial Case Entry form.


	
For Seriousness Criteria, check the appropriate checkboxes to indicate the seriousness of the case, as appropriate.


	
Attachments and References

	
To insert a file attachment

1. Click Add on the Attachments and References tab.

2. Enter the Classification and Description, as applicable. Select File Attachment from the drop-down list and click Add.

3. On the File Attachment -Webpage dialog box, double-click Browse and navigate to the relevant file. Click B.

Contact your system administrator to configure this location.


	
To insert a URL Reference

1. Select URL Reference from the drop-down list.

2. Enter the URL after http://.


	
To search for and insert a document

1. Select Documentum Link and click Add.

2. The Document Lookup dialog box is displayed.

You can search for a document from the database by specifying a search criterion in this dialog box.








	
Click BookIn.

Once clicked, this button is hidden from the screen. The button is enabled only if the Save operation fails or when the case is booked-in successfully.


	
If Argus has been configured to generate a case number automatically, it is generated now.

If the case number is not automatically generated, enter it according to your company guidelines.


	
When the case creation message appears, click Yes.

Note: If you click Yes, the Case Form page appears. You can now enter case data.

If you click No, the case is saved and closed. You can open the case and enter data at any time.








Initial Case Entry—Fields Descriptions


	Field	Description
	Initial Receipt Date	Enter the complete date on which your company became aware of the case. The Receipt Date cannot be entered as a partial date.
	Central Receipt Date	Enter the date on which this information was received by Central Safety.
	Country of Incidence	Select the country where the adverse event occurred. This may or may not be the reporter's or the patient's country of residence.
	Report Type	Select the item that best describes the type of report. This determines the fields that are made available for entering case information.
The report type also impacts duplicate search. For example, selecting Sponsored Trial makes the Study ID and Protocol ID fields available. The Administrator can adjust the information in this list.


	Study ID(applicable to clinical trial cases only)	Click Select to choose the study ID from the Clinical Trial Selection dialog box.
	Center ID
(applicable to clinical trial cases only)

	Click Select to choose the Center ID from the Clinical Trial Selection dialog box.
	Initial Justification	The values of this field are configurable through the standard Argus Justifications dialog box. This field is reflected in the General tab of the Case Form and is also available for duplicate searching for cases.
Click the green dot to view and select justifications from the Argus Justification dialog box.


	Product Name	If the adverse event(s) are associated with more than one product, each additional product can be added from the Case Form.
Enter the most suspect product here. Click Select to search for a product from the Trade Name Product Lookup dialog box. Several items are automatically entered on the Case Form based on the product selected here.


	Generic Name	This field can be used to enter the generic name of the product. This field is automatically entered when a product is selected from the Trade Name Product Lookup dialog box.
	Description as Reported	Enter a brief verbatim description from the reporter describing the event that is most clinically important in the case. The icon denotes that the event is encoded. Click the icon to populate the MedDRA hierarchy dialog box.
	Onset Date/Time	Enter the date/time for the onset of adverse event symptoms.
	ID	Enter the value to search for a Reporter Reference number, Case Reference, and Case number.
	Journal and/or Title	These items are applicable to literature cases only. Click Select to choose a journal and/or title from the Literature Reference dialog box. The Administrator can adjust this list.









Check for Duplicates

	
Enter the information related to the case in the Initial Case Entry form.


	
Select the Receipt Range Limits option to check for duplicates based on the dates entered in the form and click Search.


	
Review the list to determine if any case contains duplicate information.





Receipt Range—Fields Descriptions


	Field	Description
	No date	90 days before System Date and 2 days after System Date.
	Full Onset Date	10 days before Onset date and 90 days after Onset Date.
	Full Initial Receipt Date	60 days before Initial Receipt Date and 60 days after Initial Receipt Date.
Note: This default date range for searching on Initial Receipt Date can be disabled by un-checking the Receipt Range Limits option on the Initial Case Entry dialog box.


	Partial Onset Date	Based on the Full Date Range - if only the year is entered, the date range becomes: 10 days before the end of the previous year and 90 days after end of the year.
	Partial Initial Receipt Date	Based on Full Date Range - if only a year is entered, the date range becomes: 60 days before end of previous year and 60 days after the end of the year.









	
Note:

	
If an Initial Receipt Date is not entered but an Event Onset Date has been entered, the search will default to look for cases with Initial Receipt Dates 10 days before and 90 days after the Event Onset Date. This feature can be disabled directly on the dialog box by un-checking the Receipt Range Limits checkbox. If you do not check anything, the default date range is 90 days before and 2 days after the current date.


	
The Duplicate Search permits you to sort in ascending or descending order in the duplicate search results. You can also use wild card searches on all text fields in the Book-in dialog box.


















Initial Case Entry—BookIn Dialog Box

	
You can enter the attachment classifications and their descriptions on the Initial Case entry dialog box.


	
The values entered in the Classifications and Description fields are transferred after the cases have been booked.


	
When you book in a clinical trial case and select a study where the country of incidence value does not match the list of countries defined in the study configuration, a warning message appears.


	
Right-click on the row, and select one of the following:

	
View Case Summary


	
Print Medical Summary—Displays the Medical Summary report PDF. If you do not have access to the Medical Review dialog box, the Medical Summary Report is hidden.


	
Print—Launches the Case Form print dialog box. If you do not have access to the Case Form print dialog box, the Print Case option is hidden.












Accept Incoming Cases

The Intake function enables you to view a list of incoming attachments in the Worklist View where you can select an attachment for creating a case.

To access the Worklist > Intake page, hover over the Worklist menu and select Intake.


View Pending Case

Use Pending tab to create case, reject case, and so on. Users other than Workflow Managers can reject a case from the Intake Worklist.


	Field	Description
	Priority	Allows the user to view the priority of the case.
	Case Type	Allows the user to view report type information.
	Reporter Type	Allows the user to view the Reporter type for the Primary Reporter in the case.
	Group	Allows for the current group owner or Unassigned group to be assigned to the case.
	Central Site/LAM Site	Allows the user to view the current Site (Argus or Affiliate) of the Case - If there are no Sites defined, ALL users can access the case attachment.
	Attachment Name	Allows the user to view the attachment which is associated to the case.
	Classification	Allows the user to view the attachment classifications which is associated with the case.
	Description	Allows the user to view the attachment description which is associated with the case.









View Rejected Cases


	Field	Description
	Generic Name	Allows the user to view the generic name of the suspect product in question.
	F, LT or H	Allows the user to view Fatal, Life-Threatening or Hospitalized cases.
	Reporter Type	Allows the user to view the Reporter type for the Primary Reporter in the case.
	Country	Allows the user to view the Country of incident.
	Classification	Allows the user to view the attachment classifications which is associated to the case.
	Description	Allows the user to view the attachment description which is associated to the case.
	Rejected Date	Allows the user to view the date when the case was rejected.













Enter General Information

The General tab captures the case information in categorized sections for category-specific information. It also enables you to enter or view information such as type of report, literature information, and so forth.

	
If a priority has not been assigned to a case, the Case Priority field is hidden.


	
If a case owner has been assigned to the case, the name of the case owner appears at the top of the Case form.





General Information—Field Descriptions


	Field/Control Name	Description
	Report Type	Select a report type that determines availability of fields relating to clinical studies and literature references.
The Clinical Study reports prompts for information relating to the study, and literature-based reports enable to select the journal and reference on which the case is based.


	Country	Select the country where the adverse event occurred.
	Initial Receipt Date	Enter the date your company became aware of the case. Argus Safety uses this date throughout all reports.
This date can be changed only prior to regulatory report submission.


	Central Receipt Date	Enter the date on which this information was received by Central Safety.
	Medically Confirm	Specify whether the case was medically confirmed or not, by a healthcare professional.
	Initial Justification	Enter the initial justification reason.
The entry in this field is displayed as per the reason entered when the case is being booked in.


	Amendments/Follow-ups	On sorting by Follow-up received dates, the serial number still displays the order of entering the follow-ups. The follow-up information can be sorted by:
	
Serial Number


	
Follow-up Received Date


	
Central Received Date




Click on the header to sort in ascending or descending order. By default, the sorting is in descending order of the Follow-up Received Date.


	Follow-up Received Date	To enter the date on which amendment or follow-up information was received by your company, click Add.
You can select whether the case has significant follow-up information by confirming the message: Is this follow-up significant?.

When sorting on follow-ups, by default, the dates are sorted in descending order.


	Safety Received	Enter the date on which follow-up information was received by Central Safety. This field is disabled for an amendment and any prior data in this field is cleared.
	Significant	Check this checkbox if the follow-up is significant.
	Data Clean up	Check this checkbox to mark the follow-up as a Data Clean up version.
This version is used in the Data Lock Point for Case Versioning in and System Reports.

This field is disabled for an amendment and any prior data in this field is cleared.


	Amendment	Specify if the case was updated without adding any new information.
This checkbox is enabled irrespective of whether the Significant checkbox is checked.


	Amendment/Follow-up Justification	Select a pre-defined justification for Amendment or Follow-up.
Click the icon to view the standard justifications dialog box. The justification entered in the Amendment field is also populated in this field.

You can select a pre-defined justification from this dialog box or enter a new justification.


	Case Requires Follow-up	Check this checkbox if the case requires follow-up information.
	Classification	Select up to 50 case classifications used to categorize a case.
To enter additional case classifications, click Add.

When the Classifications field is hidden, the classification section is hidden on the Case Form











Enter Study Information

	
To choose from the available list of study information, click Select.


	
In the Clinical Trial Selection dialog box, enter Project, Study, and Center information.

The Clinical Trial Selection dialog box allows you to select a clinical trial from the list configured by the administrator.


	
Click Search.




	
Tip:

To broaden the search results, enter as little information as possible. Select the required clinical study and study center, and click Select.








	
Choose the study information from the list, and click Select.

The details of the selected Study Information are added to each field in the Study Information section.





Study Information—Field Descriptions


	Field/Control Name	Description
	Project ID	Enter the Project ID, or select one from the list.
Selecting a Project ID automatically creates items in the Study ID list.


	Study Phase	Enter the Study Phase for the configured study.
This field is pre-populated if you select a Study with an already-configured Study Phase.


	Blinding Status	The status is auto-populated based on the type of study.
You need special access rights to use any of the Broken By entries.

Note: The Unblind Case dialog box appears when you try to unblind a study. For Not Blinded studies, saving the case or generating a report, you can enter the actual drug (vs. placebo) given to the patient.


	Observe Study Type	The value selected from this drop-down list is populated in the Case Form Study Section when the Clinical Study is selected.
	Unblinding Date	Auto-populates when the blinding status is changed to 'Broken by Sponsor' or 'Broken by Investigator'.
If you double-click the date in this item, the Unblind Case dialog box is displayed. If the date of unblinding is more recent than the date for the most significant follow-up information, an automatic follow-up is generated.

Unblinded date is not editable in the Unblind case dialog box when blinded status is changed to 'Broken by Sponsor' whereas it is editable when the blinded status is changed to 'Broken by Investigator'.













Enter Reporter Information

Enter the information about the person providing the case-related information.

	
The Reporter Rearrangement dialog box displays the number of Reporters present in the case. It displays the First Name and Last Name, followed by the Reporter Type in brackets, as entered in the reporter information dialog box.


	
To view all the Reporters, click the Quick Launch icon.


	
To view the details of the selected Reporter tab, click a Reporter Name.


	
To add a new reporter, click the New tab. You can add a maximum of 100 reporters.


	
The Primary Reporter is identified by the Reporter icon on the Reporter Information tab.





Add Reporter Information

	
In the Reporter Information section, click Select.


	
In the Reporter Lookup dialog box, enter the search criteria, and click Search.

	
All filter criteria you have entered on the Reporter Look Up dialog box are saved as user preferences while it populates the reporter information on the General tab.

	
If you have reporter information in the case, the information appears in the Reporter Lookup dialog box and search is performed.


	
After performing the search the search criteria is retained as user preferences. The next time you perform a search, these preferences appears.


	
When you log out, the user preferences are retained and are available the next time you log in.


	
To clear all the values in the filter elements, click Clear.










	
Tip:

You can choose to search either by Search Cases or by Search List Maintenance.








	
From the search results, select the reporter information, and click Select.

The selected, pre-defined information is added to the fields.








Reporter Information—Field Descriptions


	Field/Control Name	Description
	Reporter Notes	Click this button to enter free text notes relating to this reporter.
This field supports multiple language entry. Click on a flag, select the language tab, and enter information.


	Institution ID	Enter the reporter's institution ID.
This field value is populated based on the Institution ID selected for the Reporter from the Reporter Lookup dialog box. This field also allows to manually enter or update the value directly in the Case Form irrespective of the value specified in the Institution field for the reporter.

Manually entered Institution and Institution ID field values are allowed in the Reporter Information section even if they are not specified or linked to each other as per Console Institution code list.


	Protect Confidentiality	If this checkbox is checked, the name and address of the reporter do not appear on regulatory reports and the reporter's information displays "NAME AND ADDRESS WITHHELD".
The 'MSK' null flavor appears in the eVAERS report when this checkbox is checked. MSK is populated only when the data element contains some data and is not null.


	Primary Reporter	Only one primary reporter is permitted per case. The primary reporter is the reporter whose name appears on the regulatory reports. The tab that identifies the primary reporter is displayed in blue as compared to the other reporter tabs.
	Correspondence Contact	If this checkbox is checked for a reporter, the reporter's address information is used in letters. You can select more than one reporter as the correspondence contacts for the case.
	Reporter ID	If known, enter the Reporter ID. This completes the Case Form reporter fields.
	Reporter Type, Report Media, and Intermediary	These lists are maintained by the administrator.
	(New) Tab	Creates details for a new reporter.











Enter Literature Information

You can enter a literature reference for a case manually or you can enter pre-defined literature information.

	
From the list of available literature, click Select.


	
In the Literature Reference dialog box, select the a reference in the list, and click Select.

The details of the selected literature information are added to each field in Literature Information.










Enter Patient Information

You can enter patient information such as the patient's past medical history and current conditions, and laboratory tests and test results.


Enter Current Medical Status

	
In the Case Form > Patient tab, click Current Medical Status.


	
From the items in the form, select the options that apply to the patient.

If you don't know whether a particular condition applies for the patient, select Unk.


	
To save the current medical status, click OK.








Copy Patient Information from Reporter Information

If the patient and the reporter are the same person, the reporter information entered in the General tab can be copied to the Patient tab.

To copy the reporter information, click Patient Info From Reporter.





Patient Information—Field Descriptions


	Field/Control Name	Description
	Child only Case	If this checkbox is checked, then the pregnancy [Detail] button is accessible from the Parent information tab only and no longer through the Patient tab directly.
	Current Medical Status	Captures details about the history and the current condition of the patient from the dialog box.
The items that appear in the Current Medical Status dialog box are mapped to the fields for the German BfArM tab on the Analysis tab. Changing the values on the BfArM tab does not affect these items.


	Name
(Title, First Name, MI, Last Name)

	During book-in, the patient name is transferred to the relevant name and initials fields. If the Patient Name or Initials are three characters or less, this is transferred to the Initials field.
	Number of Patients	Enter the number of patients involved in the adverse event.
	Pat. ID	Enter the Patient Identifier number.
Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection dialog box.


	Protect Confidentiality	If this checkbox is checked, the patient's name and address will not appear on any of the regulatory reports and the patient's information will show the word PRIVACY.
The 'MSK' null flavor appears in the eVAERS report when this checkbox is checked. MSK is populated only when the data element contains some data and is not null.


	Randomization #	Determines which drug was administered to the patient during the course of the study.
Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection dialog box.


	Sponsor Identifier	Enter the Sponsor Identifier of the patient.
Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection dialog box.











Enter Patient Notes

Click [image: graph] to enter free text notes relating to the Patient. If there is no text data for Patient Notes, from the NF drop-down list, select Null Flavor.

Note: This field supports multiple language entry. Click on a flag icon to enter data in different languages.

[image: graph2] Icon is displayed when there is no data in Patient Notes and NF data.

[image: graph3] Icon is displayed when there is data in Patient Notes or NF data.





Enter Patient Details

Enter patient information, including pregnancy data.


Table 3-1 Patient Details—Field Descriptions

	Field	Description
	
Ethnic Group

	
Enter the patient's ethnic group such as Hispanic or Latino, Not Hispanic or Latino, and so on.


	
Military Status

	
Enter the details of the Military status of the Patient such as Active Duty, Reserve, National Guard, TRICARE Beneficiary, and so on.


	
Race

	
Select the patient's race. You can capture up to 5 Race using the Add and Delete buttons.

Note: You cannot select the same Race more than once.









Enter Pregnancy Information

	
From the Pregnant drop-down list, select Yes.

This field is shown as active only after the Gender field in this section is selected as Female.

The Pregnancy Information section appears.


	
Enter the available pregnancy information in the form.


	
Click OK.


	
In the Neonate Information section:

	
To delete neonate information, right-click the neonate, and click Delete.


	
The changes are tracked to the neonate information in the audit log.







The following list describes the fields on the Pregnancy Information and Neonate form.


	Field/Control Name	Description
	Gestation Period	Enter the gestation period when the reaction or event was observed in the foetus. Select a unit for the gestation period from the accompanying drop-down list.
	Number of Fetus	Enter data for a baby who is born to the patient.
To make an additional entry, click New.


	Prospective/Retrospective	Select if the information was Prospective or Retrospective.
A prospective information is one where the company hears of the case before the baby is born to the patient who took the drug.

In a retrospective case, a company gets to know after the baby is born.













Enter Patient Death Details

Enter information about the death of a patient.


Event Death Details—Field Descriptions


	Field/Control Name	Description
	Autopsy Done?	If Autopsy Done is set to No or Unknown, the Autopsy Results Available is shown as No.
	Autopsy Results Available?	The Autopsy Results Available? field is enabled only if the Autopsy Done? field is marked as Yes.
If Autopsy Results Available? is changed to No, and Autopsy Result rows exist, you will be asked to delete the rows first. Click Yes to delete the data.


	Add	Click this button to add a Cause of Death and Autopsy Results row.
Note: You can add multiple records, up to 50 entries.


	Delete	Deletes a highlighted row.











Enter Other Relevant History

Enter information related to past drugs administered on Patient, and Current Medical condition of the patient.

To copy the Other Relevant History rows, select the row, and click Copy.


Other Relevant History—Field Descriptions


	Field/Control Name	Description
	Copy	Enables you to copy a row. After you copy the row, the focus will be on the newly copied row.
	Add	Enables you to add a row to the relevant history. After you add the row, the focus will be on the new row.
	Delete	Enables you to delete a row from the relevant history.
	Start Date	Enter the start date of the condition. You can enter a partial date if the actual date is not available. You can also choose not to enter a date.
Note: If you click Add but do not enter a date, the Date column is removed.

Once the date is entered and a test is associated with the date, you cannot clear the date but can only modify it. To remove the date column, individually delete all the cells in that Date column.


	Stop Date	Enter the stop date of the condition. You can enter a partial date if the actual date is not available. You can also choose not to enter a date.
If you select Ongoing as Yes or Unknown, the Stop date is cleared and disabled.


	Age and Units	Age and Age units are enabled only for condition type with Patient Other Relevant Therapy being set.
	Family History	Check this checkbox, if this relevant history is reported to be present in another family member. The Family History checkbox is enabled only for Condition types that are mapped to &rsquor;Medical History Episode' in the Condition Type codelist.
	Substance Information	Displays the substance name, term ID, and strength unit of the Product separated by commas. If there are multiple records, they are displayed in subsequent rows.
	Name Part	Displays the name part and name part type information. If there are multiple records, they are displayed in subsequent rows.
Click Name Part button to enter Product Name Part Type and Product Name Part details.


	Product Name Parts Information	Displays the Product Name Part information. Enabled only for condition type with Patient Other Relevant Therapy being set.
	Version	Displays the Date or Version of the Product Identifier. Enabled only for condition type with Patient Other Relevant Therapy being set.
	Coded PT/Description of condition LLT/Indication PT/Reaction PT	Enter a term to describe the condition. You can either manually encode or auto-encode, if you have been so configured by the Administrator.
In manual mode, type the description (for example, Fever).

In Auto-encode mode, enter a partial description and press ENTER or TAB.

The appropriate coding dialog box appears.

In either mode, click Encode and modify the encoding. If the condition type is historical drug, the encoding will be done with WHO drugs.


	Product Identifier Type/ Product Identifier Version/ Notes	Displays the type of Product Identifier such as MPID, PhPID, and so on. Enabled only for condition type with Patient Other Relevant Therapy being set.
Displays the Date or Version of the Product Identifier. Enabled only for condition type with Patient Other Relevant Therapy being set.


	Encode	Click this button to encode the term. Encode is used in multiple contexts such as coding with MedDRA for reactions and indications, and coding for products using WHO drug browser.
Note: To view the complete MedDRA hierarchy for the encoded term, click the encoding status icon.


	Indication PT and Reaction PT	This field is visible on the case form only if the condition type selected in the List maintenance is Patient Other Relevant Therapy.
	Ongoing	Indicates whether the condition is continuing. If it is set to Yes or Unknown, the Stop date is disabled.











Enter Lab Data—Lab Test and Test Results

The maximum number of lab test data on the Case Form is 1500.

	
To enter a Lab Test Name:

	
Click Add Test.


	
Enter the description, and click Search.


	
From the search result, select a name.





	
To select a Lab Test Group, click Select.

A list of lab test that matched the selected group appears.

If lab test data is already in the case form, the lab test group is appended after the last lab test.


	
To add more rows of Lab Test Data, right-click on an empty cell, and click Add.


	
To copy a Lab Test Data, right-click the row to be copied, and click Copy.


	
To delete a Lab Test Data, right-click the row to be deleted, and click Delete.


	
To arrange entries in a specific order, click the Order icons.


	
You can sort Lab data in chronological order by Date of the Test and alphabetically by the Test Name.

If there are partial dates entered, the date is displayed at the beginning of the month, and year for the date entered.


	
To view the hierarchy of the Event Term, click the view icon.


	
To view Notes in a Zoom dialog box, click the view icon.


	
To arrange the Lab Test Data, click the arrow button to move data to left or right.

This is available only when the Lab Test is entered for the same date.





Lab Data—Field Descriptions


	Field/Control Name	Description
	Norm Low/Norm High	The Test Name list can retrieve details of the normal range for the test selected (if the administrator has entered the normal range into the list). Otherwise, enter the values manually.
	Result/Units	Enter the test result, including units, and select a term to describe the qualitative assessment of the results. The administrator can modify the list of possible assessments.
If test results cannot be expressed in Result/Units or Assessment, enter the data in Notes field.

You must enter Lab test result by using Results/Unit, Assessment or Notes fields, and not in all the fields. Regulatory agencies may send rejection for ICSR if data is sent in all formats.


	Assessment	Select a qualitative assessment term to describe the lab test results.
	More Info Available	Check this checkbox, if there is additional information is available for this Lab test in Additional Info tab.











Enter Additional Test Information

Enter additional information about any relevant tests, such as toxicology.





Enter Parent Information

The Parent Information tab is similar to the Patient tab.

However, in the Other Relevant History section, the Family history, Age, and Units fields are unavailable.







Enter Product Information

Enter and view details for products and dosage regimens. This tab contains the name of the drug that has been entered here. For Blinded Studies, the Blinded Product Name field appears in the tab.

If you do not have access to view unblinded information on the Case Form, some of the fields are hidden.

If the study has been unblinded and a study drug had been selected, the selected Study Drug Name is displayed. You cannot view unblinded information and the tab continues to show the Blinded Product Name.

You can enter details of more than one product and more than one dosage regimen for a company product for which multiple licenses exist (for example, drug and vaccine, or drug and device).

Based on the type of license (drug, vaccine, or device), different views are available in the Products tab. If the selected item is not a company product or if a license for a company product does not exist, all three views are always available.


Search for Products


Product Browser based search

	
In the Products tab, click Select.

The Product Browser dialog box appears.


	
Click the displayed entities.

The hierarchy above and below the entity being searched is also displayed. For example, if Product Name is searched, it displays the Product Name as well as the Family Name and Trade Name.


	
Search for Products based on the following criteria:

	
Ingredient


	
Family


	
Product Name


	
Trade Name—Searches the License Trade Name





	
To select all the search criteria, select the Full Search checkbox, and click Select.


	
Select a product from the search result.


	
To remove the entered search criteria, click Clear.





WHO Drug Browser based search

	
To open the WHO Drug Coding dialog box, click Encode.


	
From the Case Form Configuration dialog box where the Dictionaries are selected for encoding, select either the WHO Drug B format or the WHO Drug C format.


	
Enter the search criteria, and click Search.

You can search a product based on:

	
Trade Name


	
Formulation/Strength (sequence 3 and sequence 4) of the product


	
Country—The Sales Country Code of the Product as defined in the WHO Dictionary


	
Generic.

The following criteria are not available for display or searching in the WHO Drug B Format:

	
Formulation


	
Country


	
Strength


	
Generic


	
Medicinal Product ID


	
Product Type








	
To copy the selected drug to the Product tab, click Select.


	
To close the selection dialog box without making any updates to the Product tab, click Cancel.


	
To perform a full search from the WHO Drug browser, select Full Search.

	
By default, a like search is performed (e.g., CUREALL%)


	
You can use the percent (%) sign to perform wildcard searches


	
If you click Full Search, the a full search is performed (e.g., %CUREALL%)





	
You can also search for drug formulation and country. This option is available only if you select the WHO Drug C format.


	
To clear the search criteria you entered, click Clear.


	
You can sort the results on all the fields.








Enter Time Measurement Information

You can enter seconds in the following fields:

	
Argus > Case Actions > Open > (Select a Case) > Event tab > Event sub tab > {event description} sub tab > Event Information section (middle of screen)

	
Onset From Last Dose field


	
Duration field


	
Onset Latency field





	
Argus > Case Actions > Open > (Select a Case) > Products tab > Product sub tab > {Product Name} sub-sub tab (drug) > Dosage Regimen section (lower 1/3 of screen)

	
Duration of Regimen





	
Argus > Case Actions > Open > (Select a Case) > Products tab > Product sub tab > {Product Name} sub-sub tab (drug) > Product Details section (lower 1/3 of screen

	
Duration of Administration


	
Time between First Dose/Primary Event


	
Time between First Dose/Primary Event





	
Any number following by the letter "s" defaults to "#sec."


	
The seconds entered in the form are interpreted in the following formats, where:

# is a number from 0 to 9

#s—changes the format to # sec.

# s—changes the format to # sec.

# sxx

where:

x is other letters—that changes the format to # sec


	
The Temporal View and the Case Form printout display the seconds.


	
The E2B import and export case functions support seconds and M2 Validation for the defined fields.








Enter Drug Information


Product Information—Field Descriptions

This section enables you to enter information about the drug being used for the case.


	Field/Control Name	Description
	Product Information	

	Product Name	Enter the name of the product using the Select button or by entering a partial product name. Type a partial product name and press TAB. This displays the Product Selection dialog box.
If only one product is found, this information is entered without showing the dialog box. If no match is found in the company product list, the WHO Drug Dictionary is searched for a possible match through the WHO Drug Dictionary dialog box. If a match is still not found, the text you initially typed in, is used as is.

Note: If the study is blinded, the Blinded Name of the clinical study is displayed in this field. After unblinding, the selected study's Product Name for Unblinded cases is not shown.


	Select	Displays the product selection dialog box.
Select a product from the list of company products click Select.

The relevant fields are added to the Case Form.


	Encode	Click Encode to retrieve the code.
	Suspect/ Concomitant/ Treatment	Make a selection for the product you are entering. The drug types indicate the involvement of the product with the adverse event(s) reported for the case.
Suspect indicates that the product may have caused the adverse event(s).

Concomitant indicates drugs that are taken with the suspect drug.

Treatment is the drug taken to treat the adverse event.


	Generic Name	Enter the generic name of the drug in a manner similar to the Product Name. If the study is blinded, the Generic Name is replaced with the Study Name of the product.
Note: This name is entered based on the selected company product.

If the study is blinded, the Blinded Name of the clinical study is displayed in this field. After unblinding, the selected study's Product Name for Unblinded cases is not shown.


	Product Identifier	Displays the type of Product Identifier such as MPID, PhPID, and so on.
	OTC Product	Check this checkbox if the product administered was an over-the -counter (OTC) product.
	Compounded Product	Check this checkbox if the product administered was compounded.
	Company Drug Code	Displays the licensed country for the selected company product.
	Obtain Drug Country	Country the drug is licensed in.
	Drug Code	Enter the WHO-DRUG code.
	WHO Medicinal Product ID	Displays the Medicinal ID associated with the selected WHO drug. The WHO Drug code used to identify the drug.
Note: This ID is populated only if a WHO-drug is selected.


	Formulation	Select the formulation of the product. The form in which the drug was administered (liquid, tablet, capsule, and so on.)
Note: This field is entered based on the product. Contact your administrator to adjust this list.


	Drug Authorization Country	The country where the drug is licensed.
	Market Authorization Holder	Captures the name of the Marketing Authorization Holder of the product that was administered.
	Authorization Type	Captures the Authorization Type of the product that was administered such as IND, BLA, PLA, and so on.
	Authorization Number	Captures the Authorization Number or License Number of the product that was administered.
	Manufacturer	A different Manufacturer can be selected from the drop-down list and can still be kept as a company product.
	Concentration	Indicates the amount of the drug that was administered.
After a drug and formulation have been entered, select the concentration from the list, or enter the concentration.

If this information is changed manually, the product is marked as a non-company product.

Note: This field is entered based on the chosen product. The concentration cannot be modified for a Study drug.


	Interaction?	Indicates whether the case involves a drug interaction.
	Contraindicated?	Indicates whether the drug was administered contrary to its indication.
	Drug Not Administered	Check this checkbox if no drug was administered on the patient.
	Substance Information	

	Substance Name	Displays the Ingredient's name.
	Strength	The Strength of the substance used in the Product.
	Units	The drug unit (such as mg, tsp, and so on).









	
Note:

Drug Authorization Country, Authorization Type, Authorization Number and Marketing Authorization Holder data are populated from the Argus Console for company products.
For Study Products, the system populates the Authorization Type, Authorization Number, and Marketing Authorization Holder data based on the Primary license number selected in the Argus Console > Studies Configuration. When unblinded at the case level, Authorization Type and Authorization Number data is not accessible for users with restricted access to unblinded data.














Enter Product Indications

Enter information about the indicator of the adverse event, like:

	
Reported Indication—Reported reaction


	
Coded Indication—Code for the reaction




Both the values could be the different or same.


Table 3-2 Product Indication—Field Description

	Field/Control Name	Description
	
Reported Indication

	
By default, the value of this field is populated with the Product Indication from the Product Configuration, if set up. If not, you can enter a term into the Reported Indication field.

Note: Argus Safety automatically encodes this information. You can also click Encode to open the coding dictionary dialog box.


	
Coded Indication

	
This field is populated with the encoded term when you enter data in the reported indication field and tabs out.


	
Encode (Indication)

	
Opens the MedDRA Browser with the term already populated from the Coded Indication field.

To view the complete MEDDRA hierarchy for the encoded term, click the Encoding Status icon.


	
Add

	
Adds a new Indication row.

Only two indications are visible at a time


	
Delete

	
Click this button to delete the selected Indication row.












Enter Quality Control Information

To enter quality control information, click Quality Control.


	Field	Description
	Quality Control Safety Date	Enter the Quality Control department reference number for the analysis.
	Quality Control Cross Reference	Enter the Quality Control department reference number for the analysis.
	# CID Number	Control Identification Number
	PCID Number	Product Control Identification Number
	Lot Number	If the Lot Number entered is incorrect, a Lot Number Lookup dialog box is displayed, that allows you to select from the existing lot numbers.
	Quality Control Result Date	Enter the date the result of the analysis was received by the Quality Control department.
	Quality Control Result	Enter a text explanation as necessary. Use the zoom icon to open the zoom notes and view or edit the text.









Enter Dosage Regimens


	Field/Control Name	Description
	Stop Date/Time	Enter the stop date and time of the dosage. Entry of time information is optional, and you can enter partial dates.
Note: If no Stop Date is entered, Onset from Last Dose is calculated from the Event Onset Date and the most recent Stop Date or the most recent Start Date.


	Ongoing	Select this checkbox if the drug treatment is ongoing.
The Stop Date, Duration of Regimen, and Last Dose fields are removed if this checkbox is checked.


	Outside Therapeutic Range	Check this checkbox if the drug has not been used in accordance with the label or has been used for outside the Therapeutic Range.
Contact your administrator for further company-specific information on the use of this field.


	Duration of Regimen	This value is calculated based on regimen start and stop dates (if full dates are entered for the start and stop dates). If the value is entered manually, the duration units (for example: minutes, hours, days, months, or years) must also be entered along with the actual duration.
Note: Contact your administrator to set the duration to be inclusive or exclusive. In Inclusive mode, the starting day counts in the calculation of the duration; in Exclusive mode, it does not.


	Dose Description	This value is entered by using the values from Dose, Dose Units, and Frequency. If necessary, you can change this value.
If Dose, Units, or Frequency information is changed, this value will be recalculated.


	Daily Dosage	This value is calculated based on the dose and frequency. It can be manually overwritten. If either the dose or the frequency fields are blank, this field is not calculated automatically.
	Regimen Dosage	This value is calculated based on the daily dose, duration, and frequency. This total can be overridden. If the daily dose is blank or the frequency fields are 0, this field is not calculated automatically.
	Regimen Dosage Unit	This value is derived based on the Daily Dose Units.
	Accidental Exposure	Select the type of Accidental Exposure from the list. A non-modifiable list of items is provided for this list.
	Pack Units	Select the package presentation information of the product.
Contact you administrator to adjust this list.


	(New) Tab	Click this tab to create a new dosage regimen entry.










Enter Product Details


	Field/Control Name	Description
	First Dose	The earliest regimen start date.
	Last Dose	The latest regimen stop date.
	Duration of Administration	Calculated automatically if full dates are available for the first and last doses.
	Total Dosage	Calculated based on daily dose and duration.
	Time Between First Dose/Primary Event	The time from the first dose to primary event onset.
	Time between Last Dose/Primary Event	The time from the last dose to primary event onset.
	Total Dose to Primary Event	The cumulative dose to time of the event.
	Action Taken	Select a term.
If you select Dose Increased or No change, the dechallenge and rechallenge fields are disabled.

Contact your administrator to adjust this list.


	Dechallenge Results	Indicates the drug stopped for the purpose of determining if it was the drug that caused the adverse event.
	Date	Enter the date the dechallenge was carried out.
	Gestation Period at Exposure	Gestation Period at Exposure is automatically calculated for all Products in the case by using the formula: Date of First Dose of the respective Product – LMP Date. It is calculated only if full dates available for both fields.
	Taken Previously / Tolerated	Select a response from the list.
	Rechallenge Results	Make a selection based on whether the drug was taken again.
If Pos or Neg or UNK is selected for the Rechallenge field, the following fields are enabled:

	
Rechallenge Start Date/Time


	
Rechallenge Stop Date/Time


	
Rechallenge Outcome





	Start Date/Time	Enter the date and/or time when the rechallenge was started.
	Stop Date/Time	Enter the date and/or time when the rechallenge was stopped.
	Specialized Product Category	Select specialized FDA product categories such as combination products, compounded and repackaged products used in eVAERS reports.
	Abuse	Check if the patient abused the product (For example: Painkillers taken without pain).
	Batch and lot tested and found within specifications	Check if the batch and lot was found to be within specifications, after being tested.
	Batch and lot tested and found not within specifications	Check if the batch and lot was not found to be within specifications, after being tested.
	Tampering	Check if the product appeared to have been tampered with before it was used.









Enter Study Drug Information

You can enter a Study Drug for a Non-Configured Study entered in a case and mark a current product as a study drug.


To mark a product as a study drug

	
Right-click on any suspect product in the case.


	
To mark the current product as a study drug, select Make Study Drug.




Make sure:

	
The drug type is disabled to make the product a Concomitant or Treatment option.


	
Study Drug is a read-only field that contains the product name selected by you.


	
For non-configured studies in the case, the following message appears for all study drugs in the case:

Drug Not Administered.










Enter Device Information


Enter Product Information


	Field/Control Name	Description
	M/W Info	The MW Info dialog box allows you to enter the following device information:
	
Is this a single-use device that was reprocessed and reused on a patient?—Indicate whether the device was labeled for single use. If the question is not relevant to the device being reported (for example, an X-ray machine), leave the select box cleared.


	
Reprocessor Name—Enter information for Address 1, Address 2, City, State, Country, Postal Code, Fax, and Email Address.


	
Select if the device was an Adverse Event or a Product Problem.


	
Type of Follow-up Report—Select a checkbox that describe the nature of the follow-up (supplemental) report:

Correction—Changes to previously submitted information.

Additional information—Information concerning the event that was not provided in the initial report because it was not known/available when the report was originally submitted.

Response to FDA request—Additional information requested by FDA concerning the device/event.

Device Evaluation—Evaluation/analysis of device.





	
	
	Enter information for Address 1, Address 2, City, State, Country, Postal Code, Fax, and Email Address.
	
Device Evaluated by Mfr—Select the Not returned to mfr. checkbox if an evaluation could not be made because the device was not returned to or made available to the manufacturer.

Select Yes if an evaluation was made for the suspect medical device. You can attach a summary of the evaluation and select Yes, Summary Attached.

If an evaluation of a returned suspect or related medical device was not conducted, check the No checkbox and attach an explanation or provide an appropriate code from the coding manual (Part II, Subpart A).


	
Reason for Non-Evaluation—Enter the reason for the device not being evaluated by the manufacturer.


	
Other Reason for Non-Evaluation





	
	
	Patient Codes—To display the 'FDA Codes' dialog box and to select the Patient codes, click Select.
	
Device Codes: To display the 'FDA Codes' dialog box and to select the Device codes, click Select.


	
Evaluation Codes Information—To enter the applicable codes from the categories listed, click Select.

Follow the instructions in the dialog box to enter the evaluation codes. Conclusion codes must be entered even if the device was not evaluated.


	
If reedial action initiated, check type—Select the applicable actions. If other, specify the type of action in the space provided (for further reference, see 21 U.S.C. 360h and 21 CFR part 803).


	
Usage of Device—Make a selection to indicate whether the use of the suspect medical device was the initial use, reuse, or unknown.


	
USC 360i(f) correction/removal reporting number—Enter the number that the FDA assigned to the corrective action. If the FDA has not yet assigned a number, the internal number assigned to the action by the company is used.


	
Additional manufacturer narrative—Check the checkbox (if applicable) and enter any additional information, evaluation, or clarification of data presented in previous sections.


	
Corrected Data—Check if the data is corrected.





	EU / CA Device	The EU/CA Device dialog box allows you to enter the device information. Fields are marked by either an EU flag or a Canadian flag to indicate which entity is mapped to the field.
	
Identification of Notified Body involved in Conformity Assessment—Enter identification number of the Notified Body involved in the conformity assessment procedure (if any) and the date(s) of the attestation(s).


	
Remedial Action by HC Facility: Enter the remedial action taken by the Health care facility.


	
Update to Initial Report (Follow-up Report): Check if the Follow-up report must be updated to an Initial report.


	
Availability of Device: Select whether the device was Destroyed, Returned to Manufacturer/Importer, or Neither.


	
Current location of device: Enter the present location of the device that was involved in the incident.


	
Where was the device purchased: Enter the establishment where the device was purchased.


	
Marketed Device Variant/Subset: Enter the value for device variant or subset.

The valid values are:

0 – Model

1 – Software

2 – Other Variant

3 – Lot/Batch














Enter Quality Control Information

See Enter Quality Control Information.





Enter Product Indications

See Enter Product Indications.





Select Product Delivered by Device


	Field/Control Name	Description
	Type of Drug	Select the type of drug from the drop-down list.
	Other Mfg Product	Displays the Other Manufacturing Product.
	Add	Adds another row.
	Delete	Deletes the highlighted row.









Enter Device Component Information


	Field/Control Name	Description
	Component Name	The device component name used in the product.
	Component Term ID	The device component term ID of the device component used in the product.
	Version	The Date or Version of the device component term ID of the device component used in the product.
	Batch Lot #	The batch lot number of the device component name used in the product.
	Add	Adds another row.
	Delete	Deletes the highlighted row.









Device Information—Field Descriptions

	
You can enter up to 10,000 characters in the Additional Manufacturer Narrative field.


	
The device evaluation codes have been updated to reflect FDA standards. Go to the following link for more information: http://www.fda.gov/cdrh/mdr/373_appdxb.html.


	
The evaluation method is available is the following site: http://www.fda.gov/cdrh/mdr/373.html.


	
The evaluation results are available at the following site: http://www.fda.gov/cdrh/mdr/373_appdxd.html.





	Field/Control Name	Description
	Product Information	

	Catalog #	Under Catalog#, enter the exact catalog number as it appears in the manufacturer's catalog, device labeling, or accompanying packaging.
	UDI System	The UDI System captures the unique identification type of the given device.
The valid values are:

GS1 – Global Standards 1

HIBCC - Health Industry Business Communications Council

ICCBBA - The International Council for Commonality in Blood Banking Automation


	Unique Identifier (UDI) #	Under Unique Identifier (UDI) #, enter any other applicable identification number (for example: component number, product number, part number, bar-coded product ID).
Data is entered in such a way to handle the UDI Device identifier and UDI Production Identifier fields.


	Operator of Device	Select the type of person operating or using the suspect medical device on the patient at the time of the event such as Health Care Professional, Patient, Paramedic and so on.
	If other	If the operator of the device is other, enter the operator of the device.
	Malfunction Type	Make a selection to indicate the type of reportable event. For an event associated with a malfunction, the FDA refers to applicable sections in 21 CFR Part 803 reporting guidelines.
	Device Available for Evaluation	Indicate whether the device is available for evaluation. Also, indicate whether the device was returned to the manufacturer and if so, the date of the return.
	CE Marked	Select whether the device is CE Marked or not. This information is preloaded from License information for a case booked manually, through E2B or LAM, and can be modified as needed.
	Malfunction Information	-
	Reported Malfunction	Enter the malfunction as entered by the reporter.
	Determined Malfunction	Enter the malfunction as determined by the company.
	Listedness	Enter the listedness of malfunction in respect of the device.
	Reportable	Select the reportability of the malfunction.
	Incident Information	This section captures the incident details. It contains the following fields and supports multi record entry. The Event Type Level codes are cascading, that is, Event Level 2 depends on 1.
Event Type Level 1

Event Type Level 2

Manufacturer Event Type Level 3

Event Type Level 3 Description


	Manufacturers Final Investigation Results	This section captures the investigation details. It contains the following fields and supports multi record entry. The Evaluation Type Level codes are cascading, that is, Evaluation Level 2 depends on 1.
Evaluation Type Level 1

Evaluation Type Level 2

Manufacturer Evaluation Type Level 3

Manufacturer Evaluation Type Level 3 Description









EU/CA Device Dialog Box—Field Descriptions


	Field/Control Name	Field Length	Field Type
	NCA Reference Number	100 characters	Alphanumeric
	Identify to what other NCA's this report was also sent	2000 characters	Alphanumeric
	Number of Patients Involved	3 characters	Numeric
	Number of Devices	3 characters	Numeric
	User facility reference number	20 characters	Alphanumeric
	Remedial Action by HC Facility	1000 characters	Alphanumeric
	Usage of Medical Device	N/A	Checkbox
	Other	15 characters	Alphanumeric
	Update to Initial Report (Follow-up Report)	N/A	Checkbox
	Final Report	N/A	Checkbox






When you select the EU/CA Device option, the fields on the Case form are printed. A track of the fields and any updates are maintained in the audit log.







Enter Vaccine Information


Enter Product Details

This section is the same for the Product Details section under all the tabs - in the Drugs tab, Device tab, and the Vaccine tab.

See Enter Product Details.





Enter Prior Adverse Events Information

	
Enter the relevant vaccination information items in the form.


	
Click OK.








Enter Product Information


	Field/Control Name	Description
	Include in VAERS Block	Select the VAERS Form block that this vaccine needs to be printed in.
	Suspect/Concomitant/Treatment	Make a selection for the product you are entering. The drug types indicate the involvement of the product with the adverse event(s) reported for the case.
	
Suspect indicates that the product may have caused the adverse event(s).


	
Concomitant indicates drugs that are taken with the suspect drug.


	
Treatment is the drug taken to treat the adverse event.





	Generic Name	Enter the generic name of the drug in a manner similar to the Product Name. I
if the study is blinded, the Generic Name is replaced with the Study Name of the product.

This name is entered based on the selected company product.


	Formulation	Select the formulation of the product. Contact your administrator to adjust this list.
Note: This field is entered based on the product.


	Drug Authorization Country	Displays the licensed country for the selected company product.
	Concentration	After a drug and formulation have been entered, select the concentration from the list, or enter the concentration. If this information is changed manually, the product is marked as a non-company product.
Note: This field is entered based on the selected product. The concentration cannot be modified for a Study drug.


	Units	Select a concentration unit.
Contact your administrator to adjust this list.


	Interaction?	Indicates whether the case involves a drug interaction.
	Contraindicated?	Indicates whether the drug was administered contrary to its indication. Make the appropriate selection to indicate whether the drug was contraindicated in this case.









Complete Vaccine Administration Form


	Field/Control Name	Description
	For VAERS Form-1 Use Only	

	Resp. Physician	Enter the name of the physician responsible for the patient.
	County	Enter the county where the patient was vaccinated.
	State	Enter the state where the patient was vaccinated.
	CDC/FDA VAERS #	Enter the verification number.
	Purchased With	Select the an item from the list to describe how the vaccine was purchased.
	Vaccine Facility Information	

	Facility Name	Enter the name of the facility where the vaccine was administered.
	Country	Enter the country of the facility where the responsible physician works.
	Facility Type	Enter the facility type where the patient was vaccinated.
	Facility Military Flag	Indicates whether or not the vaccination facility was a Military facility.









Enter Vaccine History


	Field/Control Name	Description
	Route of Admin	Enter the route of administration or a short code for the route of administration.
Contact your administrator to adjust this list.


	Anatomical Location	Select the anatomical location of the vaccination.
Contact your administrator to adjust this list.


	Block 14	If this box is checked, this Vaccine History will be printed in the VAERS Form Block 14.
	Add	Adds a new Indication row.
Note: Only two indications are visible at a time.


	Delete	Click this button to delete the selected Indication row.













Enter Event Information

You can enter or view details for adverse events for a case using this tab. It has the following sub-tabs:

	
Events tab


	
Event Assessment tab


	
Product-Event Details tab





Events Tab—Field Descriptions


	Field	Calculation
	Total Dosage	The sum of all Total Regimen Dosages.
	First Dose to Onset	The system calculates this value based on the First Dose Stop date and the event onset date, if present.
If any regimen start date is null, the system sets the First Dose to Onset to null.

The system uses only complete date entries for the regimen start and stop date/time fields to calculate First Dose to Onset.

The user can overwrite this field.


	Last Dose to Onset	The system calculates this value based on the last dose stop date and the event onset date, if present.
If the regimen start date is null, the system sets the Last Dose to Onset is to null.

The system uses only complete date entries for regimen start and stop date/time fields to calculate the Last Dose to Onset.

The user can overwrite this field.








	
You can change the listedness for a drug at the individual level.


	
The field labels for the Event Assessment tab can be updated and configured on the Argus Console.


	
If the Death Seriousness criteria on the Event tab are unchecked, the event outcome reverts to empty and is not set to fatal.


	
The MedDRA LLT term selection behavior across the Case Form is based on the profile switch value configured in the Allow User to Add Non-Current MedDRA Terms for and On change of LLT Term Sync English and Japan LLTs, irrespective of the currency.


	
The system populates the To be coded value on the MedDRA pop-up window when you check the green checkbox for the MedDRA hierarchy. This applies to the areas where the MedDRA dialog box appears.


	
The Event to Exclude from Report field enables you to identify information to not include in a PMDA Expedited report.

	
When this checkbox is checked, enter a justification for this action in the Reason to Exclude from the Report dialog box.

The system places a symbol to the right of the field.


	
The system does not retrieve events that are excluded from a report as part of CSPSR (Clinical Study Periodic Safety Report) unless it has been configured to include them.







When you click the Recalculate button, the system does not recalculate listedness where the Event Assessment Listedness already has a case justification (generated automatically or manually overwritten).


Enter Event Information

The Event information tab lets you encode adverse events, record criteria for event seriousness, and display results of automated assessments that determine whether events are listed in data sheets. It also lists the licenses for the data sheets.


Event Information—Field Descriptions


	Field/Control Name	Description
	Relationships	Click the Relationships button to view the Diagnosis-Event Relationships dialog box. This allows you to group symptoms and signs with diagnoses. This requires at least two events and a diagnosis.
	Description as Reported	Enter the verbatim term used by the reporter, or patient, to describe the adverse event. As you type, the term is copied under Description to be Coded. Verbatim English translations of foreign languages may also be entered here.
	Term Highlighted by Reporter	Indicate whether the primary source reporting the event considered it a major concern. If the information was not explicitly provided, the term is not considered a highlighted term. The seriousness of the reaction/event must be based on the ICH E2A criteria.
Selecting Yes does not mark this case as Serious.


	Description to be Coded	You can modify the verbatim term in this field. For example, the original term can be split, or enhanced with an anatomical location. Contact your system administrator to prevent manual encoding of the description. If automatic encoding is enabled, the term can be auto-encoded to the included term level.
	Onset Date/Time	Enter the date/time when the event started. Enter a partial date if the full date is not available.
	Onset from Last Dose	This field is calculated from the event onset date and most recent stop date listed in the dosage regimen details of the suspect drug(s). You can also enter or modify the field manually. This field is removed if the dosage regimen is ongoing.
	Duration	This field is calculated from the event start and stop dates. You can also enter or modify the duration manually.
	Onset Latency	This field is calculated from the earliest first dose date of the suspect drug(s) to onset date. You can also enter or modify the duration manually.
Onset Latency = Onset Date - First Dose.


	Receipt Date	Enter the date on which information about this event was received by your company. In Flexible Aggregate Reporting, this field is used to filter the events that falls out of the reporting period.
	Patient Has Prior History?	Indicate whether the patient has had a prior history or has suffered from the same event in the past.
	Intensity	Select the category of severity of the event. Contact your system administrator to adjust this list.
	Frequency	Select the frequency of the event from the list. Contact your system administrator to adjust this list.
	Outcome of Event	Select the outcome of the event. Contact your system administrator to adjust this list. If Fatal is selected, Death is selected in the list of seriousness criteria.
If the Death checkbox is subsequently cleared, the outcome still remains fatal.











Review a Diagnosis-Event Relationship

You can group events in a case, and/or associate them with particular diagnoses. Your company may determine these or they may be reported to it. This helps in interpreting and reviewing individual case reports. You can also enable the reporting of diagnoses only, while retaining database records of individual event terms.

Click the Relationships button in the Event Information section to open the Diagnosis-Event relationship dialog box.

The case must contain at least two events and, at least, one diagnosis. The events related to a diagnosis are listed on top in this dialog box and the symptoms are indented to the diagnoses. You can group events together and associate them with individual diagnoses.





Associate a symptom with the diagnosis

Click the up or down arrows to associate a selected symptom with a diagnosis. In Argus Safety Web, select the symptom and click Move Up or Move Down.

For example:

Defining a diagnosis-event relationship can clarify an adverse event report. Suppose an initial case report describes a patient suffering from Somnolence, Sore Throat, and Fever.

AE # Diagnosis AE Term (Associated AEs)

1 Somnolence

2 Sore Throat

3 Fever

For reports on all events, they would appear on a CIOMS-I form as:

	
Somnolence [SEDATION]


	
Sore Throat [SORE THROAT NOS]


	
Fever [PYREXIA]




Suppose a Follow-up report then supplies information that the patient also had neutropenia, and had been diagnosed as suffering from agranulocytosis (the cause of the sore throat and fever). The somnolence was considered to be coincidental, and unrelated to any other adverse events.

Neutropenia and agranulocytosis would be entered onto the system, and a diagnosis-event relationship established as follows:


	AE #	Diagnosis AE Term (Associated AEs)
	1	Yes agranulocytosis
	2	(sore throat)
	3	(fever)
	4	(neutropenia)
	5	Somnolence






These events would appear on a CIOMS I form as:

	
AGRANULOCYTOSIS


	
[AGRANULOCYTOSIS] [SORE THROAT],


	
[PYREXIA NOS], [NEUTROPENIA]


	
Somnolence [SEDATION]




This immediately provides a clear clinical picture of the case.





Auto-populate Event Information

The MedDRA application searches the term dictionary for a match at the Lower level or at the Synonym level. If a match is found, the following fields are automatically populated: Term code, Preferred Term, Included Term, High Level Term, Group Term and Body System/SOC.





Configure Regulatory Reporting Rules

The regulatory reporting rules are mainly configured to look at Seriousness, Listedness, Causality, and Outcome. Out of these, Listedness and Causality can be captured and controlled (using the event assessment section) down to an individual license basis.

This granularity allows individual license holders to override the normal listedness and causality assessment to control the need for submissions to their local regulatory authority. Each affiliate could either suppress the need for a report by demoting the criteria, or add the requirement for a report by promoting the listedness or causality.

This serves to promote the global reporting automation while maintaining the level of individual local affiliate control that is often needed.

To obtain an assessment of the adverse event, the product must be in the company's suspect product and the event must be encoded.







Enter Event Coding Information

The Event Coding section enables you to enter information about the event.


	Field/Control Name	Description
	System Organ Class (SOC) (Code)	Displays the body system or System Organ Class. This item is automatically entered from the event dictionary used and cannot be edited.
	High Level Term (Code)	Displays the high-level group term when using the MedDRA coding dictionary. This field is not shown when coding with WHO-ART and cannot be edited.
	High Level Term (Code)	Displays the High Level Term when the MedDRA coding dictionary is used. This item is not displayed when event encoding is done using the WHO-ART dictionary and cannot be edited.
	Preferred Term (Code)	Displays the preferred term. This item is automatically entered from the event dictionary used and cannot be edited.
	Included Term (Code)	Displays the lower level term code. This item is entered from the event dictionary used and cannot be edited.









Enter Seriousness Criteria


	Field/Control Name	Description
	Death	Displays the Death Details dialog box
Note: If you un-check the Death option in the Seriousness Criteria, you are required to confirm the deletion of the death details.


	Hospitalized	Displays the Event Hospitalization dialog box.
	Other	Check this checkbox to enter explanatory text. You must mandatorily enter text, specifying the Other Seriousness Criteria.







Enter Death Details

	
Check the Death checkbox under Seriousness Criteria.

The form for Event Death Details appears.


	
Enter information for the items in the form.


	
Click OK to save the entered Death Details.







	
Note:

When Seriousness criteria Death is unchecked, the system displays a message Do you wish to delete the Death Details?.On confirming, the Death date (NF or date) and Autopsy details are cleared.











Enter Hospitalization Details

	
Check the Hospitalized checkbox under Seriousness Criteria.

The form for Hospitalization Details appears.


	
Enter information for the items in the form.


	
Click OK to save the entered Hospitalization Details.








Select Nature of Event

The Nature of Event section enables you to identify the nature of the event from the drop-down list. You can add a maximum of 50 such Nature of Event rows.





Enter Event Notes

The Details section enables you to enter notes related to the event. If Reported Causality is entered when the case is booked-in, the system transfers it to this field.







Enter Event Assessment Information

The Event Assessment tab enables you to capture causality and listedness information for a case. All encoded events in the case are compared with the listed events for company products (agents) associated with the case.


Event Assessment Tab—User Actions


	User Action	Result
	Click Datasheet column's icon	The system does the following:
	
Displays the license view


	
Displays the datasheet view


	
Displays the License column


	
Enables the icon for the License column





	Click Product Name link	Displays the name for the selected product.
	Click Event Description link	Displays the Event Information for the selected event.
	Click Datasheet Description link	Displays the first 1000 terms in the datasheet. Click Print to view all the terms and click Export to export all the labeled terms to an Excel file in a single column with column header as Labeled Terms.






Event Assessment—Fields Descriptions


	Field/Control Name	Description
	Recalculate	Refreshes the Event Assessment section with the newly entered data if new suspect products or events are entered, or the Event Relationship is modified.
	Product	Populated when events are entered in the Products tab and appears as:
	
First Line - Product Name


	
Second Line - Generic Name





	Causality as Reported/Source/ Method/ Result	Provides the source of causality as reported such as Investigator, Healthcare Professional, and so on.
Provides the method used for causality determination.

Provides the result of the causality assessment.


	Causality as Determined/Source/ Method/ Result	Provides the source of causality as determined such as Sponsor, MAH, and so on.
Provides the method used for causality determination.

Provides the result of the causality assessment.


	Other Causality /Source/ Method/ Result	Provides the source of causality from any additional source such as NCA.
Provides the method used for causality determination.

Provides the result of the causality assessment.


	Event	Populated when events are encoded and appears as:
	
First Line - Event PT (Verbatim)


	
Second Line - LLT





	D/S	Displays the Diagnosis/Symptom details by D or S.
	Seriousness Severity Duration	Displays the seriousness, severity, and the duration of the event.
	Listedness	Indicates whether the system found the event on the datasheet for this product.









Filter Event Assessment Details

Only the assessment rows that match the selected criteria appear in the filtering results.


	Field/Control Name	Description
	Product	The Product filter drop-down list contains all products listed in the event assessment. You can filter on all the products which are present in the Event Assessment dialog box.
	Event PT(Description)/LLT	Contains a drop-down list of values of distinct Event PT. You can filter on all the products which are present in the Event Assessment dialog box.
	D/S	Contains a drop-down list of values of D for Diagnosis or S for Symptoms.
	Datasheet	Contains a drop-down list of values of distinct Datasheets.









Enter Product-Event Details

The Product-Event Details tab enables you to capture causality information for a case.


	Field/Control Name	Description
	Event	Populated when events are encoded and appears as:
	
First Line - Event PT (Verbatim)


	
Second Line - LLT





	Onset from First Dose	This date is defined as the earliest regimen start date to Onset, and is completed automatically. The date calculation is based on the Case Form Calculation for Inclusive or Exclusive.
	Onset from Last Dose	This date is defined as the latest regimen stop date to Onset, and is completed automatically. The date calculation is based on the Case Form Calculation for Inclusive or Exclusive.
	Total Dose to Event	This value is calculated based on daily dose and duration.













Add Attachments to Your Case

The Additional Information tab lets you attach notes and other items to a case. For example, you could attach a fax message that came in as part of the case and needs to be scanned and attached or an electronic file received by email. It also lets you set up cross-references to other cases such as links between cases referring to mothers and children. The total number of attachments and references attached to a case appears in the header.

	
When you click the hyperlink and a reference case is present, the system opens a case number irrespective of the selected reference type when you clicked the hyperlink.


	
If no sites are defined for the attachments classification, the system permits all users to view the attachments on the Additional Information tab.


	
The system permits Workflow Enterprise to view all attachments across all sites.


	
You can send different Case Form attachments to different agencies, based on the Attachment classification specified to the Receiving Agency in the Reporting Destination Codelist in the Argus Console. For more information, refer to the Argus Safety Administrator's Guide.


	
After the records in Notes and Attachments are sorted, if the following options are invoked without closing the case, the sort order is respected in these modules:

	
Case Form Print


	
Medical Review


	
Copied Case








Enter Additional Information for the Attachments


	Field/Control Name	Description
	Notes and Attachments
	Notes and Attachments	Lets you sort column headers to sort the records based on the fields in the Notes and Attachment section.
	Classification	Select a classification that describes the attachment. Contact your system administrator to adjust this list.
Refer to the Oracle Argus Interchange User's Guide for details about Attachment Classification usage in sending attachments in electronic reports.


	Incl. Reg. Sub	Check this checkbox to merge PDF attachments within the Case Form. The Incl. Reg. checkbox identifies the attachments to be included as an appendix to Expedited reports. On checking this checkbox, the Expedited reports - CIOMS I, CIOMS I (Local), US FDA MedWatch 3500 Drug and 3500 A Device print an appendix page before each attachment. This is added to the case, and marked as Inc. Reg. Sub checked.
The checkbox is available only if a PDF is selected as an attachment.


	Literature Reference	Select the Literature that is related to the attachment. Attachments that have Literature reference are transmitted as inline attachments for the data element C.4.r.2 in the E2B(R3) report.
	Attach File	Inserts a file attachment into the case. Maximum file size is 4 GB.
	Attach Documentum Link	This option is visible only if Documentum is available.
Click Searching for Documentum to search for and attach Documentum.


	References Type	Select a reference type from the list, for example, a parent-child link. Contact your system administrator to adjust this list.
	ID #	Enter the case number of the case that is to be referenced.
Click Select to search for the case that is to be referenced. You can also use this field to record the reference number for external cases.


	Select	Opens the Case Selection dialog box for the selected ID.









Sort Attachments


	Field	Description
	Keywords	On clicking this column header for the first time, records are sorted in the ascending order (alphabetically) of the Keywords.
	Date	On clicking this column header for the first time, records are sorted in the ascending order (chronologically) of the Date.
	Description	On clicking this column header for the first time, records are sorted in the ascending order (alphabetically) of the Description.









Search for Documentum Links

	
Click the Attach Documentum Link button to open the Documentum Lookup screen.


	
Enter the desired search criteria as per Type Name, Attribute Name and Search String, and click Search.


	
Select the desired link from the row displaying the search results.


	
Click Select to select the link from the list.








Attach Files to a Case

	
In the Notes and Attachments section of the Additional Info tab, click Attach File to open the Attachment dialog box.


	
Click Browse to locate a file attachment.


	
Select the file and click OK.








Enter Keywords

You can associate keywords with a case in the Notes and Attachments section.


To attach keywords to a case

	
Go to the Notes and Attachments section and click Select.


	
When the system opens the Attachment Keywords dialog box, select a keyword from the Select a keyword to add to the list drop-down list.

The system displays the selected keywords in the Keywords field.


	
Click OK








Attach References to a Case

	
Locate the References section and click Select.


	
When the system opens the Case Search Criteria dialog box, enter the search parameters and click Search.


	
When the system displays the search results in the Total Number of Rows section, select the desired search criteria from the list and click Select to view details about the selected case.








View and Print Attachments

The Attachments tab enables you to view and/or print case attachments. The system prints date/time information:

	
As footers on all printouts (except letters).


	
In the following format: dd-mmm-yyyy hh24: mm: ss.





To print case attachments

	
Click the Description link to display the attachment.


	
When the system opens the letter, click Print to print it.











Review Local Labeling

	
Hover over the Worklist menu and select Local Labeling.


	
When the system opens the Local Labeling screen, select the appropriate information as necessary.




	
Filtering by Product Family: You can filter products in the Event Assessment dialog box based on the selected product families. Click the magnifying glass icon to filter the search results by product family.




	
The system displays the number of cases currently in view and automatically updates the range based on the page size specified in the Search dialog box (read only). For example, if you select 100, the system divides the displays rows into groups of 100 cases.


	
Events assessment can show all listedness values. By default, it shows listedness only for the core datasheets and countries you have permission to access.


	
Diagnosis -- The Diagnosis Filter contains a drop-down list with the following values:

	
D (Diagnosis)


	
S (Symptoms)


	
In the Events Assessment dialog box, you can filter on either the diagnosis or the symptom.







	
By default, the system displays all events with the <ALL> option.


	
Datasheets

	
The Datasheets drop-down list contains a list of distinct datasheets.


	
All the blank datasheets display as a single row of Unspecified.


	
When you click the Datasheet hyperlink, the system displays the datasheet notes.







	
Licenses

	
The Licenses drop-down list contains a list of distinct countries for the licenses.


	
All licenses not associated with a datasheet appears under Unspecified and are aligned with the datasheet view.


	
When you click the Licenses hyperlink, the system displays the license references.





	
The Process button triggers all the applicable rules (both global and local) for the country/license type for the licenses that are assessed through this screen.




For more information about Local Labeling, see the LAM User Guide for Worklist - Local Labeling requirements.





Enable Local Data Entry for Japan

Argus Safety supports a concept of global lock that indicates the readiness of case data for global reporting, and a concept of local data locks that indicates the readiness of case data for local reporting having fulfilled the local data entry and assessment needs.


Enable Local Data Entry

The application allows local users to open a case for entering local data without globally unlocking the case and at the same time maintain the integrity of the "global" case data.

In order to achieve this:

	
The fields in the application are categorized into global and local fields. The local fields have been identified as local to one or more countries. The local fields for only Japan are supported in this release.


	
All Argus J users are considered as Japan Local user in this release and as having access to edit the Japan local fields.





About Local Fields

A field is identified as a Local field to one or more countries based on a new attribute in the CMN_FIELDS table. The local fields for only Japan are supported in this release.

Customers can configure any field in the Case Form > General, Patient, Products, Events tabs, and in the Analysis > PMDA tab as a Local field for Japan through back-end updates to the CMN_FIELDS table.

The Enterprise copy configuration action will copy these updates as per existing functionality.

If a customer configures a field that could update global value as a local field, it is expected that the customers maintain the integrity of the global data by business SOPs or custom software processes.

All the fields in a case that is not a Local PRPT case are simply treated as global fields.

All Argus J users are considered as having access to edit the Japan local fields.

All Japanese text fields, including J User-Defined fields are considered as Local fields for Japan.

i. All Japanese text fields are the fields that currently has separate _J columns.

ii. All fields from PMDA tab, PMDA Device Information section.

Argus Safety allows selection of secondary LLT (stored in LLT_J or LLT_CODE_J field) or Synonym (SYN_CODE_J) encoding using MedDRA J browser that does not change the base MedDRA hierarchy of English.

The Event Assessment > Listedness field in the tab for for the licenses of the local country corresponding to the local user is considered as local field. However, this field is available for editing for the user only when the local user has listedness privilege for that local country assigned to them via the User Group > Listedness Determination - Countries access and the datasheet associated with that local country license is configured with "Global / No Local Assessment Required" checkbox as unchecked.

The Events tab > Infection and Event Exclusion checkbox are also considered as local field for Japan.

Any field where an update to a global field can occur is NOT considered as Local field.

All numeric fields, date fields, drop-down fields which share same data value for English and Japan sides are not considered as Local fields.

However, there are exceptions to this rule where some fields that contain global values are available for update to local users and in such a scenario, it is expected that the global value should be protected by customer's business SOPs.

Case classification is such a field that can cause update to global value and it is available as a Local field in the application out-of-the-box.

Study section under General tab requires special handling by the application during local editing. Study Name, Study Description, Protocol Number, Clinical Compound Number and Center Name are local fields.

When the study is a configured study, all these fields are disabled for local editing except Center Name (J). Center Name (J) is available as an editable local field.

Product Information section in Products tab requires special handling by the application during local editing. J Drug Code type and the corresponding J Drug Code/OTC Drug Code/Temporary Code (i.e., DRUG_CODE_TYPE_J, DRUG_CODE_J,), J Generic Name and J Product Name fields are local fields.

Any field that is already editable after case lock will remain editable even after local lock.

An auto-narrative generation performed during Japan Local data entry (after global lock) only updates the J field value and does not update the English or any other language field value.







Access Local Case Data Lock Functionality

This section lists the different sections where the functionality for Local Case Data Lock has been documented in the Argus Safety suite of documentation.

Refer to the following table for the list of features and the corresponding Guides where they have been documented:


	Local Lock Feature	Overview	Documented in
	Local Locking and Local Unlocking - Configuration	Introduction of new switches: Allow Local Locking - to allow a local user to be set up with the privilege to locally lock or unlock a case
Enable Local Unlocking - to provide a system level control permitting local users to locally unlock a case and make any corrections to the previously entered local data.

	Oracle Argus Safety Administrator's Guide > 2 Access Management > Configuring Users
Oracle Argus Safety Administrator's Guide > 4 System Configuration > Configuring System Management - Common Profile Switches

Oracle Argus Safety User's Guide > Global User Management


	Changes to the Case Locking Mechanism in Argus Safety - Case Form Changes	Introduction of action icon - Local Lock - to allow a user to locally lock or unlock a case	Oracle Argus Safety User's Guide > 1 Getting Started > Quick Launch Toolbar
	Changes to the Case Locking Mechanism in Argus Safety - Changes to global locking, One Step Global and Local Lock	Allow Global locking and triggering of global and local reports, and allow one step global and local locking	Oracle Argus Safety User's Guide > Locking a Case
	Changes to the Case Locking Mechanism in Argus Safety - Changes to Global Unlocking - Configuration	Introduction of new switches:
Allow Forced unlock (Global and Local) - to allow users to be set up with the privilege to forcibly unlock a case that been globally and/or locally locked but pending report generation

Allow Global Unlock on Pending Local Lock - to allow users to be set up with the privilege to forcibly unlock a case that is still pending a local lock

	Oracle Argus Safety Administrator's Guide > 2 Access Management > Configuring Users
Oracle Argus Safety Administrator's Guide > 2 System Configuration > Configuring System Management - Common Profile Switches

Oracle Argus Safety User's Guide > Global User Management


	Changes to the Case Locking mechanism in Argus Safety - Changes to global unlocking - Case Form changes	Control globally unlocking a case based on local/global reports pending generation and /or cases pending local lock	Oracle Argus Safety User's Guide > Unlocking a Case
	Case Form changes - Local Reports Configuration - Local Reporting Rule and Local Reports	Configuring Local Reporting Rules and Local Reports	Oracle Argus Safety Japanese Administrator's Guide > 3 System Configuration > Configuring Local Reports - Local Reporting Rule and Local Reports
	Triggering Local Reports - Changes to Report Scheduling and Generation Algorithm - Auto Scheduling	Changes to report auto-scheduling for scheduling local reports	Oracle Argus Safety User's Guide > Report Scheduling - Auto-Scheduling
	Triggering Local Reports - Changes to Report Scheduling Algorithm - Manual Scheduling	Changes to report manual scheduling for scheduling local reports	Oracle Argus Safety User's Guide > Report Scheduling - Manual Scheduling
	Triggering Local Reports - Changes to Report Generation Algorithm	Changes to report generation for generating local reports	Oracle Argus Safety User's Guide > Triggering Local Reports - Report Generation Algorithm
	Changes to Expedited Reports and Periodic Reports on DLP	Changes to DLP while generating local expedited and periodic reports	Oracle Argus Safety Japanese User's Guide > Reports









Process an Outlier

When a suspect product with local license is removed on a follow-up, the case remains a Local PRPT Case (Local Potential Reportable Case) until the corresponding nullification/downgrade local reports is generated.

If a customer wants to change Local Reports configuration data after being in production with this release, it is recommended that customers ensure that cases/reports under processing be completed before changing configuration data to avoid unpredictable results. Note that if a customer changes the Local Reports configuration data mid-way where the reports are mid-way processing (e.g., scheduled), the reports will be determined as local/global based on what type it was at the time when the report was scheduled and will be completed processing that way irrespective of current configuration even if inconsistent with the configuration. Also note that presence of local reports will determine that the case is local case.

It is also recommended that customers ensure that cases/reports under processing be completed before up taking the Local Locking feature and (thereby) installing the local lock configuration data (refer to Activate Local Locking in Argus Safety). Note that if the case was mid-way processing (e.g., case was open in data entry workflow) when customer up took the Local Locking feature, a subsequent case save will determine if the case is local or global.






Activate Local Locking in Argus Safety

In order to activate the Local Locking feature in Argus Safety, the installer provides the users with an option to install the underlying metadata that enables the local lock feature in the application. A customer, who may not prefer to turn on the local locking feature due to existing business processes that already handle the local processing needs for a company, could choose not to install the metadata and thus not uptake the local lock feature in the application.

A separate database script is provided so that the user can run to turn on the Local lock feature after an upgrade or fresh install. On executing this script, it prompts the user to choose to turn on the local locking feature and uptake the Local Locking seed data.

The application assumes the default value of 1, parses the user input and installs the Local Locking seed data for each of the enterprise specified in the comma separated list.


Enter Local Reports Configuration Seed Data

A new table is seeded to identify Local Reports for Japan:

	
Country - The seed data is the country id for Japan (from codelist Countries) for this release.


	
Reporting Destination - The script prompts the customer to provide the default value of reporting destination for PMDA.

Prompt - "Please enter Agency Name for the PMDA reporting destination as configured in the "Reporting Destination" codelist. This name will be used to identify Local Reports for all enterprises".


	
Report Form - The seed data is the following Japan reports:

[image: Surrounding text describes imagej.jpg.]







Enter Local Users Seed Data

The upgrade installer script prompts the user to choose if all the Argus J users will be updated to have local locking privileges.





Enter Local Fields Seed Data

Note that the CMN_FIELDS are always seeded as part of install/upgrade factory data to identify the Local Fields for Japan and will be present irrespective of if the customer chooses local locking feature or not.

In case of Multi-tenancy, the customer input value is used to set the seed values across all enterprises.

This seeding of Local users data is audit logged with the system user.

After install/upgrade, if customer has turned on the local locking, the icons in the applicable screens start reflecting the local/global lock status of the case.












4 Review Your Cases



Find an Existing Case

	
On the Home page, hover over the Case Actions menu and click Open.

[image: Surrounding text describes opencase.jpg.]

	
On the Case Search Criteria page, select the applicable search criteria and click Search.


	
When the system displays the search results, locate the case in the list.


	
Click the link associated with the Case ID to open that case in the Case Form.





Enter Case Search Criteria


	Field/Control	Description
	Search For	You can search for cases based on multiple study identifiers. The option, Pri/Stdy/Othr/Cntr/Rptr/Pat supports the entry of Project ID, Study ID, Other ID, Center ID, Reporter ID, and Patient ID values separated by the / (forward slash) character.
	Date Range	To enter a customized date range, select Custom Date Range from the list.
	
Enter an appropriate date range in the custom date range dialog box and click OK.


	
Select the Follow-up option to search on Follow-up Dates, including Significant and Non-Significant Follow-ups.





	Advanced Condition	Click AC to create a new advanced condition.
Select an Advanced Condition for the case, if applicable.













Open or View New Cases in the Worklist

	
On the Home page, hover over the Worklist menu and click New/Open.
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On the New/Open page, enter the required information and click Search.




	
When you select New, the system displays new worklist items that have been assigned but not yet accepted. You can also see unassigned cases.


	
When you select Open, the system displays all cases that have been assigned and accepted.




	
Note:

Once you have accepted the case, it is Open.








	
The New/Open Worklist displays the Workflow Group and the Workflow State currently associated with the case.


	
If the user has cases open, the system skips those cases.




You can filter the results based on the following:


	Option	Description
	Workflow State	Displays only those workflow states that occur in the given worklist, considering other filter elements such as Case Owner, Assigned to, and so on.
	Product	Displays only those products that occur in the given worklist, considering other filter elements such as Case Owner, Assigned to, and so on.
	Event Preferred Term (PT)	Displays only those Event PTs that occur in the given worklist, considering other filter elements such as Case Owner, Assigned to, and so on.
	Event as Reported	Displays the name of the event as reported.
	Case Report Type	Displays only those report types that occur in the given worklist, considering other filter elements such as Case Owner, Assigned to, and so on.
	Product Group	Displays product groups where the Primary Suspect Drug occurs.






The default filter is Case Number. This lets you enter a Case Number to search for results matching a specified case number.

The search results are displayed in the Total Number of Rows section. The following table lists and describes the fields in this section.


	Field	Description
	Lock Status	Enables the user to view the Locked state of the case by the icon. The type of case (Initial or Follow-up) is also displayed along with the icon.
If the case is a Follow-up, additionally, the Follow-up number is also displayed. For example: Initial or F/U: 1.

The icon (displayed in the lock state column) denotes a SUSAR (Suspected Unexpected Serious Adverse Reaction) case.


	Receipt Date	If the option Display Initial Receipt Date always is configured, the Initial Received date of the case is displayed in the Receipt Date column on the Worklist screen.
If the option Display Initial Receipt Date or the latest Follow-up Receipt Date is chosen, and if a Follow-up entry exists, the latest Follow-up Received Date regardless of significant or not is displayed in the Receipt Date column on the Worklist screen.

If Follow-ups do not exist, the Initial Received date of the case is displayed in the Receipt Date column on the Worklist screen.


	Aware Date	The Aware date is the latest significant Follow-up which is received in the case or the Initial Receipt Date if there are no Significant Follow-ups present in the case.
	Days Open	Displays the number of days that have elapsed between the Initial Receipt Date or the latest significant Follow-up Receipt Date (if it exists) and the current system date (Database server).
	Days Remaining	Displays the number of days that are remaining, as configured in the Administration module for Case Processing.
	Event PT	Displays the Preferred term of the Primary Event.
	Event Verbatim	Displays the Verbatim text for the Primary Event.
	S/U/R	Displays the Case Level Assessments:
	
S denotes Serious (Y/N)


	
U denotes Unlisted (Y/N)


	
R denotes Causality (Y/N)




	
Unknown is treated as a "?"


	
When the user clicks the SUR link, the Case Summary is displayed.





	F, LT or H	
	F denotes a Fatal (F) case
	
LT denotes Life Threatening (LT)


	
H denotes Hospitalized (H)




If any of the above are present together, then Fatal takes precedence followed by LT followed by H. If the case is neither of the above, No is displayed.


	Study ID	Displays the Study ID of the study cases.
If Study ID is not present, this field is blank.


	Reporter Type	Displays the Reporter type for the Primary Reporter in the case.
If Reporter type is not present, this field is blank.


	Assigned To	Displays the current owner or text Unassigned to indicate the assignment status of the Case. This option is not available if the user selects the Individual option from View.
	Owner	Displays the Owner of the case. If Owner is not present, this field is blank.
By default, the first user to accept a case after book-in becomes the Case Owner. The Case Owner has access rights to assign cases that he owns to another user. A Case Owner cannot be reassigned automatically after the initial assignment. However, he can be reassigned manually by a Workflow Manager.


	Print List Button	Allows the user to print the current worklist for reference.
	Routing Details	Displays the case routing details.









Find Cases Assigned to you

	
On the Home/Personal Argus Status page, check the Cases Assigned checkbox.

The list of cases assigned to you is displayed.
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If the Personal Argus Status Page is not your default home page, go to Utilities and click Personal Argus Status.





View your Pending Action Items

	
On the Home/Personal Argus Status page, check the Action Item Entries checkbox.

The list of your pending action items is displayed.
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View your Case Workload

The Case Workload feature is available for Workflow Managers only (administrator). For example, if a user belongs to a group which has access to this menu option but is not a Workflow Manager, this option will not be displayed.

To view the case workload for individuals and one or more sites, select Dashboards > Case Workload.

The Case Workload parameters display the specific Worklist where the user can view the case numbers. Click + to view the next level and expand the parameter.


	Site	Expands either the Workflow State or Workflow Group.
	Workflow State	Expands to User Name.
Click the Header to toggle between Workflow Group or Workflow States.


	Workflow Group	Expands to User Name.
Click the Header to toggle between Workflow Group or Workflow States.


	Week Forecast	Displays the number of cases projected in the next 5 days for the current workflow state or group.
If a case is routed to multiple workflow states or groups, it is counted multiple times within the Week Forecast.

The Projected Week Forecast is based on the Dynamic Workflow calculation for the entire case, as per the configuration settings.


	User Name	Displays the user to whom the cases are assigned.
Expands to Priority.

Online Users can view the Online icon and their User Names appear in bold.


	Priority	Click the link to view the specific Worklist where the user can view the case numbers.
	# of Cases	Click the link to view the specific Worklist where the user can view the case numbers.
	Refresh	Enables you to only refresh the number and the entities but not the entire page.
Enter a value in the text field to Auto-Refresh the data every N minutes up to a maximum of 99 minutes.


	Print	Prints the Load Balancing Dashboard in PDF format.
	Export to XLS	Exports the Load Balancing Dashboard in Excel format.







Open Case Summary Reports

To view a summary of all the open cases, select Dashboards > Open Case Summary.

	
The case summary appears in PDF format.


	
The cases are sorted in ascending order as per the number of days the case has been open.


	
The Date Received column prints the initial receipt date or the latest follow-up date for the case.


	
If there are no follow-ups for a case, the system calculates open cases based on the initial receipt date.


	
If there are follow-ups for a case, the system calculates the days open based on the most recent follow-up in the case. If the latest follow-up date is older than the previous follow-up, it considers only the last follow-up.








View Workflow Status

You can view the workflow status based on case owner, site, case seriousness, and other criteria.

	
Select Dashboards > Workflow Status.


	
In the Search Case fields, enter the parameters, and click Search.

Workflow Status appears on the Worklist Group menu.

	
To open the list of cases, click a bar graph, and select from a dashboard menu.

To drill down on the specific workflow state details, click the graphical bars.


	
If no updates are made to cases during case processing, the cases are displayed based on the number of cases you clicked during the drill down.


	
If one or more cases change workflow state between loading the dashboard screen and loading the worklist-specific screen, a discrepancy in case numbers may occur.


	
The system maintains user preferences when you return to the Workflow Status Dashboard.


	
By default, only the first filtering results appear, to view other filter options, click More Filtering.

Use CTRL and Shift keys to make multiple selection for a filter.

	
The Site filter displays all active (undeleted) sites in the Argus Code List. However, the LAM sites are not displayed.


	
The Workflow State filter displays all active (undeleted) workflow states, except archived or closed in the Argus Utilities - Configuration.


	
The Date Range function selects last month as the default value for the range.

The Aware Date is evaluated to fall in between the date range specified in the Date Range filter.


	
The Serious or Non-Serious filter further provides more sub-filtering options.


	
For Project ID filter, the values are configured in the Argus Utilities Protocol ID Code List.


	
The Default Report Configuration filter returns all cases for the current month when no other filters are used. The cases are evaluated based on the Aware Date.





	
To go to worklist specific screen, double-click the Bar Graph.

Bar graph colors indicates: the following statuses:

	
Red—Late cases


	
Yellow—Outside of normal cases


	
Green—Normal cases
















View your Worklist Action Items

	
Hover over the Worklist menu and select Action Items.


	
When the system opens the Action Items screen, enter the information in the fields as necessary.




The Worklist Action Items displays the entire description of the action item selected in the Description field on the dialog box.


Manage your Queries

The system generates open Query Action Items based on the advanced conditions rules for the action item type.

	
When the user saves the case or clicks the Generate Query icon on the Quick Launch toolbar, the system creates an open action item based on the profile switch.


	
The Due Date for the action item is the System Date + the Due Date (in days) as defined in the codelist.


	
The Open Date is the system date on the day the Query was created for the case.

When you click the Generate Queries icon, the system generates the action item queries. These queries are based on the rules defined for the action item types in codelist Maintenance where the Advance Condition satisfies the case criteria.

This item displays on the Quick Launch Toolbar when the case is open.

Short cut key: CTRL+ALT+X




If, after the system schedules the action item query, unresolved queries are resolved or there are queries that do not meet the criteria of the Advance Conditions, the system closes the action item and uses the system date as the close date.

If there are open query action items, the system does not create new action items with the same name when the system tries to resolve the open queries list in the Case Form.





Query your Action Items

	
You can query only query action items by selecting View Query Action Items.


	
You can filter only overdue action items by clicking Overdue Action Items. The Worklist displays those action items where the due date is before today's date (system date).


	
The system allows all open query type action items to be populated in a Letter template by adding the place holder: [OPEN_QUERY]. This populates the open queries letter template content as configured in the codelist when the letter is being generated in a separate line for each open query.





	Attribute	Tool Tip	Example
	Query Name	Name of Query to be included in the letter template.	QUERY_Preg_LMP (must begin with QUERY_).
	Query Condition	Advanced condition. If the condition is true, then insert text into the generated letter.	Patient is pregnant and date LMP missing (Advanced Condition).
	Query Letter Text	Text to be inserted in generated letter if Query Condition is True. If Query Condition is no true, the no query item is created.	Please provide the Date of Last Menstrual Period (LMP) for the patient.
	Query Item Text	Text to be display on the list of open queries.	Patient missing Date of LMP.






For example:

	
Please provide Reporter Name (Adv. Cond is Reporter name is null)


	
Please provide Physician's address (Adv. Cond is Reporter address is null)


	
Please provide Physician's phone number (Adv. Cond is Reporter phone number is null)


	
If the case is saved and the Reporter Name exists, the system creates two action items.










View your Contacts

	
Hover over the Worklist menu and select Contacts.


	
When the system opens the Contacts screen, enter the information in the fields as necessary.




The search results are displayed in the Total Number of Rows section. The following table lists and describes the fields in this section.


	Field	Description
	Study ID	Allows the user to view the Study ID present in the case.
	Description	Displays the description of the action item in question.
	Product Name	Allows the user to view the Product Name of the Primary Suspect Drug.







Review your Contact Log

The Contact Log section of the Activities tab lets you:

	
Track correspondence related to individual cases


	
Display scheduled letters





Use the Contact Log Section

The number displayed in parenthesis in the header of each section - Contact Log, Action Item, Routing Comments, Case Lock/Archive - displays the total number of entities within the section.

The system remembers the sort order for the duration of the case.


	Field/Control Name	Description
	Date	The date is inserted by the system when a letter is scheduled or generated through the Letters menu. You can enter the date on which the letter is manually scheduled or generated.
Click the letter icon to open the Letter Preview dialog box. This allows you to view a letter or to modify it if it has not been sent already.


	Code	Select from a list of values to set the contact code for this entry. Contact your system administrator to adjust the information in this list.
	Description	Enter a brief explanation for the letter, for example, Initial Letter, or the details of a phone conversation.
	Group/User	Select a group responsible for the Contact Item. From the list below, select a user from the selected group who is responsible for the action. The Contact Item appears in the Worklist for the selected user. If Any is chosen as the group, the Action Item appears in all the users' Worklist. Contact your system administrator to adjust the information in these lists.
	Date Sent	The date is inserted when a letter is sent through the letter menu. You can also manually enter the date the letter was sent. If this field is completed, the letter becomes read-only.









Generate Letters

	
Select Contact Log from the Activities tab and click New Letter.

The Custom Letter Templates dialog box opens.


	
Select the required letter template from the list and click OK to open the letter in a separate window.


	
Make the necessary changes to the letter text and Save.


	
If you modified the letter, select Yes.

This attaches the letter to the Case Form by browsing to the location where you saved the changes.


	
After saving the letter, the system displays it in the Contact Log section of the Activities tab.


	
The system creates an action item for following-up on this letter in the Action Items section of the Activities tab.




The following image displays the meaning/status of various letter icons:

[image: Surrounding text describes lettericons.jpg.]

	
A letter is only added to a search if the Correspondent checkbox is checked.


	
Contact your system administrator to configure the system to generate letters automatically and to schedule them for a specific number of days after receiving details of an adverse event. For example, the system might schedule an Initial Response Letter to be sent the day after an adverse event is received. Auto letter scheduling is triggered when a case is initially saved.


	
If the Primary Reporter is marked as a correspondence contact, the system sends auto-scheduled letters to the Primary Reporter. Otherwise, the letter is sent to the first correspondence contact.


	
Auto-scheduled letters appear in the Contact Log section of the Case Form. You can view or print them by double clicking the letter icon. You can also edit letters that have not been sent. You must send or remove letters manually.


	
In addition to auto-scheduling letters, you can also configure auto action items, which prompt you to follow-up with a correspondent after a letter has been scheduled and sent. Auto action item scheduling is triggered once the sent date has been entered for a letter.


	
The system uses the following naming convention to when saving letters in the Uploaded letters folder:

XXXX_YYYY.RTF

where:


	XXXX	Is the current case number
	YYYY	Is the current letter numbering format (that is, date and time the letter was generated)






	
The system replaces all special characters in the case number with an underscore ( _ ) character.


	
The CFG_PLACEHOLDER SQL limit is 4000 characters








Schedule Action Items for Letters

When specifying or changing the Date Sent field in a letter, you can schedule an action item.

	
Any action item can be updated on the screen immediately after a case has been saved.


	
Unless the action item has already been marked as completed, each time the Date Sent field is changed for a letter, the corresponding action item (if one exists) is also updated with a new Due Date of Date Sent of the Letter and the number of days specified for the Action in the Letter configuration








Open a Message Editor

	
Click the letter icon to open the message editor.


	
The system opens the message editor. All fields are editable.





	Field/Control Name	Description
	To	Displays the email address specified for the Primary Reporter in the Case Form.
	From	Displays the email address specified in the Return Email Address in Argus Console > Code Lists > Letter Configuration.
	Subject	Displays the Case Number and the Description of the Contact log.













View and Print Letters Due

This Worklist functions displays a list all emails across all cases.

	
Hover over the Worklist menu and select Letters.


	
When the system opens the Letters page, enter the appropriate information.





Enter Case Search Criteria for Letters


	Field	Description
	Current Letter	Select the current letter from this list
	Date Range	Allows the user to select a date range from which cases may be selected. The selection made from the Date Range drop-down list automatically populates the From and To fields.
	Show only those cases with no previous notifications	Allows the user to filter the case list search to only those cases that have not had any correspondence letters sent.
	AC	Creates a query for an Advanced Condition









View and Print Letters

The Letters tab enables you to view and print completed letters.

	
Click the Description link to display the letter.


	
When the system opens the letter, click Print.










Perform a Medical Review

	
Hover over the Case Actions menu and select Medical Review.

The system opens the Medical Review form.


	
Click on the appropriate tab.





Use the Medical Review Tab

The system displays the user-defined fields in the Medical Review dialog box, if they have been enabled on the Case Form Analysis tab.

[image: Surrounding text describes medreviewtab.jpg.]

Enter information in the Case Narrative, Case Assessment and Event Assessment sections.


Enter Case Narrative Information

You can choose from the drop-down options associated with the fields to view any of the other narrative fields. The system saves the view as a default and uses it when you open the Medical Review for another case.





Enter Case Assessment Information

This section enables you to provide information about case details.

Select whether the case is serious or not from the Case Serious drop-down list. In a similar manner, select relevant information about Company Agent Causal, Listedness, and Case Outcome from the drop-down lists.





Enter Event Assessment Information


	Field	Description
	Product	Populated when events are entered in the Products tab and is displayed in the following format:
Product Name

Generic Name


	Causality as Reported/
Causality as Determined

Event PT (Description)/LLT

	Causality as Reported - Indicates the degree of reported causality.
Causality as Determined - This field is populated with information entered in the Reported Causality field.

Event PT/Description/LLT - This field is populated when events are entered in the Events tab and displays in the following format:

Event PT

Verbatim

LLT


	D/S	Displays the Diagnosis/Symptom details by D or S in line with the Events.
	Seriousness Severity Duration	Displays the Seriousness, Severity and the Duration of the Event.
	Data Sheet	Displays the data sheets for the agent.
	License	Displays the licenses for the agent.
	As Determined Listedness	Indicates whether the system found the event on the datasheet for this product.







Filter in the Event Assessment Section

The following table describes how the each field of the Event Assessment section is filtered:


	Field	Description
	Product	The product filter drop-down list contains all products listed in the event assessment. The user can filter on all products that are present in the Event Assessment dialog box.
	Event	Contains a drop-down of values of distinct Event PT. The user can filter on all products that are present in the Event Assessment dialog box.
	Diagnosis	Contains a drop-down list of values of D for Diagnosis or S for Symptoms.
	Data Sheet	Contains a drop-down of values of distinct data sheets. All blank data sheets display as a single row of <Unspecified>.
	Licenses	Contains a drop-down of values of distinct countries of the licenses. All licenses not associated with a data sheet appear under <Unspecified> or are aligned with the data sheet view.






Only the assessment rows that match the selected criteria are displayed in the filtering results.


User Actions—Event Assessment Section


	User Action	Result
	Click Datasheet column's plus icon	Displays the license, data sheet views and the license column and enables the - for the License Column.
	Click Product Name	Displays the Product Information dialog box for the selected product.
	Click Event Description	Displays the Event Information dialog box for the selected event.
	Click License Description	Displays the Product Information as defined in the License Configuration.
	Click Datasheet Description	Displays all the configured terms in the data sheet.







Attach Cases from the Medical Review Screen

The Notes and Attachments and Contact Log sections appear on the Case Form Additional Info tab to the Medical Review screen. The system displays user-defined fields in the Medical Review dialog box if they have been enabled on the Case Form Analysis tab.







Use the Temporal View Tab

Click the Temporal View tab to view a read-only version of the case before routing.

The information displayed in the Temporal View tab is taken from the information entered in the Case Form section.


View the Summary Section


	Field	Description
	First Suspect Product	Displays the name of the primary suspect product.
	Generic Name	Displays the generic name of the primary suspect product.
	Coded Indication	Displays information about the product indication.
	Company Agent Causal	Displays the case causality status.







Enter Display Options Information


	Field	Description
	Suspect Products	Check the checkbox to view Suspect Products in the Event Assessment Section.
	Non-Suspect Products	Check the checkbox to view Non-Suspect Products in the Event Assessment Section.
	Patient History	Check the checkbox to view Patient History in the Event Assessment Section.
	Patient Lab Data	Check the checkbox to view Patient Lab Data in the Event Assessment Section.
	Relevant Tests	Check the checkbox to view Relevant Tests in the Event Assessment Section.
	Events - All Events, Serious Events Only	Check the checkbox as required to view All Events/Serious Events Only in the Event Assessment Section.









View the Event Assessment Section


	Field	Description
	ID	Denotes the type of event. For example, HOSP means Hospitalized.
	Info	Click the Info icon (i) to view details about the selected entity.
	Item	Displays the item name.
	Start	Displays the date from when the event assessment began.
	Stop	Displays the last date of the event assessment.
	Duration	Displays the duration of the event assessment.






The system opens a unique dialog box for the event you have chosen to view.


	View Death Information	The system presents death information in this dialog box.
	View Event Information	The system presents event information in this dialog box.
	View Hospitalization Information	The system presents hospitalization information in this dialog box.
	View Patient History	The system presents patient history information in this dialog box.
	View Product Information	The system presents product information in the Temporal Information Product dialog box.











Enter Relevant Tests Information


	Field	Description
	Relevant Tests	Displays information about any relevant tests, if any.
	Zoom/Unzoom	Click the Zoom icon to view the report on a bigger scale.
Click the Unzoom icon to revert to the earlier view.


	Flag Icon	This icon displays the language text that is supported.
	Notes Icon	Click this icon to view/enter notes.













Perform a Coding Review

Hover over the Case Actions menu and select Coding Review.


Use the Coding Review Function

The Coding tab provides a single entry point for viewing and coding several kinds of information.

[image: Surrounding text describes codingreviewtab.gif.]


Review General Information


	Field	Description
	Report Type	Identifies the case type.
	Study Info	Displays study information about of the case.
	Patient Info	Identifies the patient's age and gender.
	Literature Info	Displays information about the Primary Literature of the case.









Review Product Information


	Field	Description
	Product Name	Displays the product name.
	Formulation	Select the formulation from the drop-down list.The Administrator can adjust the information in this list.
	Concentration / Units	Displays the configured Concentration and Units for the drug.
	Reported Indication	Enter the indication as reported.
	Coded Indication LLT	Enter the indication to be coded. Click Encode to display the associated coding dictionary.









Review Event Information


	Field	Description
	Preferred Term (LLT)	Displays the Preferred term for the selected term.
	Seriousness	Displays the Event Seriousness for the Event.
	Intensity	Displays the Event Intensity for the Event.
	Duration	Displays the Event Duration for the Event.









Review Death Information


	Field	Description
	Verbatim	Displays the coded or un-coded event verbatim for cause of death.
	Coded PT (LLT)	Displays the Coded PT with LLT in parenthesis.









Review Patient Information


	Field	Description
	Condition Type	Displays the condition type of the patient's previous history.
	Verbatim	Displays the condition of the patient's previous history.
	Coded PT (LLT)	Displays the Coded PT with LLT in parentheses.









Review Lab Data Information


	Field	Description
	Test Name (LLT)	Displays the Lab Data Verbatim for the Lab Data.
	Results	Displays the entered Results for the Lab Data.
	Units	Displays the entered Units for the Lab Data.
	Coded PT (LLT)	Displays the Coded PT with LLT in parenthesis.
	Normal High	Displays the configured Normal High with Units for the Lab Data.
	Normal Low	Displays the configured Normal Low with Units for the Lab Data.









Review Parent Information


	Field	Description
	Condition Type	Displays the condition type of the Parent previous history.
	Verbatim	Displays the condition of the Parent previous history.
	Coded PT (Description of condition LLT)	Displays the Coded PT with LLT in parenthesis.









Review Case Analysis Information


	Field	Description
	Company Diagnosis / Syndrome	Displays coded or un-coded event term for diagnosis or syndrome that the company ascribes to the case.
	Coded PT (LLT)	Displays the Coded PT with LLT in parenthesis.











Review your Coding Action Items

The Coding Review > Action Items section lets you view or enter details of action items for the case and assign responsibilities for actions.

[image: Surrounding text describes codingreviewactionitem.gif.]




	
Note:

You can also view this screen by hovering over the Worklist menu and selecting Coding Action Items.








Review Action Items Information


	Field/Control Name	Description
	Date Open	Enter the date the action item was created. Open action items appear in the Worklist of the user who is responsible for it. They also appear in the Open Action Items report.
	Code	Select an action item code from the drop-down list. This displays the description of the selected Action Item Code. Contact your system administrator to adjust this list.
	Description	Selecting an Action Item code automatically enters information into this field. The text can be modified. The Administrator can adjust this list.
	Group /Responsibility	Select a group responsible for the action item from the given drop-down list. From the drop-down list below this, select a user from the selected group who is responsible for the action. The action item appears in the Worklist for the selected user. If Any is chosen as the group, the action item appears in all the users' Worklist. Contact your system administrator to adjust these lists.
	Due	Enter the date on which the action item is to be completed.
	Completed	Enter the date on which the action item was completed. A red border indicates a completed action item while a green border indicates an incomplete action item.
	Sent in Letter	Identifies that the Query Type Action item has been sent as a part of the letters. Displays only for those action items that are configured as Query Action in the Argus Console's Action Type codelist.









Open Action Items Reports

To view all outstanding action items, select Dashboards > Open Action Items.

The Open Action Items Report appears in the PDF format and is sorted as per the Case ID of the listed cases.


	Field	Description
	Action Item	Status of the case and the action that needs to be taken
	Date Assigned	Date when the case was opened/assigned
	Assigned To	Workflow/Case Owner













View Coding Status

	
Hover over the Worklist menu and select Coding Status.


	
When the Coding Status screens appear, enter the information in the fields as necessary.





Coding Status Icons


	Icon	Description
	[image: Surrounding text describes verbatiam.gif.]
	Displays that the verbatim text has not yet been coded.
	[image: Surrounding text describes verbatimy.gif.]
	Displays that the verbatim text has been successfully coded.
	[image: Surrounding text describes wait.gif.]
	Is displayed if the verbatim text has been submitted to Central Coding, but no result has been returned to Argus yet.
	[image: Surrounding text describes stop.gif.]
	Is displayed if the term was submitted to Central Coding for coding and returned a status of error either from Central Coding or Argus.









Enter Case Search Criteria


	Field	Description
	Date Range	Select a relevant Date Range, if applicable.
To enter a customized date range, select Custom Date Range from the list.


	Advanced	Select an advanced condition for the case, if applicable.
Click AC to create a new advanced condition.








The search results are displayed in the Total Number of Rows section. The following table lists and describes the fields in this section.


	Field	Description
	Seriousness Criteria	Displays the Case level Seriousness Criteria. In case the case has any Fatal or Life Threatening event, it is displayed as such.
	Aging (Days)	If all codeable items of the case are coded completely, Aging is displayed as the Number of days from the Initial Receipt Date to the date when latest item of the case was coded.
If any code-able item of the case is not coded, Aging is displayed as the Number of days from the Initial Receipt Date to the system date (Database Server).


	Coding State	If all the events / products are encoded, the coding state is denoted with a green check mark.
If the case has even a single code-able item as not coded, the coding state is shown as a red cross mark.













Review your Case for Regulatory Submission

The Analysis tab enables you to generate or view a narrative description of the case along with other notes. It also enables you to enter information required for generating the MedWatch 3500A, BfArM, and AFSSaPS reports.

Use this tab to:

	
Make a medical assessment of the case


	
Approve the case for completeness and accuracy





Use the Case Analysis Section

Use this section to enter narrative information about the adverse event.


Enter Case Analysis Information


	Field/Control Name	Description
	Narrative	Click Generate to generate an auto narrative.
Contact your system administrator to configure this feature. If you are not utilizing the auto narrative feature, enter the narrative here. The narrative is printed on Expedited reports.


	Case Comment	You can enter comments in this area. If you are not permitted to edit the auto narrative, you can use this field to provide additional details important to the interpretation of the case. Comments appear on certain Expedited reports.
	Abbreviated Narrative	Enter brief comments in this field. This item maps only to the PSUR report.
	Company Comment	Enter comments in this area. This information does not appear on Expedited reports.
	Evaluation in light of similar events in the past	Enter an evaluation comment that takes in to consideration similar events that have occurred in the past.






To generate or add narrative templates:

	
Click the button to view the Custom Auto Narrative Templates dialog box.


	
Select the required Autonarrative from the list.


	
Click Append to append this Autonarrative to the existing narrative.


	
Click Append if this is the first narrative being added to the text area.


	
Click Replace to replace the existing narrative with the selected narrative.




	
Note:

Contact your system administrator to configure allowing modification of the Autonarrative text.
If an Autonarrative template has been configured in multiple languages, icons representing the languages appear above the text area.













View Differences in Case Narratives

You can view the differences in case comments from previously locked versions of the case. To view these differences, click the Show Difference button in the Case Analysis section of the Analysis Tab.

When you choose to view the differences in the two narratives, the system does the following:

	
Displays the differences in red with a strike out and a yellow highlight.


	
Displays additions to the narrative in black with green highlights.


	
The system displays the last revision number of the case and date and time stamp in the following format:


	
(Last revision # X as of YYYY MMMM)

where:


	X	Is the revision number of the last case.
	YYYY	Is the date the case was locked.
	MMMM	Is the time the case was locked in 24-hour format.






	
The system disables the button if there is no previously locked version of the case.








Use the Case Summary Section

The Case Summary section of the Case Analysis tab enables you to enter summary information about the adverse event.


Enter Case Summary Information


	Field/Control Name	Description
	Case Serious	This list indicates whether the overall adverse event case is serious or non-serious. This assessment is performed by the system from the Seriousness Criteria of the Events tab. If any of the Seriousness Criteria was selected for any event in the Event tab, Yes is selected in the list. No is selected if the Seriousness Criteria is cleared for all events in the Events tab. You can modify the selection after entering a justification, if you have the access rights to do so.
	Case Serious Notes	A justification for overriding the system determination appears in the Notes area. Click the green dot to revert to the automatic calculation for seriousness or to view the overriding notes.
	Causality considered expeditable	The system determines this value from the As Determined causality in the Event Assessment section. This field is displayed as Yes if the As Determined causality is Yes and vice versa. If the As Determined causality is Unknown, this field will be Yes.
	Causality considered expeditable Notes	A justification for overriding the system determination appears in the Notes area. Click the green dot to revert to the automatic calculation or to view the overriding notes.
	Listedness Determination	The value for this field is calculated from the Event Assessment section in the Events tab. If any row there displays Unlisted under the Listed column, this value is set to unlisted.
	Listedness Determination Notes	A justification for overriding the system determination appears in the Notes area. Click the green dot to revert to the automatic calculation or to view the overriding notes.
	Case Outcome	The value for this field is calculated from the Events tab. If the outcome for any event is Fatal, the case outcome is set to Fatal. If the case outcome is changed here, that change is not made to the event outcome in the Events tab.
	Company Diagnosis/Syndrome	The company diagnosis or syndrome is entered in this field.
	Notes	A justification for overriding the system determination appears in the Notes area. Click the green dot to revert to the automatic calculation or to view the overriding notes.









Use the MedWatch Info Tab

The MedWatch Info tab enables you to enter additional details required for the MedWatch 3500A Drug Report.


Enter MedWatch Info Details

The values in the Form section column refer to specific sections of the MedWatch 3500A Drug Report form.


	Form Section	Field Description
	B. Adverse Event or Product Problem	Select Adverse Event when a product is suspected to have caused an adverse outcome in a patient.
Select Product Problem when the defect or malfunction in the product could lead to a death or serious injury.

Check both checkboxes if a malfunction or product problem caused a death or serious injury.


	C. Suspect Medications (NDC#)	Enter the National Drug Code if you have checked the Product Problem checkbox.
	F1. Check one	Indicate whether this report is from a user facility or an importer. You can suppress printing of Block F of the MedWatch 3500A report by selecting Suppress Block F Printing.
	F2. UF/Dist report number
Consider UF / Importer data from

	Enter the complete number of the report exactly as entered in the upper right corner of the front screen.
Select User Facility or Importer information from the Case Form or the Reporting Destination.


	F3. User facility or Importer Name
Address1/Address 2/City / State/ Country/Postal code

	Enter the full name and address of the user facility or distributor reporting site.
	F4. Contact person
Sal/First Name/MI/Last Name

	Enter the full name of the medical device reporting (MDR) contact person. This is the person who is designated as the device user facility/distributor contact for this requirement. The FDA will conduct its MDR correspondence with this individual. The contact person may or may not be an employee of the facility.
	F6. Date aware of event	Enter the date when the user facility's medical personnel or the distributor became aware that the device may have caused or contributed to the reported event.
	F10. FDA codes Patient
FDA Device Codes

	Click the first row and column of the FDA Patient and Device Codes section and then click Select. You can enter up to 6 FDA Patient Codes. If the entered code is not present in the FDA Codes list, it is erased.
	F11. Report sent to FDA	Check this checkbox if a report has been sent to the FDA. If you select it, enter the date when the report was sent to FDA.
	F13. Report sent to mfr?	Check this checkbox if a report has been sent to the manufacturer. If you select it, enter the date when the report is sent to manufacturer.
	G. All Manufacturers	-
	G3. Report Source	Check the Report Source checkboxes as applicable, to match all report sources specified with the Reporter Type.
See the guidelines below this table for checking the checkboxes.


	G5. STN# Pre-1938 / OTC Product	Enter the PLA number.
If the product pre-dates 1938, select Pre-1938.

If the product is an over-the-counter product, select OTC product.









Check G3 Report Source Checkboxes


	If this condition is true	Check the following checkbox
	Country of Incidence is not USA.	Foreign
	Report Case type is configured to contain cases from Literature.	Literature
	Report Case Type is configured to contain cases from Clinical Trials.	Study
	Any reporter with Health Professional set to Yes.	Health Professional
	Any Reporter Type is selected as Company Representative.	Company Representative
	Any Reporter (Primary or Other) exists in a case with a Reporter Type of Other. If the selected Report Type is a Regulatory Authority (text value) within the Argus Case, the Other checkbox should be checked and the text Regulatory Authority should be entered in the text box.	Other
	Any Reporter Type is selected as Consumer AND none of the reporters is identified as Health Care Professional.	Consumer






The User Facility and Distributor checkboxes must be checked manually.

Enter the text if you have selected Other as a report source.







Use the BfArM Info Tab

	
Open the BfArM Info tab.


	
Select the choices that apply to the patient from the items in the form.


	
If you do not know if a particular condition applies for the patient, select Unk.







	
Note:

If any of the relevant items are entered in the Current Medical Status form in the Patient tab, the system enters them here. If you change any of those items in the BfArM Info tab, the system will not enter the data in the Patient tab.











Use the AFSSaPS Info Tab

Use the AFSSaPS Info tab to enter the imputability assessment information for the suspect product along with the Adverse Events.


Enter AFSSaPS Info Details


	Field/Control Name	Description
	Event	Displays included terms for all events.
	Product	Enter the suspect product. You cannot enter a concomitant product.
	Chronology	Select a Chronology code. The fixed set of values is C0, C1, C2, and C3. Click the icon to select the Time to onset, Readministration and Drug Stopped Values.
The user's selection auto-calculates the Chronology for the Product - Event combination.


	Semiology	Select a Semiology code. The fixed set of values is S1, S2, and S3.
Click the icon to select the Semiology Outcome, Complementary Test, and Other Explanation.

The user's selection auto-calculates the Semiology for the Product - Event combination.


	Bibliography	Select a Bibliography code. The fixed set of values is B0, B1, B2, and B3.
	Imputability	Imputability Calculation:
	~	Check from one or more of the following checkboxes:
	
Poursuite de l'étude sans modification du protocole


	
Poursuite de l'étude avec amendement au protocole


	
Arrêt de l'étude


	
Arrêt du développement du produit


	
Autres




The text box after Autres supports fifty characters. If the Autres checkbox is not checked, the field is disabled.

You can click Copy to Local Evaluator Comment to copy imputability values to the Local Evaluator Comment field and place the imputability text-equivalent at the beginning of the text that currently exists in the field. Copy to Local Evaluator Comment is visible only if the language for the Local Evaluator Comment field is French.


	Future Actions	Enter a text description for future actions.











Route a Case to the Next Workflow Step

The Routing Comments section displays workflow routing information and comments for the case. It also contains a read-only sub-section on Case Locking/Closure.

	
Select Route from the Activities tab of the Case Form menu to open the Case Routing dialog box.


	
From the Route to Next State drop-down list, select the state to which you would like to route the case.

If only one workflow state can be selected for the Next Route state, that state is selected by default in the Route to Next State field.


	
From the Route to User drop-down list, select the user or user group to route the case to.


	
Enter the routing comments in the Comments field.

OR

Click Select to select a comment from a list of pre-defined routing justifications.





	Field/Control Name	Description
	Date	The date the case was routed to a new workflow state. Automatically generated when a case is routed.
	User	Displays the name of the user who routed the case. Automatically generated when a case is routed.
	Comment	Displays the routing comment.
	Route button	Routes the cases.
	Return button	Returns the case to the previous state.







Route Cases

If the case meets the routing rules specified by the Administrator, you can use the Case Routing dialog box to route a case to the next workflow state.

	
Non-Enterprise Workflow managers cannot view all the Workflow States below the line if the Workflow States are assigned to sites in the Workflow Configuration.


	
Only Enterprise Workflow Managers have access to all sites for routing cases ahead in the Workflow.


	
If the Workflow state does not have defined sites, all Workflow Managers can see it.





Routing Comments Log and Case Print

Local Lock/Unlock details are displayed as part of the Routing Comments log in the Case Form > Activities tab.

The text Case Locally Locked for JP or Case Locally Unlocked for JP is populated before the user added comments in the Local Lock screen, corresponding to the local lock or unlock action. JP is the standard A2 country code for Japan defined in the Argus Console > Countries codelist.

When a case is globally/locally locked or globally/locally unlocked at the same time, only one entry is added to the Routing Comments log.

The text Case Globally and Locally Locked for JP is added for single lock operation.

The text Case Globally and Locally Unlocked for JP is added for single unlock operation.

The system records the corresponding routing comments even in scenarios where the system user (for example, AGservice) performed the local lock/unlock action.


To select text from the pre-defined list of routing justifications

	
Click the Select button in the Case Routing dialog box to open the Routing Justification dialog box.


	
Select the required justification from the justification list displayed under Select a standard justification for this field. The system highlights the selected row.


	
Click OK.


	
The system closes the Routing Justification dialog box and displays the selected justification text in the Comments field in the Case Routing dialog box.


	
Click OK.







	
Note:

The system displays disabled users in the user drop-down list in alphabetical order with an asterisk (*) at the end. You can view the total number of times the case has been routed in the header section, excluding the blank rows.











Return Cases

If necessary, you can return a case to its previous workflow state.

	
Open the case.


	
Click the Return button in the Activities tab of the Case Form.


	
When the system opens the Case Routing dialog box, enter your password.


	
From the Route to User drop-down list, select the user or group the case needs to be returned to.


	
Enter any routing comments in the Comments field.


	
Click OK.










Close, Save or Copy a Case


Close a Case

	
Hover over the Case Actions menu and select Close.


	
On the Save Case dialog box, click Yes to save and close the case.

OR

Click No to close the case without saving it.

	
The system opens the next active case, if you have active cases that you are working on. If there are no active cases, the system displays the default Worklist.


	
If the default Worklist option is <None>, the Personal Argus Status appears.











Save a Case

	
Click the Case Number of the case you want to save.


	
When the system opens the Case Form, hover over the Case Actions menu and select Save.


	
When the system opens the Case Form Saving dialog box, click OK.








Copy a Case

Argus enables you to save all or part of a case and stores the copy in the database as a separate case. Clicking the case reference in any copied case opens the original case.

If your system is configured for manual case numbering, the system prompts you to enter a new Case ID. Otherwise, the system automatically assigns a new Case ID.

	
Hover over the Case Actions menu and select Copy.


	
When the system opens the Case Copy - Webpage dialog box, enter the number of copies you want to make and click Yes to copy the case.


	
When the system displays the Case Copy dialog box, check the appropriate checkboxes to select the portions of the case you want to copy

OR

Click Select All to copy the entire case.


	
Click Copy.

Depending on whether the system is configured for automatic case numbering, the system either generates a case ID or enables you to enter the case ID for this case.

Null flavor data is copied along with Case Form data on Case Copy.










Use the Print Function


Print a Case Form

	
Open a case.


	
Hover over the Case Actions menu and select Print > Case Form.

The system opens the Print Case tabbed dialog box.

[image: Surrounding text describes printcasetab.gif.]

	
Check the checkbox for each section of the Case Form you want to print

OR

Click Select All to select all the sections of the Case Form.


	
Click Print to print the case.








Print a Medical Summary

	
Open a case.


	
Hover over the Case Actions menu and select Print > Medical Summary.

The system opens the Medical Summary Report.


	
Select File - Print in the PDF to take a printout of the medical summary.








View and Print Letters

The Letters tab enables you to view and print completed letters.

	
Click the Description link to display the letter.


	
When the system opens the letter, click Print.








View and Print Attachments

The Attachments tab enables you to view and/or print case attachments. The system prints date/time information:

	
As footers on all printouts (except letters).


	
In the following format: dd-mmm-yyyy hh24: mm: ss.




	
Click the Description link to display the attachment.


	
When the system opens the letter, click Print to print it.










Unblind a Study

When a study is complete, you can unblind all the cases associated with the study at the same time instead of unblinding them one by one.

	
From the Utilities drop-down menu, select End of Study.

The End-of-Study-Unblinding (EOSU) dialog box appears.

EOSU does not pick a case that is globally or locally unlocked, or pending local or global report submission.


	
From the End-of-Study Unblinding drop-down list, select a study.


	
In the Dosage Regimens dialog box, enter the drug dosage information.


	
Click OK.




	
Note:

For each case that is unblinded by this method, the Blinding Status is adjusted to "Broken After Study" if the study type is single or double blinded and enters the following information: \
	
Unblinding Date


	
Study Drug


	
Follow-up Received Date


	
Mark case as Significant


	
Dosage Regimen



















Lock or Unlock a Case

The Case Lock/Close section enables you to lock a case, unlock a locked case, and formally close a case. You must lock the case before you can generate a report.


Lock a Case

	
In the Case Lock/Close section of the Activities tab, click Lock.

The system opens the Case Locking dialog box.


	
Enter your Argus Safety password in the Password field.


	
Enter any notes in the Notes field.


	
Click OK.


	
The system displays the locking notes in the Notes field of the Case Lock/Close section.





	Field/Control Name	Description
	Case Status	Enables you to unlock, lock, or close a case after entering user information.
	
Unlock -- Enables you to unlock a case if you have the permissions. To unlock a case, enter the password you use to log on to Argus Safety.


	
Lock -- Enables you to lock a case if you have the permissions. The current date is used for the lock date. To lock the case, enter the password you use to log on to Argus Safety in the Case Locking dialog box.


	
Close -- Enables you to close a case if you have the permissions. To close the case, enter the password you use to log on to Argus Safety in the Case Closure dialog box.

Note: Auto-archiving a case is not allowed if any local or global reports are pending for generation. If a user tries to close a case for which Local Reports have not yet been submitted (through this Case Status field here), the application displays a message that the case cannot be closed due to reports needing submission.





	Closure Date	Date on which the case was locked or closed. If a locked case is being viewed by a user, any other user who tries to access the same case will have read-only access to the case.
	
Cases must be closed only after all action items for the case are complete, all Expedited regulatory reports have been submitted, and all the expected Follow-up information has been received. If a closed case requires modification, the case must be re-opened by using the password.


	
A case may be either locked or closed, but not both. A locked case will be moved from the locked state to the closed state without having to unlock first.

Note: Case closure should not be confused with closing the Case Form. Closing of the Case Form refers to removing the current Case Form from the screen.





	Lock or Closed By	Displays the name of the user who locked or closed the case.
	Notes	Displays relevant information about the case lock or closure.






Understand Lock Statuses


	Lock Status with Icon	Description
	Global Locked [image: Surrounding text describes glbl.jpg.]	Denotes a locked case that does not have local reporting needs.
	Global Unlocked [image: Surrounding text describes glbl1.jpg.]	Denotes an unlocked case that does not have local reporting needs or where the Local PRPT case is both globally and locally unlocked.
	Global Locked and Local Locked [image: Surrounding text describes glbl2.jpg.]	Denotes a Local PRPT case that is locked at both global and local levels for all local countries for the case.
	Global Locked and Pending Local Lock [image: Surrounding text describes glbl3.jpg.]	Denotes a Local PRPT case that is locked global but pending local lock for any local country for the case.






When a user clicks on the Local Lock icon on a case that has been Global Locked but is pending Local Lock for Japan, the system displays a pop-up window to validate the user who attempts to perform the local lock on the case.

Enter the password and notes to perform the local lock on the case.

When a user clicks the Local Lock icon on a case that has already been Local Locked for Japan, the system checks that the common profile switch Enable Local Unlocking for the current enterprise is set to Yes. If this option is set to No, it displays a message that the Local Unlocking feature is not enabled.

If the option is set to Yes, the system checks if the case has any Local Japan report, that is pending generation, and displays a warning message.

If there are no Local Japan reports that are pending generation, the system prompts the user (on Case Local Unlock dialog box) on whether they want to proceed with Local Unlock.

On clicking Yes for Local Unlock, the system validates the user again.

After the user has been validated, the system stops any local Japan report that is pending generation from being generated and enables all the Local Fields for editing.

After a case has been globally locked and a local user (Argus J user) opens that case, the application allows the local user to enter local data, as follows:

	
All local fields remain editable for the Argus J user.


	
All existing Case Form fields and tabs that remain editable after global lock retain the same behavior (irrespective of English or local users).


	
Any operation that updates the global value such as Re-arrange, Add, Delete, Up / Down buttons, Relationships, Copy Japanese to English button, Lab data import is not allowed. One exception to this is Case Classification field - the Add and Delete buttons remain available.


	
The Copy English to Japanese button allows the user to copy information from English to Japanese data entry. No global values are updated with the Copy action.




On global lock, all the qualifying reporting rules are executed as follows:

	
All the qualifying Global (that is, non-Japan) and Japan Local reports are scheduled.


	
The Global (that is, non-Japan) reports are generated/transmitted as per the existing functionality.




However, the Japan Local reports cannot be generated before local lock is performed.


Use the One-Step Global and Local Lock

In some scenarios, when a Japanese user enters a domestic case, both the local data entry and English translation may happen before the global lock, which necessitates the Global and Local Lock be done in a single step by the Japanese user.

When a local user (Argus J user) performs a global lock, the system displays the existing Case Locking dialog box but enhances it with an option to perform Local lock additionally for a Local PRPT case.




	
Note:

This functionality is applicable for global case locking done from any place via the application's UI including Case Form, E2B, Incoming Review, and so on.







This checkbox appears only for a Local PRPT case, when the user has Allow Local Locking enabled under Argus Console > Access Management > Users.

When the user clicks OK on this screen to perform Global Lock and if the Local Lock option is checked, the system performs both the global and the local lock for the case.





Unlock a Case

	
In the Case Lock/Close section, select Unlocked from the Case Status drop-down list.


	
When the system opens the Locked Case dialog box:

	
Type your password in the Password field.


	
Type any relevant information in the Notes field.


	
Click OK.





	
When the system opens the Case Unlock dialog box, click one of the following:

	
Significant F/U


	
Non-significant F/U


	
Other







When a user performs global unlock for a case, the system checks if the case has local or global reports in pending generation state (scheduled and new data available states as identified by the configured SQL explained below) or pending lock (for Local PRPT case), as explained below:

The checks for reports pending generation are applicable only when DLP_EXPEDITED_E2B_REPORTS is set to 0 (that is, DLP is not enabled for Expedited reporting).

The system checks the value returned by running the SQL (if any) configured in the SQL to prevent case unlock when reports are pending generation common profile switch under Case Processing. If the value returned is 0 or no SQL has been configured, the system allows users to global unlock the case without any of the other checks.

If the value returned is greater than 0, the system behaves as follows:

	
If the Value of Allow forced unlock (Global and Local) is No and the Report status (Global or Local) is Pending (that is, the configured SQL returned a value > 0), the case is not unlocked and an error message is displayed.


	
If the Value of Allow forced unlock (Global and Local) is Yes and the Report status (Global or Local) is Pending (that is, the configured SQL returned a value > 0), a warning message is displayed. The case is unlocked using the Locked Case dialog box if the user selects Yes on the warning message.


	
If the Value of Allow forced unlock (Global and Local) is N/A and the Report status (Global or Local) is Generated /Submitted (that is, the value from SQL check returned 0 or no SQL has been configured), the case is unlocked.




This switch functions independent of the Allow Local Lock and Enable Local unlocking privileges. For example, a local user who does not have the Allow Local Lock privilege but has the Allow forced unlock (Global and Local) privilege can globally and locally unlock the case on Global unlock.

When a user performs a global unlock for a case that has pending local lock (for a Local PRPT case), a warning message is displayed.

When a user performs global unlock for a case that has pending local lock (for a Local PRPT case):

	
If the value of Allow Global Unlock on Pending Local Lock is set to Yes, a warning message is displayed. If the user selects No, the case is NOT unlocked. If the user selected Yes, further checks on reports are implemented.


	
If the value of Allow Global Unlock on Pending Local Lock is set to No, the case is NOT unlocked and an error message is displayed.


	
If the case has both local lock pending and reports scheduled, the pending local lock check takes precedence over the pending report generation check.


	
This functionality is applicable for case unlocking done from any place via the application's UI including Case Form, LAM, E2B, Incoming Review, and so on.




This feature is NOT applicable to End of Study Unblinding (EOSU).







Create a Follow-up Event

After unlocking a case, the system sets the focus for significant/non-significant follow-up events as follows:

	
When you click the Significant F/U button on the Case Unlock dialog box, the system displays the case General tab, checks the Significant checkbox for both drugs and devices (if enabled by the profile switch), and sets the focus on the Follow-up Received Date.

Argus > Case Actions > Open > (Select a Case) > General Tab > General Information Section > Follow-ups sub-section (middle of screen).

	
The system checks to determine whether the Significant checkbox is checked.


	
The system sets the focus on the Follow-up Received Date.





	
When a case is unlocked and you select the Non-Significant F/U button from the case unlock pop-up window, the system displays the case General tab and sets focus on the Follow-up Received Date.

Argus > Case Actions > Open > (Select a Case) > General Tab > General Information Section > Follow-ups sub-section (middle of screen)

	
The Significant checkbox is not checked.


	
Focus is on the Follow-up-Received Date.




	
You can add multiple follow-ups.

Argus > Case Actions > Open > (Select a Case) > General Tab > General Information Section > Follow-ups sub-section (middle of screen)

	
If you add a single Follow-up, the Add button remains available for the user to add additional Follow-ups.


	
The Add button disappears after the user adds a single Follow-up. The user must save, close, and reopen the case before they can add an additional Follow-up.





	
A hyperlink in the Follow-ups section enables you to open the link in a different dialog box.











Delete or Undelete a Case


Delete a Case

	
Hover over the Case Actions menu and select Delete.


	
When the system opens the Action Justification dialog box, do one of the following:

Enter the justification manually in the Please enter a justification for performing this action: field

OR

Select a pre-defined justification from the Select a standard justification field.


	
Type your Argus login password in the Password field.


	
Click OK.




When you delete a case, you can no longer access it from the application. However, the system retains the case information from the database. Before the system permits you to delete a case, you must provide a justification.





Undelete a Case

	
To restore deleted cases, hover Utilities, and click Case Undelete.


	
To retrieve deleted cases, in the Case Search Criteria fields, enter the value, and click Search.

The search results appear in the Total Number of Rows section.


	
Check the checkbox for the case number to restore it.


	
Click Case Undelete.


	
In the Action Justification dialog box:

	
In the Please enter a justification for performing this action field, enter the justification manually.


	
From the Select a standard justification for this field drop-down list, select a pre-configured justification.





	
Click OK.










View Case Revisions

	
Open a case.


	
Hover over the Case Actions menu and select Case Revisions.

The system opens the Argus Safety Case Details dialog box. The dialog box provides the following information for the current case:

	
Scheduled Reports


	
Submitted Reports


	
Case Revisions





	
Select the desired report from this list.




The system displays the Audit Log Details screen containing a list of all revisions.

	
Revision History dialog box of Case Actions | Case Revisions displays the Lock icon for the revisions in which the case is in locked state.


	
Unlock icon is displayed for the revisions where the case is in unlocked state.


	
Archive icon is displayed for the revisions where the case is in archived state.




You can track the revision where follow-up information was appended to the case. The follow-up designations are as follows:

	
(S) F/U - Indicates that Significant Follow- up information is attached to the case.


	
(NS) F/U -Indicates that the Follow-up information attached to the case is not Significant.








View Audit Logs

Logs are a repository of all the cases in the database, displaying the following entries:

	
Activity


	
Audit Data


	
User ID


	
Date.Time




The audit log is a chart that show modifications that have been made to a particular case since the case's inception.

It also shows which user made the changes, the date and time the changes were made, and the old and new field values. Run the AG Service Audit Log update to log all the cases.

To view an audit log, from the Utilities drop-down menu, select Logs > View Audit Log.

	
To search the logs, in the Search Conditions section, enter or select a criteria, and click Search.

To view all the updates performed by the user, from the Category drop-down list, Select All.

You can select a category and filter on a specific field elements, and you can view all revisions at the same time by clicking the checkbox near the Revisions column.


	
The search results appear in the Total Number of Rows section. The following table lists and describes the fields in this section.


	Field	Description
	Action	Displays the Audit Log Details Screen.
	Activity	Displays the status of the activity. Displays whether it has changed or not.
	Audit Data	Displays the audit data in the following format:
Name of the entity (such as Advanced Condition): deleted or changed (as applicable) in entity (such as Advanced Condition)


	User	Displays the last user who made changes to the case.
	Date/Time	Displays the last time the case was changed.
Note: The time displayed is as per GMT.








	
To print all the logs, click Print List.





Audit Log Details Screen

The Audit Log functionality tracks all central coding activities for the code-able event and products.

	
Click the Action icon.


	
To display the details, click a row with a revision.




Audit log for the case has the record of the central coding related changes. These changes display the Username as the associated Central Coding Username concatenated with Central Coding.

Multiple selections can be made to view the details of revisions.





LAM Audit Log

To track changes made while using the LAM module, from the Utilities drop-down menu, select LAM Audit Log.

	
Argus Safety Audit Logs:

	
To view all updates made by a user, from the Category drop-down list, select <ALL>.


	
To enable the Search button, from the drop-down list, select a User Name.

The default User Name is updated as the name of the user who is logged in.


	
The category is identified on the UI.


	
The print list displays the Category.


	
The element field label is updated based on the selected category. If you do not enter an element value, the audit details are returned as-is.


	
You can view all revisions at the same time by selecting the checkbox near the revisions column. The entire audit trail for the elements is displayed.





	
Argus Affiliate Audit Log

	
You can filter for a specific Affiliate event in the audit log.


	
You can view all revisions at the same time by selecting the checkbox near the revisions column. The entire Audit trail for the elements is displayed.


	
You can view all LAM user updates made for Argus Safety cases under the LAM Audit Trial.

For example, the Action Items which can be closed or perform local labeling by a Affiliate user is visible under the LAM audit trail.


	
Central User updates do not display under the LAM audit trail.


	
Any user who has access to LAM Audit Log can view All cases associated with that site.


	
The audit trail detail print includes only the revisions that you have selected.





	
Search Conditions

The Search Conditions section enables you to enter information for retrieving the audit logs you want to view.


	
Total Number of rows

The search results are displayed in the Total Number of Rows section. The following table lists and describes the fields in this section.


	Field	Description
	Action	Displays the Audit Log Details Screen.
	Activity	Displays the status of the activity.
	User	Displays the last user who made changes to the case.
	Date/Time	Displays the last time (as per GMT) the case was modified.
	Print List button	Prints the list of all the logs.














View the Error Log

To view the error log for information about errors that occurred during case processing:

	
From the Utilities drop-down menu, go to Logs > View Error Log.


	
To search for error logs based on pre-defined or custom date ranges, in the Search Conditions section, enter a value, and click Search.

The search results appears in the Total Number of Rows section.


	
Locate the error log you want to view, and click to view the error message text.

Click the Zoom icon to view the complete text.











5 Use Advanced Conditions

You can create complex or non-standard queries in the Advanced Conditions screen where you can define field-level search criteria. To create advanced conditions, detailed knowledge of the database schema is not required.




	
Note:

Only users with execute rights for an advanced condition, can view the advanced condition in the drop-down list in the Case Open dialog box.







When using Advanced Conditions:

	
By default, the Advanced Conditions drop-down list enables you to view only the New, None, and already selected Advanced Conditions.


	
Access rights and permissions can be assigned to the individual advanced conditions. You can execute and modify access rights to one or more groups on a per-advanced condition basis.





Create, View or Modify Advanced Conditions

	
From the Advanced Conditions drop-down list, select New.

OR

Click the Advanced Conditions icon.


	
To create a new advanced condition query set, in the Confirmation dialog box, click Yes.


	
To create a new advanced condition by associating logical operators (like AND, OR) with items from the Case Form, in the Confirmation dialog box, click No.

The Use the Advanced Condition Set Dialog Box appears.





Use the Advanced Condition Set Dialog Box

You can search entities under the Properties tree-list that are from either the case data or from the code list.

[image: Surrounding text describes acs.jpg.]

The dialog box has two buttons that provide this functionality:

	
From Code List—Displays a list of all values configured in the Code List in the Value drop-down list. The values in the Code List are configured by the administrator in Argus Console. To configure these values, refer to the Administrator's Guide.


	
From Case Data—Displays only the values actually in the cases in the Value drop-down list.


	
These radio buttons appear only if the selected entity belongs to a code list.

To search the entity based on the code list or case data, select the relevant entity and one of the radio buttons.


	
In the following sections, select the product from the company product browser instead of the drop-down values. To do so, in the Read Only text field, click Select.

	
Suspect Product Name


	
Product Name 2/Study Cases


	
Company Product


	
Study Drug


	
Primary Suspect Drug





	
To enable you to search on the selected product, the Product Name is transferred to the user interface.


	
From the Properties tree list, select a property type.





Use Information from Properties for Advanced Conditions

The items available in the folders in the Properties list represent Case Form fields that you can use to perform search in the advanced conditions.

	
To enable a field-to-field comparison, you can auto-populate an Advanced Condition by right-clicking a field in the Properties section.


	
To enable the Select button, select a property for which terms can be encoded.

To select (possibly) multiple terms for the property, use the MedDRA Browser. See Using the MedDRA Browser for further details.


	
The enable SMQ icon, from the Properties tree-list, select SMQ-related properties.

To view details about the selected SMQ, click this icon.




	
Tip:

To view or modify the SQL statement associated with an advanced condition, click Show SQL.








	
In the Conditions list, select a condition that must apply to the item selected above.

	
In the Value field, enter the value that applies to the property or select an a value from the list.


	
To link this created condition with another condition, from the list adjoining Value, select a logical operator.


	
To add the newly created condition to the advanced condition, click Add.




	
Tip:

You can use the AND and OR logical operators to link an existing condition to a new condition.
	
If you are using the AND operator to link two conditions, both conditions must be TRUE for the advanced condition to be TRUE. In all other cases, the advanced condition evaluates to FALSE.


	
If you are using the OR operator to link two conditions, the advanced condition is TRUE if either or both conditions are TRUE. The advanced condition evaluates to FALSE if both conditions are FALSE.













	
To add more conditions to the advanced condition, repeat above steps.


	
When all the conditions are entered, click Save.


	
Enter a name for the advanced condition, and click OK.








Use the Advanced Conditions from the Case Selection Dialog Box

Users can view a list of Cases that satisfies an Advanced conditions from the Case Open screen.

	
Select Case Actions > Open.


	
You can do the following:

	
Use a set of previously saved criteria


	
Select the appropriate set of criteria from the Advanced Condition list.


	
Select the set of criteria from the Advanced list, and click the adjoining Advanced Condition icon.


	
Add a new condition to a set of criteria.


	
Create a new advanced condition by associating logical operators (like AND, OR) with items from the Case Form.











Share Advanced Conditions

You can share the advanced conditions with other users. This feature can be made available by the administrator by logging into Argus Console.

To enable other users to use the advanced condition, click the Share with other users.

	
If an Advanced Condition is not shared with other users, the Advanced Condition does not appear in the Advanced Condition list for any user except the Administrator and the user who created it.


	
If the Advanced Condition is shared, all users in the system can view the advanced condition, but cannot modify it.


	
You cannot stop sharing an Advanced Condition, if the Advanced Condition is in use in the system.







	
Tip:

To enter a customized Date Range:
	
Select Custom Date Range from the list.


	
Enter a date range in the custom date range dialog box.


	
Click OK.
















Create an Advanced Condition Query Set

	
From the Advanced Conditions drop-down list, select New.

Or, click the Advanced Conditions icon.


	
To create a set of advanced conditions by linking the previously defined advanced conditions, click Yes.

You can link the advanced conditions by using the set operators like UNION, MINUS, and INTERSECT


	
To add an advanced condition to the query set, click Add.

A new row opens in the advanced condition selection area.

From the list, select an advanced condition.




	
Tip:

To modify, open, or delete advanced conditions, in the Advanced Conditions dialog box, select an advanced condition, and click Open.








	
From the Set Operator list, select an operator.

This set operator will link this advanced condition to the next advanced condition.


	
To add the next advanced condition to the query set, click Add.


	
To enter multiple advanced conditions in the query set, repeat above mentioned steps.




	
Note:

If the required advanced condition is not already present in the list, it can be created by selecting (New) from the list.
If an existing advanced condition requires modification, select it and click Edit.

The advanced condition can be edited only if you have created it.










	
When each advanced conditions for the query set is entered, click Save.


	
Enter a name for the advanced condition, and click OK.




	
Note:

To view or modify the SQL statement associated with an advanced condition, click Show SQL.











Rename Query Sets

You can save and retrieve sets of search criteria (advanced conditions), and add, edit, or delete them.

You can select and rename a query set on the Advanced Condition screen based on the permissions to modify the advanced condition. When you open an advanced condition or query set, the query name is displayed in the Name field.

	
To enable the Save button, in the Name field, enter an advanced condition name.


	
To record changes to the advanced condition name, click Save.

The query set is saved with the new name and description, and the Query Set drop-down list is refreshed.




	
To update the changes to the query set name, click Save.


	
When you click New, all the values in the Name, Description, and Query Set fields are cleared.










Import and Export Cases in the Advanced Conditions

	
You can import an XLS, XLSX or TXT file with one column containing case numbers.


	
When you upload a text file, each line in the file is considered a complete case number.


	
If a case is missing (cannot be found) or has been deleted, a message appears.


	
If the same case has been entered multiple times; only one entry is retained for the same and rest are ignored after the import process is complete.


	
For Hit List, the import process, imports 1000 cases/60 seconds.


	
When the Hit List is created, click Store Hit List.

The advanced condition is saved and the hit list is stored later use.


	
For further processing of all other data and options available on the Case Open screen, click Hit List.


	
You can export the hit list data in CSV format.








Re-use an Existing Advanced Condition

	
Go to Case Actions > Open, and open the Case Open page.


	
To open the Advanced Conditions Lookup dialog box, click the Lookup icon next to the Advanced Condition drop-down list.


	
Under Filter, select an option.

	
Contains—Filters the advanced conditions that contain the entered criteria.


	
Starts With—Filters all the advanced conditions that start with the entered criteria.





	
Enter the search criteria for the advanced conditions in the text box, and click Filter.


	
Select an advanced condition from the list, and execute any of the following actions:

	
To list the selected advanced condition in the Advanced Conditions drop-down list, click OK.


	
To display the details for the selected advanced condition in the Advanced Conditions dialog box, click AC.


	
To close the Advanced Condition Lookup dialog box without saving changes, click Cancel.


	
Select a previously selected advanced condition from the drop-down list to apply the search criteria for that condition.








To view the results of an existing Advanced Condition:

	
From the Advanced Conditions drop-down list, select an Advanced Condition.


	
Click Search.

A list of matching cases appears in the Total Number of Rows section.

TIP: The search results are also dependent on the values entered for Date Range and the Initial/Follow-up selection. Therefore, if the Advanced Condition returns a case, but it is not part of the Date Range, the case won't be displayed when you click Search.








Search for a Case

To search for cases that match the query set criteria for the advanced condition, in the Advanced Conditions > Hit List tab, click Find Now.

A search based on the selected query set is performed, and a list of cases that satisfy the advanced condition query set appear.

The following table show the operations you can perform in the Hit List tab.


	To...	Do the following
	Manually add an existing case to the hit list	Click Add and enter the Case ID in the text box.
	Remove a case from the hit list	Click Delete.
	Save the hit list result for future use	Click Store Hit List.
	Retrieve results of the saved hit list	Click Retrieve Hit List.
	Save the hit list as a text file	Click Export.
	View SQL for Query	Click Show SQL.
	Run a Query	Click Find.









Use the Advanced Conditions Library

From the Utilities drop-down menu, select Advanced Conditions Library.

From this screen, you can:

	
Create a new advanced condition


	
Reassign an advanced condition


	
Set advanced condition permission levels


	
Modify an existing advanced condition


	
Delete an advanced condition


	
Print a list of advanced conditions




To search for an existing query sets or advanced conditions, enter the search criteria, and click Search.








6 Use the MedDRA Browser

The MedDRA (Medical Dictionary for Regulatory Activities) browser allows you to encode diseases, signs, symptoms and indications.


View the MedDRA Browser

	
Hover Utilities and click MedDRA Browser.

The MedDRA Browser screen appears.


	
If your Argus Safety Administrator has configured the system to use the MedDRA browser for encoding events or indications, enter a term and click Encode from the respective section.

You can also invoke the MedDRA browser while creating Advanced Conditions.







	
Tip:

When loading the new MedDRA dictionary, the system selects the default MedDRA browser.








MedDRA Browser Dialog Box—Field Descriptions

.


	Field	Description
	Terminology	Allows you to select the version of the dictionary in which you wish to encode this event.
	MedDRA SMQ	Select a category from the available Standard MedDRA Queries (SMQs).
	Search All Levels	Enter text in this field and press ENTER to search for text across all of the five levels of the dictionary.
	Full Search	If you check this checkbox, the search text you enter will be matched within each word of the terms. If this checkbox is unchecked, the system will only return the terms that begin with the text you entered.
	Include Non-current terms	When you check this checkbox, the system retrieves the matching Non-current terms along with the Current terms. Enabled only when the MedDRA Browser is used for searching on local MedDRA dictionaries.
	SOC	System Organ Class. You can enter text in this field to search for the term in this particular level.
	HLGT	High Level Group Term. You can enter text in this field to search for the term in this particular level.
	HLT	High Level Term. You can enter text in this field to search for the term in this particular level.
	PT	Preferred Term. You can enter text in this field to search for the term in this particular level.
	LLT	Low Level Term. You can enter text in this field to search for the term in this particular level.
	Synonyms	This level can list company-specific synonyms for LLT terms.
	Print	Creates a report of the information that is currently on the dialog box. This report will be in the PDF format.
	Select	Click this button to enter the terms that have been selected into the encoding.
	Export	This button is enabled in two scenarios - when MedDRA is opened from:



i) Argus Console > Business Configuration > Products and Licenses > Product Family > Datasheet



or, from:



ii) Argus Console > Code Lists > Argus > Event Groups



MedDRA terms are selected at any level of the MedDRA hierarchy.



On clicking this button, a dialog box is displayed, that allows you to select the file type - .csv / .xls / .xlsx file.

On specifying the file type, the selected PT terms are then exported in the Export file. in the <PT terms> format.











Search for a Term

	
Enter the required term in one of the five levels of encoding.


	
You can enter as little information as necessary to get a broader set of results. Alternatively, you can enter the term under Search All Levels to search for the term across all levels.


	
Check the Full Search checkbox, if necessary.


	
Press Enter.

A list of search results appears.




	
Click Select to transfer the selected terms to the Case Form or the Advanced Conditions dialog box, depending on where the browser was invoked from. The button only becomes available after terms at all levels have been selected.


	
If you double-click an LLT term, a Term Details dialog box appears. The dialog box displays the following details about the term:

	
Indicates if the term is current or non-current


	
MedDRA code for the highlighted term


	
Primary SOC code and term


	
Dictionary Name and version number





	
When you select a term in a particular column, the other columns will be filled-in with the appropriate terms that correspond to the selected term.


	
The Primary SOC Path is highlighted by using bold text for the path.


	
To perform a synonym search, select an LLT among the search results. A synonym for the LLT will appear in the Synonyms column. When you select a synonym, the LLTs for that synonym will appear in the Synonyms column.








Search Non-Current Terms within MedDRA Browser

Non-current terms:

	
Non-current terms are flagged at the LLT level within MedDRA.


	
These are not recommended for continued use but are retained within the terminology to preserve historical data for retrieval and analysis.


	
Terms that are vague, ambiguous, outdated, truncated, or misspelled.


	
Terms derived from other terminologies that do not fit MedDRA rules.




The Include Non-current Terms option in the MedDRA browser allows users to expand their search results on local MedDRA dictionaries to non-current terms too.

	
The Non current LLT terms are displayed preceded with an asterisk (*) symbol separated by a space, in the search results grid as well as bottom section which displayed the selected term details. On clicking on non current term, the system displays its PT, HLT, HLGT, and SOC terms.

	
If MedDRA J is not configured, only the English currency is used.


	
If MedDRA J is configured and MedDRA Browser is opened from a Japanese base language screen, then only Japanese currency is used.


	
If MedDRA J is configured, MedDRA Browser is opened from an English base language screen (for English as well as Argus J user), and Country of Incidence is Japan, then English as well as Japanese currency is used.


	
If MedDRA J is configured, MedDRA Browser is opened from an English base language screen (for English as well as Argus J user), and Country of Incidence is not Japan, then only English currency is used.





	
On selecting a noncurrent term in the MedDRA browser by clicking Select button, the following message is displayed:

Selected term is a non-current term in the MedDRA dictionary. Please select a current term.


	
The MedDRA Browser print PDF also displays the asterisk (*) symbol in front of the non-current LLT.

[image: Surrounding text describes devpmda17.jpg.]







MedDRA Recoding

The MedDRA Recoding tool displays the following options for each case with the existing data elements after the case number in the XLS export or tab delimited file:

	
Current Workflow State


	
Current Workflow Group


	
If Excel is the output format and the number of records returned is more than 60K, the system splits the record set into multiple worksheets of 64K each.


	
These options are available for the end user logs.


	
The SOC/HLGT/HLT/PT/LLT and Synonym columns in the MedDRA schema and the MedDRA table have been expanded to 250 characters to conform to the ICH guidelines.


	
The MedDRA Recoding Tool is configurable as per customer requirements.




The following is the list of tables that support MedDRA Recoding and their locations in the Argus application.


	Argus Database Table	Location in Argus
	CASE_PAT_HIST	Argus Safety > Case Form > Patient Tab > Parent Section > Other Relevant History
	CASE_EVENT	Argus Safety > Case Form > Events Tab > Event Information
	CASE_PROD_INDICATIONS	Argus Safety > Case Form > Products > Products Indication
	CASE_ASSESS	Argus Safety > Case Form > Events Tab > Event Assessment > Event PT (Description)/LLT
	CASE_DEATH_DETAILS	Argus Safety > Case Form > Events Tab > Seriousness Criteria > Death Details > Cause of Death & Autopsy Details
	CASE_LAB_DATA	Argus Safety > Case Form > Patient Tab > Lab Data
	LM_ALWAYS_SERIOUS_TERM	Argus Console > Code Lists > Always Serious Term List
	LM_LABELED_TERM	Argus Console > Business Configuration > Products and Licenses > Datasheet
	LM_PRODUCT	Argus Console > Business Configuration > Products and Licenses > Primary Indication
	LM_LAB_TEST_TYPES	Argus Console > Code Lists > Lab Test Type







MedDRA Recoding

The following logic is used during the MedDRA recoding:

	
Get the Lower Level Term (LLT).


	
Check LLT_Code column in the MEDDRA_PREF_TERM_LLT table to see if LLT is not current (LLT_CURRENCY = N).

Decisions:

	
If LLT cannot be found in MEDDRA_PREF_TERM_LLT then record as exception to be noted in LOG file.


	
If LLT is not current then get PT_CODE from MEDDRA_PREF_TERM_LLT and use as LLT (Each PT exists as LLT also - always).


	
If LLT is current then keep LLT as it is.





	
If a current LLT can be found in previous step then continue with next step else go to 1 and select the next set of Terms.


	
Based on the LLT, get the Preferred Term (PT_CODE) from MEDDRA_PREF_TERM_LLT. Get the rest of the hierarchy from MEDDRA_MD_HIERARCHY, based on PT_CODE and PRIMARY_SOC_FG = 'Y'.


	
Match all 5 levels of Code and Description and update the data, if required.


	
Populate the following columns:




	
DICT_ID = Current MedDRA Dictionary ID, present under Case Form Configuration.


	
CODE_STATUS = 1 (displaying that this set of terms has been encoded).








Recode MedDRA terms at the Enterprise level

For multi-tenant environment, the MedDRA Re-Code Tool allows recoding of MedDRA terms at the Enterprise level. [image: Surrounding text describes medra_enterprise.jpg.]


	
The MedDRA recoding tool displays an additional multi-select list of all active Enterprises. This lists all active Enterprise Short Names in the alphabetical order.


	
New Schema Owner is no longer required. As per the recoding logic, cases are also re-coded to the MedDRA version that is configured in Console.


	
Displays a note below the Existing MedDRA Version to Re-Code list - Note - Cases will be re-coded to the MedDRA version configured in Console for the respective Enterprises.


	
The MedDRA recoding tool only re-codes the items that match the selected Enterprises and values selected in the Existing MedDRA Version to Re-Code list.


	
The log file specifies the Enterprise Short Name with every log record that is processed for a particular Enterprise.













7 Manage Your Expedited Report Submissions

This chapter lists tasks related to preparing,  submitting and tracking compliance for Expedited Reports (ICSRs - Individual Case Safety Reports).


Schedule an Expedited Report


Schedule a Report Manually

The changes described below are applicable only when there are local reports configured in the application (i.e., there is data in the Local Reports Configuration table).

To schedule a report manually:

	
Open the case for which the report has to be scheduled.


	
When the system displays the Case Form for the selected case, select Regulatory Reports -> Schedule New Reports.


	
When the system opens the Schedule New Expedited Report dialog box, enter the appropriate information in the fields in the dialog box.


	
Click OK to schedule the report.


	
Save the case to save the report.




On Manual Scheduling of a report by a user, the application identifies if the report is a Local Japan report by matching the Country of the License#, Destination and Report Form chosen by the user in the "Schedule New Report" manual report scheduling dialog box with the "Local Reports Configuration".

If DLP is not enabled for Expedited Report Generation:

a. On the Global lock of a case by a user, the application generates the global reports but does not generate any Local Japan reports.

b. The Local Japan reports shall be generated on subsequent local lock for Japan.

If DLP is enabled for Expedited Report Generation, refer to the chapter in Oracle Argus Safety Japanese User's Guide > 4 Reports.

For a Study-based WHO Drug Report, the application identifies if the report is a Local Japan report by matching only the Destination and Report Form chosen by the user.

For a Study-based WHO Drug Report, the application identifies if the report is a Local Japan report by ignoring the country, matching only the Destination and Report Form chosen by the user and if the Truly Local Case switch returns value > 0.

Note that if AUTO_FOLLOWUP_MANUAL switch is ON, the existing functionality of scheduling a follow-up report for a manual report is retained as is and if the manual report was a local report, the follow-up is treated as a local report.


Schedule New Expedited Reports—Field Descriptions


	Field	Description
	Product	Select the relevant company product from the list. All company products associated with the particular case appear in the list.
The items appearing in the drop-down list are listed in the following format:

Trade Name, Product Name, Formulation, Concentration and Indication.


	License #	Select the appropriate license.
The items appearing in this drop-down list are listed in the following format:

Country of License, License Type and License Number.


	Aware Date	This drop-down list is only populated and enabled after a license has been selected. The Aware Dates are displayed in descending order of the Current Aware Date.
If an Aware Date is appended with '(A)' in the drop-down list, it is used to denote the aware date of an Amendment.

The resulting expedited report Due Date is based on the selected Aware Date and the duration of the Due Date section.

The selected Aware Date has no impact on the Actual Due Date if the user specifies an absolute Due Date. For instance, selecting a date in the Due Date field causes the report to be due on the specified date, regardless of the selected Aware Date.


	Protect Confidentiality of Patient and Reporter	Check this checkbox if identifying information about the patient and the reporter must not appear on the report.
The system also displays 'MSK' null flavor in the eVAERS report when this checkbox is checked. MSK is populated only when the data element contains some data and is not null.













Auto-schedule a Report

	
Open the case for which the report has to be scheduled.


	
Select Regulatory Reports > Auto Schedule or Auto Schedule Device.


	
Reports will be scheduled on against the reporting rules which have been set up by the administrators.





Understand Auto-Schedule a Report

The changes described below are applicable only when local reports are configured in the application (that is, when there is data in the Local Reports Configuration table).

On the Global lock of a case by a user, the application triggers the qualifying reporting rules including the Japan reporting rules and schedule the relevant global and local reports. There are modifications to the Report Generation functionality however, and is explained under section Changes to Report Generation.

On the Local Lock of a case by a user, the Local Reporting Rules for Japan are triggered again as follows, depending on the value in the configuration switch "Case Form Configuration | Auto Regulatory Scheduling":

	
If the value is set to Always: The Local Japan reporting rules are triggered on case save during the follow-up cycles of case processing when any of the local fields caused the "Significant" data change. If any of the other fields caused the "Significant" data change, then all the reporting rules are triggered as with the existing algorithm. Also, for the initial case cycle, only local reporting rules are triggered on Local lock.


	
If the value is set to Significant: The Local Japan reporting rules are triggered on Local Lock but respecting the existing algorithm to check that Significant Follow-up was added during the prior global lock cycle during the follow-up cycles. For the initial case cycle, as with the existing algorithm, they trigger on Local lock.


	
If the value is set to any value other than None, including Manual: A new checkbox called Schedule Local Reports Only will be added under the Total Number of Rows section in the Regulatory Reports tab of the Case Form. This checkbox is visible only when the configuration switch "Case Form Configuration > Auto Regulatory Scheduling is not set to None. After the rules are successfully triggered, the application unchecks the checkbox. If the checkbox is unchecked, the application triggers all the qualifying reporting rules keeping the current functionality.







	
Note:

As a result of triggering of local reporting rules again, the Local reports that were already scheduled during Global Lock may result in being overwritten or being removed.







Force Distribution: If force distribute is checked for a reporting rule, the application triggers that reporting rule as per the existing functionality. However, the generation and force distribution of the Local Reports have the following modifications:

a. When a Local reporting rule marked for "Force Distribute" has a local report that has become due, the report is scheduled, generated and force distributed by performing the global and local lock on the case using the existing AG Service Force Reporting process.

i. When a Local report that was already scheduled outside of the force distribution process from a local reporting rule marked for "Force Distribute" has become due, the application does not force generate this report keeping it consistent with the existing functionality.

b. For the above scenario, AG Service uses the one step global/local lock comment "Case Globally and Locally locked for JP." (refer section Routing Comments Log and Case Print) followed by the configured comments under Argus Console ' Reporting ' Expedited screen' Forced Distribution comments.

i. Case Globally and Locally locked for JP. << Forced Distribution comments>>

c. After the report generation is complete, the case gets unlocked globally. AG Service uses the one step global/local unlock comment "Case Globally and Locally unlocked for JP." (refer section Routing Comments Log and Case Print) followed by the configured comments under Argus Console ' Reporting ' Expedited screen' Forced Distribution comments.

i. Case Globally and Locally unlocked for JP. << Forced Distribution comments>>





Expedited Reporting Rules Algorithm

The expedited reporting rules algorithm affects the following:

	
Suppression of Duplicate Reports


	
Blinded/Forced Distribution


	
Letter Placeholder for the IND Cover Letter





Suppression of Duplicate Reports

You can suppress duplicate expedited reports to be scheduled at the reporting destination level, according to the following criteria:

	
The Suppress Duplicate Reports option only applies to drug reports. It does not apply to device reports.


	
This option does not reduce the number of reporting rules the system evaluates. However, it does prevent the system from scheduling and generating expedited reports that match the duplication criteria.


	
When you select Suppress Duplicate Reports, the system uses the following attributes to determine whether the reports are duplicates of other reports:

	
Report Form


	
Reporting Destination


	
Aware Date





	
If two or more duplicate reports have different due dates (regardless of license type), the system schedules the report with the earliest due date.








Blinded/Forced Distribution

The system enables you to configure the Blinding Study option for products in the case.

	
When you check this checkbox, the system blinds the study products for the report being sent to the reporting destination in a manner similar to the Bulk Reporting dialog box option.


	
If you select either of the Blind Study product options (Reporting Rules or Bulk Reporting), the system blinds the study product information on the report form.


	
The system blinds only active blinded studies. It does not blind the following case reports even if the Blind Study product is selected

	
Open Label Studies


	
Study is eligible for unblinding - If the Study is Unblinding checkbox is not kept as unchecked in study configuration, the user will be able to see the complete case data even if he/she has protection enabled.





	
In cases where expedited reports are due, the system permits the user to force-distribute the reports based on user-defined reporting rules, even if case processing is incomplete.


	
When you select the Force Distribution rule, the following occurs:


	
If a case encounters a rule where a report is due is locked, the system schedules the report based on the rule and does the following:

	
Generates the report on the due date.


	
Dynamically replaces the current case comment with the force distribution case comment.


	
Transmits the report based on the preferences defined by the reporting destinations.


	
Displays the status in the Worklist Bulk Transmit/Transmit ICSR dialog boxs.





	
The AG Service Force Reporting process for expedited reports completes the process by:

	
Checking the reports required for force distribution


	
Locks the case (if it's not already locked)


	
Generates the reports and makes sure it is ready for transmission





	
The notes for the Case Locking/Unlocking are the same as those defined as the common profile value for the Forces Distribution option; System is the user.








Letter Placeholder for the IND Cover Letter

	
You can define a placeholder for the IND_SIMILAR_EVENTS table. The system uses data from this table to populate the Case Number, Protocol Number, Subject ID, and Adverse Event terms for previously submitted cases reporting the same events.


	
If no reports were submitted, the system prints None Submitted instead of the table.

The placeholder only prints this information when it is used in the cover letter for the Regulatory Report. The system uses the license associated with the scheduled report to track other cases where the same product license was previously submitted for the same events in the current case.












Create Your Follow-up Reports

Follow-up reports are created when significant follow-up information is entered for the case. This is indicated by entering follow-up information in the General Information section of the General tab and when one of the following happens:

	
Data for a case changes


	
Update information for a case has been entered


	
Depending on the configuration set up by the Administrator, the system analyzes the scheduled reports prior to the data changes to see if they are still required.


	
If the system determines that they are not required, the report status is marked as Downgrade. New reports are automatically scheduled, if required.


	
If the system determines the report is still needed and needs to be updated, one of two functions can take place depending on the configuration done by the Administrator:

	
The system overwrites the report


	
The system schedules a new report in addition to the old report





	
If the system has been configured to overwrite the existing report, the report status becomes New Data Available.


	
In the Worklist, the status for this report shows New Data Available for this report. When you re-generate the report, you can select whether or not you would like to re-generate the report with the new data.


	
If the system is configured to create a Follow-up report, the previous report remains in its current state and a new report is scheduled with the status of Scheduled.


	
If a report has been previously submitted, this report is never deleted under any configuration.








Create Unscheduled Expedited Reports

	
Select Reports -> Expedited -> Compliance.


	Field	Description
	Suspect Product	Displays the Trade Name for which the report has been scheduled. A (+) displayed at the end of the Product Name denotes that more than one Suspect Company Product exists.
For Reports which were scheduled for the Device, the Device name gets displayed.


	F / LT	Denotes Fatal / Life Threatening
If the case is both F and LT, only F is displayed.

If the case is neither F nor LT, No is displayed.


	7/15	Displays 7 if the report is due within 7 days
Displays 15 if the report is due in more than 7 days








	
Click Batch Print or Create Report and search for the case for which the expedited report has to be scheduled.


	
When the system displays the search results, select the locked cases for which the expedited report is to be scheduled.


	
Click Batch.


	
When the system opens the Batch Print or Create Reports dialog box, enter the appropriate information and click OK.


	
The system generates the unscheduled expedited report.





Batch Print or Create Reports—Fields and Field Descriptions


	Field	Description
	Format	Enables you to print reports As Draft or As Final.
	
The Print As Final option is available only if all the selected cases are locked.


	
If Print As Final is selected, then the option Save with case, mark as submitted is also available as a checkbox option.


	
Click the options Print As Final and Save with case, mark as submitted to generate final Regulatory Reports and create a submission record with each case identical to the current functionality.


	
Click the options combination of Print As Final only (and not Save with case, mark as submitted) to generate final Regulatory Reports without creating a submission record with each case.


	
If the report is associated with a blinded study, check the Blind study product checkbox.





	Destination	Check the Printer checkbox to print the report
	Scheduling	
	If Run Now is selected, all the selected reports run against all selected cases and a PDF is generated.
	
The Run Now option is visible only when a MedWatch, MedWatch Drug, CIOMS, or VAERS form is selected on the Batch Expedited Report screen.


	
2Select Run at and enter the appropriate date and time when the generation of reports should occur.


	
If you select an unlocked case, the report gets printed in draft form only and is not saved.














Create Batch Reports

You can use the Batch Reports function to schedule and generate reports for multiple cases. Before using this function, verify that no cases or reports are open.

	
Select Expedited Reports from the Reports - Compliance menu.


	
When the system opens the Expedited Reports dialog box, click Batch Print or Create Report.





Expedited Reports dialog box—Fields and Field Descriptions


	Field	Description
	Suspect Product	Displays the Trade Name for which the report has been scheduled. A (+) displayed at the end of the Product Name denotes that more than one Suspect Company Product exists.
For Reports which were scheduled for the Device, the Device name gets displayed.








	
When the system opens the Expedited Reports dialog box, search for the cases for which the expedited report needs to be scheduled.


	
When the system displays the search results, select the appropriate cases and click Batch.


	
When the system opens the Batch Print or Create Reports dialog box, enter the appropriate information in the fields and click OK




The Expedited Batch Printing dialog box supports printing Batch CIOMS, Medwatch, and VAERS on Argus Web locally.


Batch Print or Create Reports dialog box—Fields and Field Descriptions


	Field	Description
	Format	Enables you to print reports As Draft or As Final.
	
The Print As Final option is available only if all the selected cases are locked.


	
If Print As Final is selected, then the option Save with case, mark as submitted is also available as a checkbox option.


	
Click the options Print As Final and Save with case, mark as submitted to generate final Regulatory Reports and create a submission record with each case identical to the current functionality.


	
Click the options combination of Print As Final only (and not Save with case, mark as submitted) to generate final Regulatory Reports without creating a submission record with each case.


	
If the report is associated with a blinded study, select the Blind study product checkbox.





	Protect Confidentiality of Reporter and Patient	Check this checkbox to hide the Reporter and Patient information on the expedited reports.
	Scheduling	1. If Run Now is selected, all the selected reports run against all selected cases and a PDF is generated.
The Run Now option is visible only when a MedWatch, MedWatch Drug, CIOMS, or VAERS form is selected on the Batch Expedited Report screen.

If you select an unlocked case, the report gets printed in draft form only and is not saved.

2. Select Run at and enter the appropriate date and time when the generation of reports should occur.













Review a Draft Expedited Report

	
Open the case for which you want to schedule a report.

Note: You can only view a Draft report if the relevant case is unlocked.


	
On the Case Form page, click the Regulatory Reports tab.


	
From the Total Number of Rows tab, locate the relevant report and click Draft to view the report.


	
Alternatively, on the Toolbar, click Draft Report and select the required report that to be generated.








Generate an Expedited Report

You can generate a report using either of the following procedures.


Method 1: Generating a Report

	
Verify that the relevant case has been locked and the required report has been scheduled.


	
Open the selected case to display its associated Case Form.


	
Open the report from the Regulatory Reports tab of the Case Form.


	
When the system opens the Regulatory Reports details for the selected case, locate the relevant report and click the Final link to generate the report.


	
The system generates the selected report.





Method 2: Generating a Report

	
Verify that the relevant case has been locked and the required report has been scheduled.


	
Select Case Actions -> Open to view the Case Open form.


	
Click Search to view cases matching the search criteria.


	
When the system displays the search results, click the Lock State icon and select Case Details.


	
When the system opens the Argus Safety Case Details dialog box, open the Scheduled Regulatory Reports folder and select the relevant regulatory report.


	
The system automatically generates the report.




	
Note:

	
You do not need to lock the case to preview a report in draft mode.


	
If you have access rights to view or print blinded information, you are prompted to select whether you would like to view a blinded or unblinded version of the report. If your access rights disallow you from viewing or printing unblinded information, you can view only a blinded version of the expedited report. The following items are not displayed when viewing a blinded version of the expedited report:

	
Clinical Treatment Given (Study Drug field)


	
Study Drug Formulation and Concentration


	
Study Drug Dose, Daily Dose and Route


	
Study Drug Batch/Lot # and Expiration Date





	
If the case is locked you can generate the report from the Worklist | Reports, Reports | Bulk Reporting and Reports | Compliance | Expedited screens.



















Approve Your Report

	
Open the case associated with the report that needs to be approved.


	
When the system opens the Case Form, click the Regulatory Reports tab to displays the case details.


	
Click the icon associated with the report you wish to approve and select View Report Details.


	
When the system opens the Report Details dialog box, click the Routing tab.


	
When the system opens the Routing tab, select Approved from the State drop-down list and click Route.


	
When the system opens a dialog box, enter the required information and click OK to approve the report.

Refer to Report Routing to understand how you can route a report to another state.








Review Your Scheduled Reports

The Regulatory Reports tab enables you to:

	
View all scheduled reports


	
Schedule new reports




When a new case is created, there are no reports associated with it. As data is entered and the case is saved, the regulatory report scheduling algorithm determines which reports, if any, are required for that case.

The reports determined to be necessary appear in the Regulatory Reports tab. You can manually schedule reports via the Reports menu or by clicking the Regulatory Reports tab. You can also add comments to existing reports. The comment section can be updated to enter notes for a report even after it has been submitted.

	
The case submission date must be on or after the initial receipt date for the case. If the submission date is before the initial receipt date, the system displays an error message.


	
The system displays the time component for the date generated on the Case Form > Regulatory Reports tab using the IE offset of the client machine for the display.


	
The system displays the time component for the date generated on the Report Details using the IE offset of the client machine for the display.


	
When you manually schedule an Expedited report, the system places the word, Manual, in the Notes field along with the current notes information.





Group Regulatory Reports

You can group reports by selecting the grouping structure from the Organized by drop-down list. You can group reports as follows:

	
Report Type/Submit Category/Reporting Destination


	
Report Type/Reporting Destination


	
Report Type/Reporting Group




The numbers in parentheses next to each folder indicate the number of reports in the folder.

The following are definitions of the terms used in the reporting structure.

	
Report Type -- Can be either Expedited or Periodic reports. The system generates a folder for each type.


	
Reporting Destination contains all defined codelist items for Reporting Destinations that have at least one report scheduled within the case.




If no reports are scheduled for a defined reporting destination, no folder is created for this destination. All the folders which are the reporting destinations under each folder are sorted alphabetically.

	
Pending Reports—Reports that have not been submitted or are marked as non-submitted.


	
Submitted Reports—All submitted reports.


	
Marked as Non-Submit—Reports that have not been submitted.


	
Reporting Group—Contains all user groups assigned to the scheduled expedited or scheduled in the case.





Group by Report Type, Submit Category, or Reporting Destination

The Expedited folder contains the following:

	
Pending Reports by Destination


	
Submitted Reports by Destination


	
Non-Submitted Reports by Destination




The Periodic folder contains single case report forms (MedWatch, VAERS or CIOMS) that were generated as part of a Periodic Report.

	
ending Reports by Destination


	
Submitted Reports by Destination


	
Non-Submitted Reports by Destination








Group by Report Type or Reporting Destination

The Expedited folder contains a sub-folder for reporting destinations that have at least one scheduled report.

The Periodic folder contains the single case report form (MedWatch, VAERS or CIOMS) generated as part of a Periodic Report listed in the Periodic section. If no report was generated, the system does not create sub-folders.





Group by Report Type or Reporting Group

The Expedited and Periodic folders contain sub-folders for each group that has generated a report. If a group has not generated a report, the system does not create a sub-folder.







Review a List of your Scheduled and Generate Reports

Expedited Reports provide access to the list of previously scheduled or generated but not submitted expedited reports.

Go to Reports > Compliance > Expedited Reports.

Depending on the regulations set forth by the Regulatory Authorities, Expedited reports may need to be submitted for the adverse events pertaining to your company's products.

	
The following expedited report forms do not print a Follow-up number when the user selects DRAFT on the Regulatory Reports tab or when he/she selects the Quick Launch Draft option:

	
US FDA MedWatch Drug/Device


	
US FDA VAERS


	
CIOMS I/CIOMS I (Local)


	
French CERFA


	
Spanish Spontaneous/Clinical





	
You can print draft expedited reports from the Batch Print or Create Reports without printing DRAFT on the reports from the Case Open or the Reports | Compliance | Expedited Reports dialog box.





View Lock State

Click the Lock State header row to sort on the following category of cases. A pop-up window appears, with the following sorting options:

	
Lock State


	
SUSAR


	
Exp/Per




Click the required option to sort cases based on the selected case categorization.




	
Note:

The icon displayed in the lock state column in the Reports-> Compliance - Expedited and Submitted screens denotes a SUSAR (Suspected Unexpected Serious Adverse Reaction) case.








Lock Icons


	Icon...	Identifies...
	[image: Surrounding text describes periodicsub.gif.]
	A case marked for a Periodic ICSR submission.
	[image: Surrounding text describes lockedcase.gif.]
	A locked case.
	[image: Surrounding text describes unlockedcase.gif.]
	An unlocked case
	[image: Surrounding text describes susar.gif.]
	A SUSAR (Suspected Unexpected Serious Adverse Reaction) case.







Lock Icon Options


	Field	Description
	Report Details	Displays specific information about the report as entered in the Regulatory Reports section.
The information displayed in the fields of the Report Details dialog box is fetched from the data entered in the Regulatory Reports section of Case Form.











View a Summary of Expedited Regulatory Reports


	To..	Do..
	View the regulatory reports for a particular case (scheduled, generated and submitted)	Open the Regulatory Reports tab of the Case Form.
	View all scheduled, generated, and approved reports, as well as other outstanding action items	Select Reports from the Worklist menu.
	View a list of all scheduled, generated, and approved reports	Select Compliance | Expedited from the Reports menu.
	View all the submitted reports in the system	Select Compliance |Submitted from the Reports menu.











Store Expedited Reports in Documentum

Argus Safety lets you store your Expedited Reports in Documentum.

	
Mark an Expedited Report as submitted from within Argus to insert the report into the Documentum system as a PDF.


	
If the report is to be transmitted via fax or email, Argus Safety Service marks the report as a successful submission in Documentum only after the fax or email transmission has succeeded.








View Scheduled and Approved Reports

To view scheduled, disapproved and approved reports, hover the Worklist menu and select Reports.

When the system opens the Reports screen, enter the appropriate information as necessary.


Report Filter Options

	
The filter options Study ID and Reporting Group elements filter cases within the list.


	
The search results appear in the Report Details dialog box and permits the user to enter the approval notes that are applied to all selected reports. The system skips any reports selected by the user that have the following statuses:

	
Scheduled


	
Disapproved


	
Approved





	
The system hides the reports fields from the report details dialog box and does not permit the user to access or modify any other tabs.


	
The system hides the Route button to prevent users from modifying the Report Status.


	
Workflow Enterprise users can access, view, and modify the report details for all reports for all cases across multiple sites in their lists.





	Option	Description
	Reporting Destination	Displays the report destination (agency) for which the report is scheduled.
	Report Status	Displays the status of the report as Approved, Generated or Scheduled.
	Report Form	Displays the description of the report.
	Filtering Reports	You can click the respective magnifying glass icons to filter reports based on Destination, Product Family, and Country of Incidence. The system displays the standard lookup dialog box.
	By Destination	The Report Destination filter multi-selection screen list contains the names of all agencies as configured in the Argus Regulatory Authority CodeList.
	By Product Family	The Product Family filter multi-selection screen contains a list of all product family names as configured in the Argus Products codelist.
	By Country of Incidence	The Country of Incidence filter multi-selection screen contains a list of all available countries.









View Filter Results

The Total Number of Rows section displays the result based on the selected filter criteria with following details:


	Field	Description
	Selected	Allows the user to select one or more reports, on which actions can be performed.
	Suspect Product	Displays the Trade name for which the report has been scheduled. A "+" displayed at the end of a Product Name indicates that more than one Suspect Company Products exist.
A Device Name is also displayed for those reports which were scheduled for the Device.


	Diagnosis	Displays the Primary Event Diagnosis PT.
	Event Verbatim	Displays the event verbatim (verbatim as reported) of the Primary Event.
	F or LT	Indicates whether a case is fatal or life threatening as follows:
	
F identifies a Fatal (F) case


	
LT identifies a Life Threatening (LT)




If any of the above are present together, then Fatal takes precedence followed by LT. If the case is neither of the above, No is displayed.


	7/15	Displays 7 if the report is due within 7 days.
Displays 15 if the report is due in more than 7 days.


	Report Form	Displays the description of the report.
Click the link to view the DRAFT report PDF.


	Initial / Follow-up (#)	Displays if the report is Initial or Follow-up.
If it is a Follow-up, the follow-up number is printed.


	Downgrade	Displays Yes if the report is a Downgrade report.
	View Report	Enables the user to view the report as a PDF.
	Local Labeling	Enables the user to view the local labeling dialog box.
	
This option is available only if the user has access to Local Labeling within the groups to which the user belongs to.


	
The Local Labeling can also be viewed by clicking the local labeling icon that is displayed next to S/U/R.


















Transmit Your ICSRs

	
You can transmit reports one by one via Reports Detail Dialog > Transmit tab.

	
Go to Case Actions > Open > Regulatory Report, left click on report to show report details, and select Transmit.


	
Go to Report > Compliance > Expedited, left click on globe icon.





	
You can transmit several reports at a time via Reports > Bulk Reporting, select Print Regulatory Report >Transmit and click Transmit at the bottom of the screen.





Transmit an ICSR

The Transmit tab enables you to transmit a case electronically.

	
Select the recipient from the Available Recipients list.


	
Select the transmission method from the Method list.


	
Enter any comments under Comments.


	
Click Transmit.








Transmit Several ICSRs at Once

The Bulk Transmit function lists the status for all transmission events against your assigned cases.


To view the Bulk Transmit page

	
Hover over the Worklist menu and select Bulk Transmit.


	
When the system opens the Bulk Transmit screen, enter the appropriate information as necessary.





Filter Reports

The Total Number of Rows section displays the search result based on the filter criteria.


	Field	Description
	Report Form	Displays the description of the report.
Click the link to view the DRAFT report PDF.


	Recipient Company	Displays the name of the company of the report recipient
	Date Created	Displays the date on which the report was created.
	Date Sent	Displays the date on which the report was transmitted to the recipient.
	# of Pages	Displays the number of pages in the report.
	Attempts	Displays the number of attempts made to transmit the report. If you are using Right Fax, the value of this field is displayed as 0 even if the Right Fax had attempted it multiple times. This is an unsupported feature in Right Fax.
	Sender	Displays the name of the sender of the report.
	Lock State	Displays the lock status of the report.
	Sender Agency Name	Displays the name of the agency that has generated the report
	Status	Displays the Report Status such as Scheduled, Generated, and so on.









User Options


	Option	Description
	View Transmission	Displays the report in a PDF format.
	Mark report as Submitted	Marks the report for the selected row as submitted.
This option is displayed to only those users who have the access rights to mark a report as submitted.


	Remove transmission	Failed transmissions can be removed using this option as it removes the transmission log entry from the list.
A report whose status is pending cannot be transmitted.


	Re-transmit	This options allows reports to be re-generated and re-transmitted if report generation had failed earlier. For failure in other stages of report transmission, this option performs only retransmission.
	Submit Multiple Reports	Multiple reports that are selected from the list can be marked as submitted simultaneously.
	Re-transmit Multiple	The status of multiple reports that are selected from the list can be changed to pending, and those reports can be re-transmitted.
	Remove Multiple Transmissions	Transmission of multiple reports that are selected from the list can be removed.









View Routing Details

Enter routing details in the text box.

Reports that appear in the Bulk Transmission section or the Bulk Print section do not display in the Reports section of the Worklist.









Print Your Reports

The Bulk Print function displays a separate list for all Bulk Print events against reports.


To view the Bulk Print page

	
Hover the Worklist menu and select Bulk Print.


	
When the system opens the Bulk Print page, enter the appropriate information.





Bulk Print User Options


	Option	Description
	Remove Print Job	Removes the print job entry from the list.
A report whose status is pending cannot be printed.


	Re-print	This option is displayed if the selected row has a status of failure or success. Select this option to change the status back to pending and the re-print the report.
	Submit Multiple Reports	Multiple reports that are selected from the list can be marked as submitted simultaneously.
	Re-print Multiple	The status of multiple reports that are selected from the list can be changed to pending, and those reports can be re-transmitted.
	Remove Multiple Print Jobs	Print jobs of multiple reports that are selected from the list can be removed.











Track ICSR Transmissions

The Bulk ICSR Transmit function displays only those ICSR Reports that are awaiting submission (not in submitted state) when transmitted from Bulk Report By Form to the Trading partner.


View ICSR Transmit Status

	
Hover over the Worklist menu and select Bulk ICSR Transmit.

The Bulk ICSR Transmit page appears withe following tabs:

	
Reports—Displays the status of individual ICSR Reports that are in the process of being transmitted.


	
Messages—Displays the status of ESM Messages which may contain multiple reports.





	
Entered the information as necessary.


	
Alternatively, go to Utilities > ICSR > ICSR Transmit Status.





Search for Reports

On the Reports tab, select the options to search for reports.


	Field	Description
	Report	Select the type of report from the drop-down list, as applicable.
Select E2B, eVAERS or eMDR from the list to view the transmission status of the report.


	Message Type	Select a pre-defined message type.This field is set to ichicsr and is disabled if report is set as eMDR or eVAERS.
	Periodic Report	This field is enabled for message type that are marked as Periodic in the Message type codelist.
This field is disabled for eVAERS and eMDR.


	Range	Select a date range.
	Search button	Triggers search based on the search criteria.
	Only show transmissions that have reached a failure state	Check this checkbox to search for only those transmissions that have a failed status.
	Show all transmissions (submitted and unsubmitted) having a error ACK	When this checkbox is checked by the user during the Search action, the system brings back any ICSR report that has received an error ACK (acknowledgement), irrespective of whether it has been marked as submitted or not.
When this checkbox is checked, the checkbox Only show transmissions that have reached a failure state is automatically unchecked.


	Stage Legend	Shows the status (through colors) corresponding to each stage.









Search for ESM Messages

On the Messages tab, select the options to search for ESM messages.


	Field	Description
	Report	Select E2B, eVAERS or eMDR from the drop-down list to view the transmission status of these reports.
	Agency Trading Partners	Enter the agency or trading partner.
	Transmit Date Range From	Select the transmit date range.
	Range	Select a range to auto-populate the Start Date and End Date.
The Range option is cleared if the Start Date or End Date is changed.











View Search Results

The Total Number of Rows section displays the search result based on the search criteria.

If the ICSR report in a result set row was already submitted, the system does not display the following pop-up windows:

	
Remove Transmission


	
Re-Transmit


	
Mark as Submitted


	
Re-Transmit Multiple


	
Submit Multiple Reports


	
ICSR Transmission History




For the same record above, the system, however, keeps the View Report Details and View ICSR Report menus enabled.


	Option	Description
	View Acknowledgement (Read only)	Displays the Acknowledgment report.
This menu option is not displayed if ACK has not been received for message.


	View xml acknowledgement	Displays business level acknowledgement.
	View Reports	Opens the Bulk Transmit ICSR in the report view for all the reports in the message.
	View Report Details
(read -only)

	Opens the existing Report Details dialog box in read-only mode.
	View ICSR Report
(ICSR Viewer for the report)

	Opens the existing ICSR Viewer report.
	ICSR Transmission History
(Transmission History for the selected report)

	Opens the new Transmission History screen.











View ICSR Pending Reports

To view the Incoming ICSR Reports screen, select Reports > ICSR Pending Reports. You can:

	
View the ICSR reports sent by the agency or the trading partner.


	
Process an incoming ICSR report.


	
Check all the ICSR values of the reports sent and determine whether to accept or reject the reports.


	
Provide a user password and acceptance notes/rejection reason and accept or reject an incoming ICSR report.





Track Incoming ICSR Reports


	Field	Description
	Message Type	Allows selection of ICSR based on the message type for all allowed values for the N.1.1 tag. By default, the drop-down is populated as ichicsr.
	Trading Partner	
	To view report by a Trading Name, click Filter and select an agency.
	
To select multiple agencies, click Add in the Select Reporting Destinations dialog box.





	Product Name/Generic Name	Click the Select button next to this text box.
A pop-up screen appears with a text box (2000 characters), a Search button, an OK button, and a Cancel button.

This pop-up screen is called "Generic Name" or "Product Name" as per the radio button selected in the Incoming ICSR Reports for which this popup was being invoked.

This pop-up screen is titled "Product Name" when invoked from the Processed ICSR Reports screen. The text box in the pop-up screen is auto-populated with text entered in product name or generic name field on the corresponding screen but can be the user updated.

Besides, when the user switches tabs between the Pending and Processed Sub Tabs, the default processing page icon appears which information that it is still processing and switching is not completed.


	Initial / F-U / Nullification/ Amendment / Downgrade	The report version of the report for the case received.
	Country of Incidence/ Primary Source Country	Displays the country where the incident occurred.
	Is/Will be assigned to this site	Displays the site membership of the case.
This field appears in the search result.


	Accept ICSR	Imports ICSRs in a batch from ICSR Pending screen after selecting one or more reports (E2B (R2) and/or E2B(R3).







Button and Right-click Options


	Button	Description
	ICSR Viewer	Select this right-click option to launch the ICSR viewer. For details, refer to the ESM User Help.
Note: At the time of generating an ICSR report, some characters entered in the case form may not be displayed the same in the ICSR report. For example, the ICSR report equivalent of the "&" character entered in the case form is &. Similarly, there are other such characters that are represented differently in the ICSR report.


	View Error/Warning Message	Select this right-click option to view all warning messages including M2 validation errors and Multiple ICSR Codes log.
	Accept ICSR	Selects the incoming ICSR report for both single and multiple acceptance.
Execute these steps to accept an ICSR Case:

1. Click the Accept ICSR Case button. The Acceptance of Initial Report Confirmation dialog opens.

2. Enter your user password, date, and select a justification from the pre-defined list of justifications.

3. Click OK.

Accepting Amendment report is the same accepting a Follow-up report. The application supports importing attachments for the file types as configured in the profile switch Case Processing -> Valid attachment file type.


	View Validation Failure	Opens the ICSR validation report (pdf) in the same format as it does at the time of export. This validation report prints all the validations that are categorized as soft validations for the import. Applicable for (R3) based ICSR reports only.
	Duplicate Search	Select this right-click option to perform Duplicate Search for the case being imported with the case present in the system.











Manage Pending Reports

When using ICSR Pending reports:

	
The Oracle Text profile settings are used for the duplicate search in ICSR Pending as configured in the Argus Schema Creation Tool.


	
Right-click the row and select the following:

	
Case Summary


	
Medical Summary


	
Case Form Print











Track Bulk Incoming ICSR Reports

The Bulk Incoming ICR Reports enable you to import multiple ICSR reports that are sent by the agency or trading partner.

To view the Bulk Incoming Reports, select multiple reports from the Incoming ICSR Reports screen, and click Accept ICSRs.

Note that:

	
The reports that are imported can be a combination of Initial, Follow-up and Nullification reports.


	
The only pre-requisite for this dialog box is that Case numbering should be set to auto-numbering and not manually.


	
Bulk Incoming Reports does not prevent the duplicate cases to be loaded into the system.




The following table lists Bulk Incoming Reports fields.


	Field	Description
	Agency Name	This drop-down list contains unique trading partner from the ICSR reports have been received.
Select an agency/trading partner to filter the ICSR reports.


	Product Name	This drop-down list contains unique suspect Product Names extracted from the received ICSR reports.
Select a suspect product to filter the ICSR reports. If an Agency Name is selected, the Product Name list contains all suspect products belonging to that agency name.


	Follow Up Output Format	This drop-down list contains CIOMS-I, MedWatch and Case Form. You can print all ICSR reports only if the Follow Up checkbox is checked.
	Source Count	Displays the total number of ICSR reports with breakdown in 'Initial' 'Follow Up' and 'Nullification' category.
	Selected Count	Displays the number of ICSR selected by the user to load the ICSR reports in Argus Safety. Selected count can be changed by checking the 'Initial' or 'Follow Up' or 'Nullification' checkbox.
	Import	Imports all the reports.
Note: For the Import process, if the system receives an ICSR report with the Medically Confirm field set to 1, the Primary reporter is marked as HCP.


	Cancel	Removes the Import ICSR reports window.











Search for Duplicate Reports

The Duplicate Search dialog box for an ICSR report enables you to search for possible duplicate cases in the Argus Safety system. You can select different combinations of search criteria. When more than one criterion is selected, only cases that satisfy all criteria are listed. By default, the fields that are present in the ICSR Report are checked for the Duplicate Search.

[image: Surrounding text describes dupsearch.jpg.]


View Duplicate Search Options


	Field	Description
	Onset Date	The date from when the first reaction or adverse event occurred.
	Reference #	National Regulatory Authority's Report Number, used as a Reference Number.
	ICSR Viewer	Enables you to view the E2B report.
	View Differences	Allows viewing differences between the current XML to be imported (a message that is not yet imported into the database), the current case data in the database, and if a case has been imported before, the last imported case.
Note: This button is available only for follow-up and nullification reports.


	Action	Enables you to view the Case Summary dialog box.
	Reporter	Displays the reporter involved with the case matching the search criteria.
This field appears in the search results.


	Reference ID	Searches on the following fields in the Argus case:
	
Additional Info | Case Reference ID


	
Reporters | Reporter's Reference #


	
Argus Case Number





	Keyword	By default, the first value from the incoming affiliate event appears.









Search Duplicates for Incoming Review

The Duplicate Search in Argus Central Incoming review enables you to search on Reference ID and Keyword field in Argus cases.

You can right-click the Case Number for a listed case and use the following options:


	Right-click Option	Description
	Case Form Print	This option is displayed for only those users who belong to the group with access to Argus Console > Access Management > Groups > Menu > File > Print.
This option allows you to print the case form report.


	Case Summary	This option is displayed for only those users who belong to the group with access to Argus Console > Access Management > Groups > Menu > File > Open Case Summary.
This option allows you to open the summary report of the case.


	Medical Summary	This option is displayed for only those users who belong to the group with access to Argus Console > Access Management > Groups > Menu > File > Print.
It displays the medical summary of the case.


	Unlock/UnArchive Case	This option is displayed to allow users to re-open the archived and locked cases. On clicking this option, a Locked Case/Archived Case screen (as applicable) is displayed. You need to enter your password along with any remarks/notes and select a reason for your action to complete the unlocking/unarchiving of the case.


Note: This option is available only when the case is in locked/archived status, and if the user has privileges to lock/close the case, as per Console User Configuration > Case Form settings.











View Differences Report

You can view differences between the current XML to be imported (a message that is not yet imported into the database), the current case data in the database, and if a case has been imported before, the last imported case.

Note: View Differences is available for follow-up reports only. This option is enabled only when an initial case or case number is selected in the duplicate search output section.

To view the View Difference report:

	
From the Duplicate Search screen, click View Differences.

The ICSR Difference Report screen appears

The differences in the ICSR reports appears as:

	
Addition—New elements are highlighted in grey.


	
Deletion—Deleted elements are highlighted in red.


	
Modification—Modified elements are highlighted in yellow.







The following table describes the fields in the report.


	Field	Description
	Trading Partner	Allows you to view the Trading Partner name from whom the ICSR report is received.
Note: The Lock/Archive icon displayed with this field denotes the status of the case.


	DTD Version	Allows you to view the DTD version of the follow-up ICSR report.
	Case Number	Displays the original case number of the ICSR report.
	Follow Up #	Displays the sequence number of the follow-up for the E2B report.
	Total Number of Rows	Allows you to select the type of ICSR Difference to view from: Current ICSR vs. Current Case in Database
	
Current ICSR vs. Last Imported ICSR


	
Current Case in Database vs. Last Imported ICSR





	Import	Highlights the import differences.
	ICSR Element	Highlights the ICSR differences.
	Current ICSR	Highlights the differences in the current ICSR.
	Current Case in Database	Highlights the differences in the current case in the database.
	Last Imported ICSR	Highlights the differences in the last imported ICSR.
	Accept Follow-up	Allows you to update the corresponding fields for the selected ICSR elements in the Argus case.
	Reject Follow-up	Does not update the corresponding fields for the selected ICSR elements in the Argus case.
	Print List	Provides the difference report in a PDF format.







Accept Initial E2B Cases As Follow-Up

This option is enabled only when an initial case or case number is selected in the duplicate search output section.

	
To add an ICSR as a follow up to the Case Number (that is highlighted in the duplicate search output section), click Accept Initial E2B Cases As Follow-Up.

A pop-up dialog box appears:

"Do you want to add this ICSR as a Follow-up to the Case Number<Num>?"


	
Click OK to proceed.


	
The Argus application attaches the incoming ICSR as a follow-up, to the selected case number highlighted in the duplicate search screen.












View Processed ICSR Reports

The Processed ICSR Reports page contains a list of ICSR that are processed successfully or processed with Errors/Warnings.


Search for Reports


	Field	Description
	Trading Partner	
	To filter based on the Trading Partner, click Filter, and select an agency.
	
To select multiple agencies, click Add from the Select Reporting Destinations dialog box.





	Product Name	Enables you to select a Product Name as a search criterion.
	
For Product Name from Processed E2B Reports—searches all the Product Names for all the processed cases.




The result set is limited to 1000 rows.

To update the Product or Generic Name, selects a value from the search result, and click OK.











View Search Results

The search results appear in the Total Number of Rows section.


	Field	Description
	Interchange Date	Displays the Case Number with which the case has been imported on the specified interchange date.
	ACK GEN Sent	Displays the status of the ACK GEN.
	
Yellow—Import is pending


	
Orange—Import is accepted but with warnings or errors


	
Red—Import is rejected


	
Green—Successful import





	EDI Out	Displays the EDI Out status.
	
Yellow—Pending to send the report out of the EDI / XML or PHY out folders


	
Green—Already sent out of the EDI / XML or PHY out folders


	
Red—EDI gateway failed to send the report out of the EDI / XML or PHY out folders





	Warnings / Errors	Click binoculars icon to view warnings/errors associated, if any.













Track your ICSR Report Submissions


Track ICSR Outgoing Status

	
To monitor the Outgoing messages and Acknowledgements, go to Utilities > ICSR > ICSR Transmit Status.


	
In the Search Reports section, enter the search criteria, and click Search.

The search results appear in the Total Number of Rows section.

If the Agency is selected as Any, the search results display all ICSR messages and acknowledgements for all receivers.








Track ICSR Incoming Status

To monitor incoming ICSR:

	
From Utilities, go to ICSR > ICSR Receive Status.


	
In the Search Reports section, enter the search criteria, and click Search.

The search results appear in the Total Number of Rows section.

If the Agency is selected as Any, the search results display all ICSR messages and acknowledgements for all receivers.


	
Click the Type Icon link to view message options.








View Message Options

Click the Type icon to view the options:

	
Any—Displays all the ICSR messages and acknowledgments.


	
MSG—Double-click MSG to view messages in the ICSR Viewer.


	
ACK—Double-click ACK to view the acknowledgement.




On click of any above-mentioned option, the Message Acknowledgement screen appears.

This screen contains all the safety report detail information such as, if the report is loaded or not loaded with error and enables you to monitor message acknowledgements.







Check When Your Expedited Reports are Due


View Expedited Report Status

	
To search for and field information about the status of expedited reports, select Dashboards > Expedited Report Status.

Alternatively, go to Worklist Group > Expedited Reporting Status.


	
In the Search Case section, enter the parameters, and click Retrieve.


	
To view the Grouped Expedited Reporting Status (Pie chart), click the color-coded areas of the pie chart.

All the reports or cases opens within that section instead of just the bar.


	
To view the Expedited Reporting Status (Bar chart), click a bar.

Worklist with the cases that belong to the reports or the actual reports appears. These reports belong to the specified time-frame.




Note that, when you have access to Expedited Report Status, you would also have access to the Report Due Soon dashboard.





View Reports Due Soon

As report scheduling is commonly configured to be executed when significant changes are made to a case, the expedited reports may be delayed if a case never gets locked. You cannot know that a report is late if it has never been scheduled. To address this potential compliance issue Argus Safety assesses case reportability prior to formal report scheduling. Workflow and Expedited Status monitoring screens identify unlocked cases due soon.

	
To view a list of unlocked cases with reports due, select Dashboards > Reports Due Soon.

The Unlocked Cases with Possible Reports Due Soon screen appears.


	
The Workflow and Expedited status include another report with cases that have not had reports scheduled but that may generate a report with a due date in the near future. This graph is displayed below the graph detailing the actual case status. The reports included in this sub-dashboard are limited to the filter criteria specified for the main dashboard.

To view a Worklist with cases of the selected state (red or yellow), click the graphical bar.










Find Overdue Reports

	
On the Home page, hover over the Worklist menu and click Reports.


	
Click on the field Days Past Due on the right of the Total Number of Rows and if needed click again to show Days Past Due in descending order (arrow pointing downwards).

[image: Surrounding text describes overduereps.jpg.]

	
To view all reports select ALL at top right of the screen.




For details on entering data in each section of the Total Number of Rows tab, see Total Number of Rows link.





Trigger Local Reports—Report Generation Algorithm

The changes described below are applicable only when there are local reports configured in the application (i.e. there is data in the Local Reports Configuration table).

The Report Generation functionality does not generate any Japan Local reports, including the reports that were scheduled by the local reporting rules that were marked as Active Moiety or Super Rules, until a local lock occurs. The global reports are generated on global lock.

In Case Form > Regulatory Reports tab, the Final hyper link for a local report is NOT available for a case that is not yet locally locked (similar to the existing functionality for global report on a global unlocked case).

In Case Form > Regulatory Reports tab, the Regenerate Report menu for a local report is NOT available for a case that is not yet locally locked (similar to the existing functionality for global report on a global unlocked case).

The Final checkbox in Case Actions > Case Open > Batch Print dialog box will remain disabled and grayed out when any of the case selected is locally unlocked as it does today when a case is globally unlocked.

If report generation is invoked from the Batch Report Generation AG Service, the AG Service skips the case that is not yet locally locked similar to the existing global unlocked cases.

Note that Worklist > Bulk ICSR Transmit > Re-Transmit and Re-Transmit Multiple Reports put a failed report back in generation to be picked up for processing by Batch Report Generation AG Service. The above point will apply in this scenario.

If report generation is invoked from other AG Services listed below, the AG Service today ignores the global locked status and generates reports. This has been corrected so that the AG Service skips the case that is not yet globally locked when generating global reports similar to the existing Batch Report Generation AG Service. Similarly, the AG Services listed below skip the locally unlocked cases while generating local reports:

	
Bulk Report Transmit


	
Bulk Report Transmit Email


	
Bulk Report Print


	
Bulk Report Transmit Fax


	
Bulk Report Transmit ICSR











8 Manage Your Periodic Report Submissions

Periodic reporting plays a key role in the safety assessment of drugs. It involves the compilation of safety data for a drug over a prolonged period of time (months or years), as opposed to single-case reporting which, by definition, involves only individual AE reports. The advantage of Periodic reporting is that it provides a broader view of the safety profile of a drug.


Prepare Content for Periodic Reports


Prepare your Aggregate Reports

These reports are executed in the background through the AG Services. A new argus service named Batch Aggregate Report Generation is available for this purpose.


Understand Aggregate Reports

	
The date and time printed on the following reports are the date and time the query is executed for case qualification. They are not the date/time the query was completed and the report obtained Web Server.

	
Case Listing Report


	
Case Data Analysis Report





	
The system converts the following elements that display in the case form as actual text on the Case Listing and CIOMS II Line Listing reports:

	
Duration of Administration


	
Time Between First Dose/Primary Event


	
Time between Last Dose/Primary Event





	
Capture the report follow up number in the Regulatory Reports section. The system prints the report follow-up number on the expedited reports in the following format:

F/U# X

where:

X is the report follow-up number.


	
For an initial report, the system prints initial in the column.


	
If there are no reports for the case in the Case Listing/CIOMS II Line Listing, the column is left blank.


	
This option is available on the CIOMS II Line Listing/Case Listing reports.


	
The system uses the IE offset of the client workstation to print the date and time component for all system-calculated fields on the Case Listing/CIOMS II Line Listing reports.


	
You can filter cases in the following aggregate reports based on the lock/archived date.


	
When you select Case Locked/Archived date, the system limits the cases based on whether the case is locked/archived within the specified time frame.


	
The lock date is considered the locked date.


	
If you select the Case Patient or Reporter Information in the Case Listing or CIOMS II Line Listing reports and the Protect Confidentiality field is checked for the patient or reporter Information, the system does not print the relevant patient or reporter Information selected in the Case Listing or CIOMS II Line Listing report.


	
If you do not have permission to view the reporter or patient information, the corresponding reporter or patient elements selected on the Case Listing or CIOMS II Line Listing report are blank.








View Saved Aggregate Reports

The System Reports Library displays the list of the saved aggregate reports including Case Data Analysis, Case Listing and CIOMS II Line listing reports. This screen displays only the reports either created by the logged in user or the reports that are shared for your user group during report creation.

	
The Aggregate report supports only PDF or CSV formats.


	
The system report library screen, provides the way to filter the reports through:

	
Report Name


	
Description


	
Report Type


	
Output Type


	
Author


	
Last Modified


	
Available for Periodic


	
Shared





	
The reports can be executed through the Print option. When you click Print, the applications opens the Report Batch Printing dialog box, where you can run or schedule the report for the desired format (PDF/CSV). You can send an email for the completion status.


	
The open option allows to open and edit the memorized reports.


	
If the user clicks Transmit, the system generates the selected report and starts the transmit process. The system displays the Recipient pop-up.







	
Note:

A shared report can only be deleted by the Administrator or the user who created it.











Create a Case Data Analysis Report

The Case Data Analysis Report enables you to view quantities of cases over time in a Cross-Tabular Fashion.

	
Select Reports > Aggregate Reports > Case Data Analysis.


	
In the Case Data Analysis Report view, select the information that must appear in the report.


	
In Row1, select the field the system uses to group cases by row.


	
In Column1, select the data the system uses to group cases by column.


	
In Row2, select the field by which each Row1 item will be categorized.


	
In Column2, select the field by which each Column1 item will be categorized.


	
Select a product family to which the report applies, if appropriate.


	
In Selection for Row1, select the value for row 1 by which the report must be restricted.


	
Specify an advanced condition, as appropriate.


	
Select Report Number of Cases or Report Number of Events, depending on the number of cases or the number of events to be entered in the report.


	
If you select Report Number of Events, you can specify the kind of events (serious listed, non-serious listed, serious non-listed, or non- serious non-listed) that will appear in the report.


	
Select whether only the top few items should be displayed and enter the number of items that should be displayed.


	
Check the Show% of Total checkbox to specify the percentage in each cell in the report.


	
Check the Blinded checkbox to hide blinded information in the report. This field is unchecked and disabled for a restricted user.


	
Check the Use Case Search Results checkbox to limit the Case Data Analysis only to the cases present in the Case Search dialog box.


	
Specify a date range for the cases that will appear in the report.


	
Enter a title for the report.


	
Click the Share this report with other users if there is a need to share the report/report output to other users. Note that the report may contain sensitive data. By default, the report is shared with all users. You can restrict it through Group, where the allowed user groups can be selected. When a report is shared for a user group, only members of that group and the report creator can access the report further.


	
The report can be used in the periodic report using Make available for use in Periodic Reports.


	
The Case Data Analysis report, in addition to the PDF and CSV format, supports the chart format too.

This report output can be selected via Report Display Type field. The following chart types are available:

	
Bar Graph


	
Line Chart


	
Area


	
Pie


	
Donut


	
Stacked




	
Note:

The chart reports are run in sync and available only the user's browser and not stored in the database.











	
Click Print to execute the report in background. This report can later be viewed under system reports library.


	
The memorize button saves the report in the application. It does not execute the report.








Create a CIOMS II Line Listing Report

The CIOMS II line listing report is a common format desired by Drug Safety professionals for reviewing cases. Create this report from the CIOMS II Line Listing dialog box.

	
Select Reports ->Aggregate Reports -> CIOMS II Line Listing.


	
On the CIOMS II Line Listing Criteria tab, select information for the header, footer, product family, advanced condition (if any), cases to include, and date.


	
Select either the Case Creation Date or Case Receipt Date radio button and specify a date range to run the report.




	
Note:

If you perform a search and return a list of cases to the Case Search screen, the Use Case Search Results is visible. Checking this box will disable all selection criteria with the exception of Include Unlocked Cases. For example, the Advanced Condition and Date Range will be disabled.








	
In the Line Listing tab, add or remove the appropriate fields.


	
In the Grouping tab, add or remove elements, insert a page break and change the sort order (if desired).


	
Click Memorize to open the Memorized Report dialog box.

The Memorize button saves the report in the application. It does not execute the report.


	
Click Print to execute the report in background. This report can later be viewed under system reports library.


	
This report can be shared with other users of Argus and the sharing can be restricted through the User Group selection.








Create a Case Listing Report

The Case Listing Report enables you to filter cases based on Case Initial Receipt Date and Case Creation Date. You can select multiple entities from the List of available fields using the CTRL+CLICK functionality.

	
Select Reports -> Aggregate Reports -> Case Listing.


	
When the system opens the in the Case Listing Reports view select the information to appear on the report.


	
Select the fields that are to appear in the report from the Available Fields list.


	
Click Add. Repeat this process for each field that must appear in the report.


	
Use Move Up and Move Down to arrange the fields in the Selected Fields list.


	
Check the Blinded checkbox to hide blinded information in the report.


	
Specify an Advanced Condition, if appropriate.


	
Specify a date range for the cases to be displayed in the report.


	
If you check the Include in Header checkbox, the selected date range is displayed on the report.


	
Under Sorting Order, select the fields by which the cases will be sorted. You cannot sort the cases by fields that do not appear on the report.


	
Enter the title of the report.


	
Click Memorize to memorize the criteria specified for a particular report.

The Memorized Report dialog box appears.


	
Save, Delete or Cancel the report, as applicable.


	
Click OK in the Case Listing Reports screen to generate the report. The report will be generated in PDF format.








Check Aggregate Report Execution Status

Go to Reports > Compliance > Report Generation Status.

This screen displays the status of report generation for both Periodic and Aggregate reports. The Aggregate Reports can be filtered using the report type filter.







Periodic Report Types

On the Reports menu, hover over the Periodic Reports option, to go to any of the Periodic Reports.

You can create the following periodic reports:

	
Clinical Trial Periodic Reports


	
ICH PSUR Reports


	
US IND Periodic Reports


	
US NDA Periodic Reports





Store Periodic Reports in Documentum

When you approve an expedited report from within Argus, the system exports the report as a PDF file and saves it in the Documentum database by Argus Safety Service. From this point, you can perform document reviews within the Documentum system.

When the report is ready to be submitted, mark the report as Submitted from within Argus. Argus Safety Service updates the status of the report within Documentum to Submitted.

If the report is to be transmitted via fax or email, Argus Safety Service marks the report as a successful submission in Documentum only after the fax or email transmission has succeeded.





View a Summary of Periodic Regulatory Reports

You can select any of the following options in viewing the summary of a periodic regulatory report:

	
To view the regulatory reports for a particular case (scheduled, generated, and submitted), open the Regulatory Reports tab of the Case Form.


	
To view all scheduled, generated, and approved reports, as well as other outstanding action items assigned to you or your user group, select Reports in the Worklist menu.


	
To view a list of all scheduled, generated, and approved periodic reports, select Periodic Reports from the Reports | Compliance menu.








Use the Library Page

The Periodic report has a library page from where you can create a new report, execute an already created report, view the output and so on.

	
PSUR (legacy PBRER, PSUR and Flexible PBRER, PMAR reports)


	
CTPR (legacy CTPR and Flexible DSUR reports)

All fields that are used by the Flexible DSUR is highlighted with blue BIP icon.


	
IND


	
NDA




While a report is running, it can be modified or run again until the previous run is complete.







Prepare Content for a Clinical Trial Periodic Report

The Clinical Trial Periodic Reports (CTPR) are created to report the IND Annual reports and EU Clinical Trial Directive line listing reports to FDA.


Create a Clinical Trial Periodic Report

	
Select Reports > Periodic > CTPR (Clinical Trial Periodic Reports) to open a list of CTPR Reports.


	
To create a new report from an existing report in the list, click Copy or Modify.


	
Click New Report to create an entirely new report. The Clinical Trial Periodic Reports pop-up window opens.


	
Enter an appropriate name for the report under Report Name.


	
Use the tabs in this pop-up window to configure the CTPR.









Enter Common Fields Information

The Report Name, Report Category and Report Sub-Category fields are common to all tabs of the Reports.


	Field	Description
	Report Name	Enter a name for the Report. The name entered here is displayed in the Reports menu.
	Report Category	
	Select a category for the Report. This is displayed in the Reports menu.
	
Select New to define a subcategory within the report category.

The Periodic Report Category dialog box is displayed.


	
Enter a category name in Category and click OK.


	
The category is entered in the Report Category drop-down list.





	Report Sub Category	
	Select a subcategory for the report.
	
Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog box is displayed.


	
Enter a category name in Category and click OK.


	
The category is entered in the Report Sub-Category drop-down list.














Configure Subject in the Report Header

The Subject of Report tab is used to configure the report header and to specify the agency, products, etc. for which the CTPR is applicable.


	Field	Description
	Available Reporting Destination	Displays the list of configured Regulatory Agencies. Select an agency from the list displayed in Reporting Destination and click Add to add the report to the Selected Destination list.
Select multiple agencies by holding the CTRL key when you click them.

Likewise, select an agency from the Selected Destination list and click Remove to remove it from the selected destination.


	Primary Agency	Select the primary agency for the report.
When you submit a Periodic report, it goes to the selected Primary Agency.


	Selected Reporting Destination	Displays the list of agencies where the report is being sent. Select an agency from the list displayed in Reporting Destination and click Add to add the report to the Selected Destination list.
Select multiple agencies by holding the CTRL key when you click them.

Likewise, select an agency from the Selected Destination list and click Remove to prevent it from being sent to the selected destination.


	Ingredient	Automatically displays the Ingredient as provided in the Subject of Report dialog box.
You can choose whether to view this field or not. Click the checkbox displayed with this field to hide or view it.


	Trade Name	Automatically displays the Trade Name(s). Multiple trade names are also displayed together, separated by commas.
You can choose whether to view this field or not. Check the checkbox displayed with this field to hide or view it.


	International Birth Date	Automatically displays the earliest license awarded date, when a user selects an Ingredient and a Product.
You can choose whether to view this field or not. Check the checkbox displayed with this field to hide or view it.


	Print all configuration criteria on separate cover page	Mark this box to print out the configuration of this report when the report is printed. This is only available when PDF option is selected during printing.
	Print page numbers on reports	When checked, this option enables the user to print page numbers on a periodic report. This is the default for all report configurations.
If this checkbox is not checked, the following occur.

	
The Include Periodic Page Numbering option in the CTPR Summary Tabulations CIOMS Report section is inactive and grayed out.


	
The User Periodic Numbering on the report option on CTPR Summary Tabulations FDA CTPR support section is grayed out and inactive.


	
The Additional Separate Page Numbering for UD Summaries option on the CTPR UD Summaries tab is grayed out and inactive.


	
The system removes all existing report page numbering and the option to check page number checkboxes on the report configuration tabs are grayed out and inactive.





	Allow access to report cases through Case Series	When the report is run as final, it creates a Hit List, which can be retrieved from other areas of the application where advanced conditions can be selected. Click this checkbox to report cases through the Hit List.









Select Products to include in CTPR

The Product Selection tab enables you to select the products included in the CTPR report.


	Field	Description
	Available Ingredients	Displays the list containing the Ingredients used for the product configuration. Select an ingredient from the list displayed in Available Ingredients and click Add/Remove to add/remove the ingredient.
You can select multiple ingredients at a time.


	Filter	Enter an Ingredient name and click Filter to search for the entered ingredient within the Available list of Ingredients.
	Selected Ingredients	Displays the list of ingredients selected from the Available Ingredients list.
	Available Countries	This list is auto-populated and displays only the countries with a license containing the ingredient selected from the Available Ingredients list.
	Selected Countries	Displays the countries selected from the Available Countries list.
	Indication	This list contains the Indication configured for the product containing the ingredients in the Available Ingredients section. The selections made from this list get displayed in the Available Products section.
You can select multiple Indications from the list at a time by pressing the CTRL key and clicking the different Indication entities.


	Formulation	This list contains the Formulation configured for the product containing the ingredients in the Available Ingredients section. The selections made from this list get displayed in the Selected Products section.
You can select multiple Formulations from the list at a time by pressing the CTRL key and clicking the different Indication entities.











Configure License or Study in the Report Header

The License/Study tab is used to configure the report header and to specify the agency, products, etc. for which the CTPR will be applicable.


	Field	Description
	Available Licenses	Contains licenses that use the ingredient selected in the Ingredient field. This field is automatically populated when an ingredient has been selected.
	Selected Licenses	Displays the licenses selected from the Available Licenses list by clicking Add/Add All. You can select Licenses that are related to different ingredients for a report.
	Available Studies	Contains studies that use the ingredient selected in the Ingredient field. This field is automatically populated when an ingredient has been selected.
	Selected Studies	Displays the studies selected in the Available Studies list by clicking Add/Add All. You can select studies that are related to different ingredients for a report.









Select Inclusion Criteria

The Inclusion Criteria tab allows you to select search parameters for inclusion of cases in a periodic report.

The top section of the dialog box allows you to specify the type of cases that will be included in the periodic report.


	Field	Description
	Case Creation Date	Allows you to specify a range of cases by the date when the case was created.
	Case Receipt Date	Allows you to specify a range of cases by the initial receipt date.
Note: The Date Range is only available when an unscheduled CTPR is being created. You must specify only one date range out of Case Creation Date and Case Receipt Date.


	Case Locked/Archived Date	Allows you to specify the date when the case was locked/archived.
	Use Current Version	Allows you to use the latest revision to populate the data within the selected reports.
	Use DLP Version	Allows you to use the case data of the version as of the specified DLP Version.
	Age Groups	Allows you to include or exclude cases based on the patient's age group. Select all the age group categories that apply.
	Restrict Cases to countries where studies are active	References study configuration to determine if the case was submitted during the dates the study was active.
Note: This option is available only if a study is selected from the Available Studies section in the License/Study tab.

It should not be used for Centrally approved products (CAP), which only have an EU license.


	Advanced Condition	Allows you to specify an advanced condition that must be satisfied by each case that is included in the report. Ensure that the advanced condition or the advanced condition query set that is specified here does not contradict any other criteria specified in the dialog box.
	Datasheet for Listedness	Select the Datasheet to look against for Listedness when running the report.
Note: Select the ALL datasheet to use the most conservative listedness for the primary event, or the Case Listedness for the tabulation.


	Use Assessment in Cases	When selected, the CTPR Report will use the Case Event Assessment when performing datasheet listedness calculations.
	Re-assess cases against datasheet in effect at the beginning	When selected, the CTPR will re-assess the cases in the line listing based on the Active Datasheet on or before the Start Date of the Reporting period.
	Re-assess cases against datasheet in effect at end	When selected, the CTPR will re-assess the case in the line listing based on the Active Datasheets on or closest to the end date of the CTPR Reporting end date range without exceeding that date.
	Reference Type (Clinical Reference Data Element)	Select the reference type to be displayed on the Main Listing if Clinical Study Reference is selected as a Data Element in the Available Data Elements section of the Line Listing tab.
	Expeditable Only	This option is enabled only when an agency has been specified on the Subject of Report tab. Check this option to include only those cases that have submitted expedited reports to the specified Primary Agency.
	Exclude Follow-up cases	Follow-up cases are cases with a significant follow-up in the Clinical Trial reporting period where the initial receipt date is in a prior period. Check this option to exclude follow-up cases from appearing on the Clinical Trial report.
	Include Unlocked Cases	Check this option to allow cases that have not been locked for reporting to appear on the report.
	Use Datasheet Assessment for UDF Tabulations	Allows you to select datasheet for a report to make UDF tabulations.If no datasheet is selected, the most conservative listedness is chosen, i.e. Unlisted followed by Listed.
	Add Cases not included in previous reporting period	Allows you to add cases which were not included in the previous reporting period.
You can enter the start date of the period in the Start Date field.











Use the Data Lock Point (DLP) Version

DLP primarily uses two processes:

	
Last Completed Version - This option always uses the case version with the last lock that existed prior to the DLP or As of reporting date. This option does not enable data cleaning

DLP saves only the last revision when multiple saves are performed in the same job session.


	
Next Completed Version - This option uses the current case lock or the next following case lock if the case version was initiated prior to the DLP or the As of reporting date with two exceptions:

	
If there is no case lock for the current version that was received prior to the DLP, the last (current) case revision is used.


	
If there is a case version after the case lock that was created for the purpose of data cleaning, it is to be used instead of the first locked case revision.


	
If there are multiple contiguous case versions following the first case lock for the purpose of data cleaning, the last case data cleaning version is used.




	
Note:

The Data Cleaning option is available only with the DLP option Use Next Completed Version (Includes Data Cleaning).

















Use DLP Queries for Dates

You can perform DLP queries for the following:

	
Receipt Date -- date entered by the user during case creation


	
Initial/Follow up Receipt Date


	
Safety/Safety Follow up Receipt Date


	
System Date (Case Creation Date) - date the case was physically entered








Use As of Reporting Function

The as of reporting function returns the same case version results as the DLP Options, with the only difference that the date depends on the As of date instead of a DLP date.





Find DLP and As of query functionality

The DLP and as of query functionality is available in the following application modules:

	
Periodic Reports

	
PSUR including all User defined Tabulations and expedited reports within the Periodic Report


	
CTPR including all User defined Tabulations and expedited reports within the Periodic Report


	
IND including all User defined Tabulations


	
NDA including all User defined Tabulations and expedited reports within the Periodic Report





	
System Reports

	
CIOMS II Line Listing


	
CDA Reports


	
Case Listing Reports











Include Line Listing


	Field	Description
	Include Line Listing	Allows you to select whether you want the Line Listing Data Elements printed with the CTPR Report.
	Blind Line Listing and Summary Tabulations	Hides the selected listings from being displayed









Add Data Elements

Select the checkbox associated with a data element (field) to add that field to the report.

	
By default, the system print s unavailable fields on the report, and they cannot be changed.


	
Required data elements are printed as columns in the report. The optional data elements are printed as separate rows below the column data for each case.








View Selected Data Elements

This section lists the selected elements and enables you to arrange the order in which these are to be printed. Click the Up or Down buttons to arrange the listed elements above or below in order of priority.


	Field	Description
	MedDRA Hierarchy from Cases/Dictionary	Select Cases to populate the data from the case data. Select Dictionary to populate the data from the MedDRA dictionary.
	Print Only the Term (Preferred Term or Lower Level Term)	Prints only the event Preferred Term (PT) or event Lower Level Term (LLT) as per the selected radio button. Select the PT option to print only the preferred term and not the verbatim description.
	Print Dose Text in place of regimen dose	Prints the dosage and frequency information from Dose Description field instead of Regimen Dose.
	Indicate if case was expedited previously	This checkbox is selected if a primary agency has been selected in the Subject of Report tab. Cases for which an expedited report was previously submitted to the selected authority are marked with an asterisk.
	Local Language	Allows a user to specify which Local language for a multi-language field is to be printed i.e. the Abbreviated Narrative field.
	Print event info (Serious, Un-listed, Related) as Column	Select this checkbox to print the Seriousness, Listedness and Causality under the Event Verbatim column.
Note: Events having listedness of Unknown are considered Unlisted. If only diagnoses are assessed for event assessment, the events which are associated with a Diagnosis but have been marked with Diagnosis as Np display - for both listedness and causality.


	List cases only once, under the primary event	Select this option to view the details of cases in the Main Line Listing only once under the Primary Event
	List cases under all events, details under the primary event	Select this option to view the details of cases in the Main Line Listing only once under the Primary Event, while non-primary events are listed under their respective event hierarchy with a reference to the primary event body system. Therefore, use this option when grouping on Main Line Listing is by the Event Body System.
	Print Product Indication for the product selected in the report	Select this option to print Product Indication for the product selected in the report.









Group Cases


	Field	Description
	Available Groupings	Allows a user to group cases together from the given list. Select the desired groupings from the list and click Add to move the grouping to the Selected Groupings list. Up to 10 grouping options can be selected.
	Selected Groupings	Lists the added groupings made available from the Available Groupings list, and reports the groups in the order they were selected.
	Ascending	Select this checkbox to sort the selected entities in ascending order.
	Page Break	Select this checkbox to start the cases from a new page, while also keeping the sorting together for every selected page break.
	Available Sortings	Allows a user to sort cases together from the given list. Select the desired sortings from the list and click Add to move the sorting to the Selected Sortings list.
	Selected Sortings	Allows a user to further sort cases without a total count for each sorted item. Up to 3 levels of sorting can be selected from the Available Sortings list.









Specify Summary Tabulations for Line Listing

The Summary Tabulations tab enables you to specify which summary tabulations/Listings will appear along with the line listing.


	Field	Description
	Include Index of Cases in CTPR	Create an index page of case numbers, for all cases included in the CTPR.
	Include Summary of Cases Missing Assessments	This option creates a sub-report of cases missing one of the following items:
	
Seriousness


	
Case Causality


	
Case Listedness


	
Case Outcome


	
Event Causality


	
Event Listedness




Click this checkbox to create one or both of the following sub reports:

Cases Missing Assessments - This sub-report displays cases that have been included in the CTPR line listing, but one or more of the following have not been assessed:

	
Case Seriousness


	
Case Causality


	
Case Listedness


	
Case Outcome


	
Event Causality


	
Event Listedness




Cases Not Included in Report - This sub-report displays cases that have not been included in the CTPR line listing as a result of missing one or more of the following items:

	
Lock Status


	
Safety Date


	
Uncoded Event


	
Causality





	Count of Cases per Report Type	This option prints a Sub Report that counts the number of cases versus the Report Type, based on the cases within the CTPR.
The Cases per Report Type can be either of the following:

Count Cases with Initial Expedited Reports: Counts cases with initial Expedited report.

Count of cases with Follow-up Expedited report: Counts cases with Follow-up Expedited report.

Total Count of Initial Cases in the Report: Counts any (serious - non-serious) cases received during the reporting period.

Total Count of Follow-up Cases in the Report: Counts any (serious - non-serious) follow-up cases entered during the reporting period.

Cumulative Count: Count of cases received from the start of the trial.


	Event Count per Study Drug	Creates a sub-report with Event count per Study Drug based on the selected causality. 2 configurations are possible as to allow for a count of related events vs. non-related events.
	All Study Drugs in Single table	Suppresses 0 current columns (with their cumulative) and print everything in a single cross tab.
	Grouped by Study Drug	Prints a cross tab report for every product. Prints the cumulative totals even if the current period has no events.
	Event Type to Include	Prints SUSAR events on the CTPR Report based on the option selected from the drop-down list:
	
Separate counts of SUSAR and non-SUSAR events

Prints SUSAR and non-SUSAR events listed separately. SUSAR events are marked with an asterisk


	
Combined count of SUSAR and non-SUSAR event

Prints SUSARs. Normal events are grouped into one (current functionality)


	
Only count SUSAR events

Prints Only SUSARs i.e. non-SUSARs would not be printed





	Include Line Listing Tabulation	Select this checkbox to view a pre-defined summary tabulation of Report type, Seriousness and Listedness of all cases in the CTPR.
	Include Initial Cases	Select this checkbox to include initial cases in the CTPR tabulation.
	Additional Expedited Report Forms (CIOMS/MedWatch/VAERS)	Allows you to print CIOMS/MedWatch/AERS forms (as per selection) for its respective regulatory agency (as selection), for all cases in the report. It also provides an option to have (or not have) a watermark in the forms.







CIOMS Reports—Fields Descriptions


	Field	Description
	Print CIOMS reports for serious/unlisted cases	Allows a user to print CIOMS I forms for all Serious/Unlisted (Case Level) cases appearing in the CTPR.
CIOMS contain Internal or Other text printed on them when the CTPR is printed using the Internal or Other option.


	Include Periodic Numbering on the CIOMS reports	Numbers the requested CIOMS I with a periodic format. (i.e. A-1-1 of 2, A-1-2 of 2, A-2-1 of 1, A-3-1 of 1 etc.). The index is modified to also contain the Periodic paging of each CIOMS report.







Cumulative Summary—Fields Descriptions


	Field	Description
	Include Cumulative Summary	Select the checkbox to create a sub-report count of events, grouped by Product and Body System (SOC) and sorted by Preferred Term. The sub-report contains a previous date range count of events (comparative date range), a current date range count (current CTPR date range) and a cumulative count (all dates) of events assessed against the product(s) of the CTPR and matching the inclusion criteria.
	Comparative Date Range	Allows a user to specify the previous date range as a comparison date for the events counted, and therefore should not overlap with the current date range specified on the CTPR inclusion criteria tab.







FDA CTPR Support—Fields Descriptions


	Field	Description
	FDA CTPR Support Section
	Include Adverse Event Summary	Select this option to generate a sub-report of events from the line listing. This sub report is grouped by Body System and Preferred Term.
Note: This section can be used if the company has obtained an FDA waiver to submit a CTPR instead of an NDA report.


	Causality	Select the desired causality from the list.
Ignore - Counts events regardless of causality assessment.

Causal - Counts events where the causality is considered reportable in the Causality Category configuration in List Maintenance.

Not Causal - Counts events where the causality is considered non-reportable in the Causality Category configuration in List Maintenance.

As Determined - Counts events where As Determined causality meets the above selected causality criteria.

As Reported - Counts events where As Reported causality meets the above selected causality criteria.

Both - Counts events where both As Reported and As Determined causality meet the above causality criteria.

Either - Counts events where either the As Reported or As Determined causality meets the causality criteria.


	Only Cases with HCP Reporter	Select this checkbox to include events for only those cases that feature an HCP reporter
	Diagnosis	Select this radio button to ensure that only events marked as diagnosis are counted.
	Diagnosis & Symptoms	Select this option to ensure that all events are counted in the sub-report.
	Separate Diagnosis & Symptoms	Select this option to include all SUSAR events in the CTR Report.
	Print Unsubmitted	This option allows a user to print MedWatch or VAERS forms for U.S. cases. The following types of cases will be excluded:
	
Foreign Cases (Country of Incidence not equal to U.S.)


	
Clinical Trial Cases (Case Report type in list maintenance has this type includes cases from clinical trials checked.)


	
Literature Cases (Case Report type in list maintenance has this type include case from literature checked.)


	
Cases with submitted expedited reports to the Agency selected in the CTPR.





	Exclude Reports that are Non-Serious and Listed	Allows a user to suppress MedWatch or VAERS forms from printing for Non-Serious listed cases where all events are non-serious and listed for the datasheet specified.
	Use Periodic numbering on the Reports	Numbers the requested forms with a periodic format. (i.e. Periodic Page 1 - 1, Periodic Page 1 - 2, Periodic Page 2 - 1, Periodic Page 2 - 2, etc.) An index with the Case Number is also included.









Generate Single Case Submission Report


	Field	Description
	Single Case Submission Support Section
	Generate Periodic ICSR Submissions for any cases in this Periodic Report that does not have at least one scheduled single-case report during the reporting period to the following Reporting Destination(s): Modify	Select this checkbox to generate the ICSR Reports only for the cases, where a Periodic ICSR Report for the message type chosen, does not exist.
Select one or more trading partners from the list box.

Important: Any case that does not have an expedited or single case periodic submission to a trading partner, must have an ICSR report scheduled as a part of the Periodic submission.

Click Modify to select a different Reporting Destination.


	Schedule these single-case Periodic Reports to the following Reporting Destination	Select a single-destination trading partner for Periodic Reports from the drop-down list box.
	Using the Message Type	Select the required message type from the drop-down list box









Select Summary Listing

The UD Summaries tab allows you to specify which summary listings will appear along with the line listing.


	Field	Description
	Include these summary tabulations/listings based on the set of cases presented in the line listing	Allows you to select from pre-configured summary tabulations/listings based on Case Data Analysis, Case listing or CIOMS II line listing reports. These tabulations are based only on the data included in the line listing. Select the Exclude Follow-up Cases checkbox to filter out follow-up cases from the attached report.
If the Exclude Follow-up Cases option is selected on the Inclusion criteria tab, this option is ignored and follow-up cases are always filtered out.


	Include these summary tabulations based on all cases	Allows for additional sub-reports based on the 'Case Data Analysis' template, to be included as an output for the all cases in the database that meet the CTPR inclusion criterion for all dates.
	Include these summary tabulations/listings based on the Date Range	This option allows for additional sub-reports based on Case Data Analysis, Case listing or CIOMS II line listing reports to be included as an output for the cases meeting the CTPR inclusion criterion for the Date Range specified when adding the sub-report.
The dates are based on either the Case Creation Date or the Initial Receipt Date as entered on the CTPR Inclusion Criteria tab. Check the checkbox to the right of the sub-report to ignore considering follow-up cases for the sub-report.












Schedule the Report

The Scheduling tab enables you to specify details of how often the periodic report will be scheduled.


	Field	Description
	Start Date	This is the International Birth Date for the PSUR product. This date is computed as the earliest Awarded date for any license of any type.
	Recalculate	Allows a user to recompute the International Birth Date of the PSUR Product. This date can be overwritten/manually entered, if needed.
	Report is due xx days after selected end date (creation or receipt date)	Enter the number of days when the report will be due after the end date specified for the scheduling period.
	Automatically generate report xx days before/after selected end date at xx:xx	Allows a user to specify the timing of the automatic report generation, by specifying the number of days before/after the selected end date of the report.
	Group	Allows the user to select the group to which the automatically generated report is to be assigned










Setup Frequency of the Scheduled Reports


	Field	Description
	Frequency	Allows a user to specify the interval required for this scheduling period.










Configure Security Level of the Report

The Security tab is used to configure the security level for the PSUR.


	Field	Description
	Share this Report with Other Users	Click this checkbox to share this report with other users. Specify the privileges to be granted to groups by adding the group name from the Users Groups list to either the Execute or Modify and Execute list. A user group can exist in only one of these access lists.
	User Groups	The groups listed here have no access to the PSUR report template. Click Add or Remove to move them to another access list.
	Execute	The groups listed here have read and execute access to the shared PSUR report template.
	Modify & Execute	The groups listed here have read, execute and modify access to the shared PSUR report template.







Use Report Templates

Refer to the Oracle Argus Dossier User Guide for a description of fields in the Templates tab.









Prepare Content for an ICH PSUR

The Periodic Safety Update Reports (PSURs) are created on a periodic basis to enable regulatory authorities to monitor the safety of a marketed product. This information is used to view new data about the product acquired from appropriate sources. It helps relate this data to the patient exposure and also indicates whether changes should be made to the product information in order to optimize the use of the product. Requirements on the due date of periodic reports may differ for different regulatory authorities.


Create Periodic Safety Update Reports (PSURs)

	
Select Reports > Periodic > ICH PSUR Reports. A list of PSUR Reports opens in the right frame.


	
Click Copy or Modify to create a new reports from an existing report.

OR

Click New Report to create an entirely new report.


	
When the system opens the ICH PSUR Line Listing Reports dialog box, enter an appropriate report name in the Report Name field.


	
Use the tabs to configure the PSUR.








Enter Common Fields Information

See Enter Common Fields Information.





Configure Subject in the Report Header

The Subject of Report tab is used to configure the report header and to specify the agency, products, etc. for which the PSUR will be applicable.


	Field	Description
	Primary Agency	Select the Primary Agency.
	Reporting Destination	Displays the list of agencies from where the report is being sent. Select an agency from the list displayed in Reporting Destination and click Add to add the report to the Selected Destination list.
You can select multiple agencies from the list of agencies such that the report can be submitted to multiple agencies at the same time.

Likewise, select a report from the Selected Destination list and click Remove to prevent it from being sent to the selected destination.


	Selected Destination	Displays the list of agencies where the report is being sent. Select an agency from the list displayed in Reporting Destination and click Add to add the report to the Selected Destination list.
You can select multiple agencies from the list of agencies such that the report can be submitted to multiple agencies at the same time.

Likewise, select a report from the Selected Destination list and click Remove to prevent it from being sent to the selected destination.


	Ingredient	Automatically displays the Ingredient as provided in the Subject of Report dialog box.
You can choose whether to view these field or not. Check the checkbox displayed with this field to hide or view it.


	Trade Name	Automatically displays the Trade Name(s) as provided in the Subject of Report dialog box. Multiple trade names are also displayed together, separated by commas.
You can choose whether to view this field or not. Check the checkbox displayed with this field to hide or view it.


	International Birth Date	Automatically displays the earliest license awarded date, when a user selects an Ingredient and a Product.
You can choose whether to view this field or not. Check the checkbox displayed with this field to hide or view it.


	Print all configuration criteria on separate cover page	Mark this box to print out the configuration of this report when the report is printed. This is only available when PDF option is selected during printing.
	Print page numbers on reports	When checked, this option enables the user to print page numbers on a periodic report. This is the default for all report configurations.
If this checkbox is not checked, the following occur.

	
The Include Periodic Page Numbering on CIOMS reports option on the PSUR Summary Tabulations CIOMS Reports section is grayed out and inactive.


	
The Use Periodic Numbering on the reports option in PSUR Summary Tabulations FDA PSUR section is grayed out and inactive.


	
The Additional Separate Page Numbering for UD Summaries in the PSUR UD Summaries tab is grayed out and inactive.


	
The system removes all existing report page numbering and the option to check page number checkboxes on the report configuration tabs are grayed out and inactive.





	Allow access to report cases through Hit List	When the report is run as final, it creates a Hit List, which can be retrieved from other areas of the application where advanced conditions can be selected. Click this checkbox to report cases through the Hit List.









Select Products to include in ICH PSUR


	Field	Description
	Available Ingredients	Displays the list containing the Ingredients used for the product configuration. Select an ingredient from the list displayed in Available Ingredients and click Add/Remove to add/remove the ingredient.
You can select multiple ingredients at a time.


	Indication	This list contains the Indication configured for the product containing the ingredients in the Available Ingredients section. The selections made from this list get displayed in the Available Products section.
You can select multiple Indications from the list at a time by pressing the CTRL key and clicking the different Indication entities.


	Formulation	This list contains the Formulation configured for the product containing the ingredients in the Available Ingredients section. The selections made from this list get displayed in the Selected Products section.
You can select multiple Indications from the list at a time by pressing the CTRL key and clicking the different Indication entities.


	Available Products	This list is automatically populated with the selections made in the Indication section.
	Selected Products	This list contains products selected by the user from the Available Products list. When a product is selected, the Trade Name field and International Birth Date fields are auto-populated with the license trade name (formulation, concentration) and earliest License Award Date for the product.









Select Inclusion Criteria

The Inclusion Criteria tab allows you to select search parameters for inclusion of cases in a periodic report. The top section of the dialog box allows you to specify the type of cases that are to be included in the periodic report.

Click Add to add a criterion. Select appropriate items from the list of items that appear.


	Field	Description
	Use Assessments in Cases	When selected, the PSUR Report will use the Case Event Assessment when performing datasheet listedness calculations.
	Re-assess cases against datasheet in effect at the beginning	When selected, the PSUR will re-assess the cases in the line listing based on the Active Datasheet on or before the Start Date of the Reporting period.
	Re-assess cases against datasheet in effect at end	When selected, the PSUR will re-assess the case in the line listing based on the Active Datasheets on or closest to the end date of the PSUR Reporting end date range without exceeding that date.
	Expeditable Only	This checkbox is available only when an agency is selected in the Subject of Report tab. If you check this checkbox, only the cases classified as submitted expedited reports to the specified agency are used.
	Exclude Follow-up Cases	Filters out follow-up Reports from the PSUR Line Listing Report.
	Include Unlocked Cases	Allows you to include unlocked cases in the periodic report.
	Advanced Condition	Allows you to specify an advanced condition that must be satisfied by each case that is included in the report. Ensure that the advanced condition or the advanced condition query set that is specified here does not contradict any other criteria specified in the dialog box.
	Use Datasheet Assessment for UDF Tabulations	Allows you to select datasheet for a report to make UDF tabulations.
If no datasheet is selected, the most conservative listedness is chosen, i.e. Unlisted followed by Listed.


	Add Cases not included in previous reporting period	Allows you to add cases which were not included in the previous reporting period.
You can enter the start date of the period in the Start Date field.


	Dropdown list	Select the appropriate report type from the drop-down list.
	Datasheet	This list allows you to specify which datasheet is to be checked to determine the listedness (listed or unlisted) of the case.
	Serious/Non-Serious	If you select Serious and clear Non-serious, only cases having a serious event are included and vice-versa. If you select both Serious and Non-Serious the seriousness criteria is ignored.
	Fatal/Non-Fatal	Select Fatal when at least one event has an event outcome of Fatal. If not, select Non-Fatal. If you select both Fatal and Non-Fatal, both types of cases are included.
	Listed/Unlisted	Select Listed to view only Listedness values. If you select both Listed and Unlisted, all Listedness values (including Unknown) are included.
	Related/Non-Related	Relatedness refers to the more conservative of reported or company causality. Select Related for any reportable causality type, and Non-Related for any non-reportable causality type.
	HCP/Non-HCP	HCP refers to cases that identify a Health Care Professional in the Reporter section within the General tab of the Case Form.
	Primary Reporter Only	This checkbox displays whether the Primary Reporter has been selected to determine the HCP status.









Include Line Listing


	Field	Description
	Include Line Listing	Allows you to select whether you want the Line Listing Data Elements printed with the PSUR Report.









Add Data Elements

	
Select the checkbox displayed against each data element to add it to the report.


	
The unavailable fields are printed on the report by default and cannot be changed.








View Selected Data Elements

This section lists the selected elements and enables you to arrange the order in which these are to be printed.


	Field	Description
	MedDRA Hierarchy from Cases/Dictionary	Select Cases to populate the data from the case data. Select Dictionary to populate the data from the MedDRA dictionary.
	Print Only the Term (Preferred Term or Lower Level Term)	Prints only the event Preferred Term (PT) or event Lower Level Term (LLT) as per the selected radio button. Select the PT option to print only the preferred term and not the verbatim description.
	Print Dose Text in place of regimen dose	Prints the dosage and frequency information from Dose Description field instead of Regimen Dose.
	Indicate if case was expedited previously	This checkbox is selected if an agency has been selected in the Subject of Report tab. Cases for which an expedited report was previously submitted to the selected authority are marked with an asterisk and the date of submission appears in the line listing.
Any case that has been previously expedited to a selected agency, is listed in the list of Agencies in the Subject of Reports tab.


	English Language	Provides the option to print the descriptions in English
	Local Language	Allows a user to specify which Local language for a multi-language field is to be printed i.e. the Abbreviated Narrative field.
	Print event info (Serious, Un-listed, Related) as Column	Check this checkbox to print the Seriousness, Listedness and Causality under the Event Verbatim column.
Events having listedness of 'Unknown' are considered 'Unlisted'. If only diagnoses are assessed for event assessment, the events which are associated with a Diagnosis but have been marked with Diagnosis as 'No' display '-' for both listedness and causality.


	List cases only once, under the primary event	Select this option to view the details of cases in the Main Line Listing only once under the Primary Event
	List cases under all events, details under the primary event	Select this option to view the details of cases in the Main Line Listing only once under the Primary Event, while non-primary events are listed under their respective event hierarchy with a reference to the primary event body system. Therefore, use this option when grouping on Main Line Listing is by the Event Body System.
	Print Product Indication for the Product selected in the Report	Enables you to print the product indication for the product selected in the report.









Group Cases


	Field	Description
	Available Groupings	Allows a user to group cases together from the given list. Select the desired groupings from the list and click Add to move the grouping to the Selected Groupings list.
	Selected Groupings	Lists the added groupings, and reports the groups in the order they were selected. Up to 5 grouping options can be selected from the Available Groupings list.
	Available Sortings	Allows a user to sort cases together from the given list. Select the desired sortings from the list and click Add to move the sorting to the Selected Sortings list.
	Selected Sortings	Allows a user to further sort cases without a total count for each sorted item. Up to 3 sorting options can be selected from the Available Sortings list. This list is populated with the Mandatory Line Listing entities plus any optional data elements chosen for this configuration.









Specify Summary Tabulations for Line Listing

The Summary Tabulations tab enables you to specify which summary tabulations/listings will appear along with the line listing.The system enables you to separate the cumulative summary by seriousness, relatedness, and listedness. If you choose this option, the system separates the product event detail into the following categories: Serious/Non-Serious, Related/Non-Related, and Unlisted/Listed events.


	Field	Description
	Include Index of Cases in PSUR	Create an index page of case numbers, for all cases included in the PSUR.
	Include Summary of Cases Missing Assessments	This option creates a sub-report of cases missing one of the following items:
	
Seriousness


	
Case Causality


	
Case Listedness


	
Case Outcome


	
Event Causality


	
Event Listedness




Click this checkbox to create one or both of the following sub reports:

Cases Missing Assessments - This sub-report displays cases that have been included in the PSUR line listing, but one or more of the following have not been assessed:

	
Case Seriousness


	
Case Causality


	
Case Listedness


	
Case Outcome


	
Event Causality


	
Event Listedness




Cases Not Included in Report - This sub-report displays cases that have not been included in the PSUR line listing as a result of missing one or more of the following items:

	
Lock Status


	
Safety Date


	
Uncoded Event


	
Causality





	Include Line Listing Tabulation	Check this checkbox to view a pre-defined summary tabulation of Report type, Seriousness and Listedness of all cases in the PSUR.
	Additional Expedited Report Forms (CIOMS/MedWatch/VAERS)	Allows you to print CIOMS/MedWatch/AERS forms (as per selection) for its respective regulatory agency (as selection), for all cases in the report. It also provides an option to have (or not have) a watermark in the forms.









Include CIOMS Reports


	Field	Description
	Print CIOMS reports for serious/unlisted cases	Allows a user to print CIOMS I forms for all Serious/Unlisted (Case Level) cases appearing in the PSUR.
CIOMS contain Internal or Other text printed on them when the PSUR is printed using the Internal or Other option.


	Include Periodic Numbering on the CIOMS reports	Numbers the requested CIOMS I with a periodic format. (i.e. A-1-1 of 2, A-1-2 of 2, A-2-1 of 1, A-3-1 of 1 etc.). The index is modified to also contain the Periodic paging of each CIOMS report.







Add PBRER Section 6.2 - Cumulative Summary Tabulations of SAEs from clinical trials


	Field	Description
	Include Section 6.2	Check this checkbox to include Section 6.2. By default, this is unchecked.
	Cumulative Start Date	Enter the cumulative start date in this field. This field users to specify the Start Date of the Cumulative date range. If not specified, the start date is picked from the date specified in the Inclusion Criteria. If specified, the application ensures that the date entered is a valid date, and is before the Start Date specified in the Inclusion Criteria.
	Identify Study Cases using Report Type	Allows you to select the study cases that use report type from the multi-select list box. The values that are populated here, come from the Report Type codelist where the values display the This type includes cases from clinical trials as checked.
	Group by Comparator	If the Product Type attribute is present in the Study Configuration for the Product being evaluated, this option is displayed. By default, this is unchecked. If this checkbox is selected, it displays sub columns based on Active Comparator names if Group by Comparator is selected. If Group by Comparator is not selected, the count is displayed under the name of the respective active comparator.









Add PBRER Section 6.3 - Cumulative and Interval Summary Tabulations from Post-Marketing Data Sources


	Field	Description
	Include Section 6.3	Check this checkbox to include Section 6.3. By default, this is unchecked.
	Cumulative Start Date	Enter the cumulative start date in this field. This field users to specify the Start Date of the Cumulative date range. If not specified, the start date is picked from the date specified in the Inclusion Criteria. If specified, the application ensures that the date entered is a valid date, and is before the Start Date specified in the Inclusion Criteria.
	Identify Spontaneous Cases using Report Type	Allows you to select the study cases that use report type from the multi-select list box. The values that are populated here, come from the Report Type codelist where the values display the This type includes cases from clinical trials as NOT checked. Only those values are included, where Display is set to Yes, in order to be consistent with the Report.
	Identify Non-interventional Studies (UNION of rules below)	This is a mandatory field, comprising three new rules to identify Non-Interventional Studies: (Case Classification, Report Type, and Observe Study Type). These three new rules are displayed as checkboxes and have a section label called Identify Non-interventional Studies (UNION of the rules below).
This field is mandatory, which means that at least one of the options must be selected if Include Section 6.3 is selected.

Along with the three options, there is a multi-select list box for each that is populated with values from the respective codelist (given below) for the corresponding option that the user selected:

a. Case Classification is populated with values from Case Classification codelist.

b. Report Type is populated with values from Report Type codelist

c. Observe Study Type is populated with values from Case Classification codelist with ICSR code values that are not-null

All values are included in this list, irrespective of the Display field for Case Classification and Observe Study Type codelists. Those values where Display for Report Type codelist is set to Yes, are also included.

A + sign is displayed as a label, next to these options to indicate that it is a UNION of selections.













Add Cumulative Summary


	Field	Description
	Include Cumulative Summary	Select the checkbox to create a sub-report count of events, grouped by Product and Body System (SOC) and sorted by Preferred Term. The sub-report contains a previous date range count of events (comparative date range), a current date range count (current PSUR date range) and a cumulative count (all dates) of events assessed against the product(s) of the PSUR and matching the inclusion criteria.
	Comparative Date Range	Allows a user to specify the previous date range as a comparison date for the events counted, and therefore should not overlap with the current date range specified on the PSUR inclusion criteria tab.









Add FDA PSUR Support Information


	Field	Description
	FDA PSUR Support Section
This section can be used if the company has obtained an FDA waiver to submit a PSUR instead of an NDA report.


	Include Adverse Event Summary	Select this option to generate a sub-report of events from the line listing. This sub report is grouped by Body System and Preferred Term.
	Causality	Select the desired causality from the list.
Ignore - Counts events regardless of causality assessment.

Causal - Counts events where the causality is considered reportable in the Causality Category configuration in List Maintenance.

Not Causal - Counts events where the causality is considered non-reportable in the Causality Category configuration in List Maintenance.

As Determined - Counts events where 'As Determined' causality meets the above selected causality criteria.

As Reported - Counts events where 'As Reported' causality meets the above selected causality criteria.

Both - Counts events where both 'As Reported' and 'As Determined' causality meet the above causality criteria.

Either - Counts events where either the 'As Reported' or 'As Determined' causality meets the causality criteria.


	Only Cases with HCP Reporter	Check this checkbox to include events for only those cases that feature an HCP reporter
	Diagnosis	Select this option to ensure that only events marked as diagnosis are counted.
	Diagnosis & Symptoms	Select this option to ensure that all events are counted in the sub-report.
	Separate Diagnosis & Symptoms	Select this option to include diagnosis and symptoms separately in the sub-report. Selecting this option means that the case numbers are separated by Diagnosis and Symptoms respectively.
	Domestic Consumer Support	Select this option to enable domestic consumer support.
	Print Unsubmitted	This option allows a user to print MedWatch or VAERS forms for U.S. cases
	Exclude Reports that are Non-Serious and Listed	Allows a user to suppress MedWatch or VAERS forms from printing for Non-Serious listed cases where all events are non-serious and listed for the datasheet specified.
	Use Periodic numbering on the Reports	Numbers the requested forms with a periodic format. (i.e. Periodic Page 1 - 1, Periodic Page 1 - 2, Periodic Page 2 - 1, Periodic Page 2 - 2, etc.) An index with the Case Number is also included.









Generate Single Case Submission Report


	Field	Description
	Single Case Submission Support Section
	Generate Periodic ICSR Submissions for any cases in this Periodic Report that does not have at least one scheduled single-case report during the reporting period to the following Reporting Destination(s): Modify	Check this checkbox to generate the ICSR Reports only for the cases, where a Periodic ICSR Report for the message type chosen, does not exist.
Select one or more trading partners from the list box.

Important: Any case that does not have an expedited or single case periodic submission to a trading partner, must have an ICSR report scheduled as a part of the Periodic submission.

Click Modify to select a different Reporting Destination.


	Schedule these single-case Periodic Reports to the following Reporting Destination	Select a single-destination trading partner for Periodic Reports from the drop-down list box.
	Using the Message Type	Select the required message type from the drop-down list box









Select Summary Listing

The UD Summaries tab allows you to specify which summary listings will appear along with the line listing.


	Field	Description
	Include these summary tabulations/listings based on the set of cases presented in the line listing	Allows you to select from pre-configured summary tabulations/listings. These tabulations are based only on the data included in the line listing. Selecting the Exclude Follow-up Cases checkbox filters out follow-up cases from the attached report.
If the Exclude Follow-up Cases option is selected on the Inclusion criteria tab, this option is ignored and follow-up cases are always filtered out.


	Include these summary tabulations based on all cases	Allows for additional sub-reports based on the 'Case Data Analysis' template, to be included as an output for the all cases in the database that meet the PSUR inclusion criterion for all dates.
	Include these summary tabulations/listings based on the Date Range	This option allows for additional sub-reports based on Case Data Analysis, Case listing or CIOMS II line listing reports to be included as an output for the cases meeting the PSUR inclusion criterion for the Date Range specified when adding the sub-report.
The dates are based on either the Case Creation Date or the Initial Receipt Date as entered on the PSUR Inclusion Criteria tab. Check the checkbox to the right of the sub-report to ignore considering follow-up cases for the sub-report.


	Identify SUSAR and Special Interest Events	Enables you to identify any SUSAR and special interest events.
	Additional Separate Page Numbering for Summaries	Enables you to include additional separate page numbering for summaries.










Schedule the Report

See Schedule the Report.





Setup Frequency of the Scheduled Reports

See Setup Frequency of the Scheduled Reports.






Configure Security Level of the Report

See Configure Security Level of the Report.


Use Report Templates

Refer to the Oracle Argus Dossier User Guide for a description of fields in the Templates tab.









Prepare Content for a US IND Periodic Report

The system enables you to define an IND summary report. You can add a new report as well as copy, modify and delete existing reports.


Create New IND Report

	
Select Reports > IND Reports to open IND Subject of Report view.


	
Click New Report.

OR

Select an existing report from the list and click Copy or Modify.


	
When you click New Report, the IND Line Listing Reports dialog box opens.


	
Enter an appropriate name for the report under Report Name.


	
Use the tabs in this dialog box to configure the IND Report.


	
From each tab in the IND Summary Report, you can choose to Print all configuration criteria on separate cover pages (PDF Only).








Enter Common Fields Information

See Enter Common Fields Information.





Configure Subject in the Report Header

The Subject of Report tab is used to configure the report header and to specify the agency, products, and other elements. Select multiple ingredients for a configured IND Report to view the multiple licenses to be selected for the report.


	Field	Description
	Primary Agency	Select the Primary Agency.
	Available Reporting Destinations	Displays the list of configured Regulatory Agencies. Select an agency from the list displayed in Reporting Destination and click Add to add the report to the Selected Destination list.
Select multiple agencies by holding the CTRL key when you click them.


	Selected Reporting Destinations	Displays the list of agencies where the report is being sent. Select an agency from the list displayed in Reporting Destination and click Add to add the report to the Selected Destination list.
Select multiple agencies by holding the CTRL key when you click them.

Likewise, select an agency from the Selected Destination list and click Remove to prevent it from being sent to the selected destination.


	Company Name	If a regulatory agency is selected in the Subject of Report tab, then the company name associated with the regulatory agency (this association is created by the Administrator) is automatically entered in this field.
	Product Name	This field is automatically filled as per the Ingredient field.
Check the checkbox corresponding to this field to choose whether you want this field to appear on the report.


	Approval	This field is automatically filled with License numbers, separated by commas. This is an editable field.
	Award Date	This field is populated with the earliest awarded Investigational License for US amongst the licenses selected. This field cannot be edited.
Check the checkbox corresponding to this field to choose whether you want this field to appear on the report.


	Print all configuration criteria on separate cover page	Click this checkbox to print out the configuration of this report when the report is printed. This is only available when the PDF option is selected during printing.
	Print page numbers on reports	When checked, this option enables the user to print page numbers on a periodic report. This is the default for all report configurations.
If this checkbox is not checked, the following occur.

	
The Additional Separate Page Numbering for UD Summaries option on the IND Summaries Tabulation tab is grayed out and inactive.


	
The system removes all existing report page numbering.





	Allow access to report cases through Hit List	When the report is run as final, it creates a Hit List, which can be retrieved from other areas of the application where advanced conditions can be selected. Click this checkbox to report cases through the Hit List.









Select Products to Generate the Report

Use the Product Selection tab to select product information to include in the report.


	Field	Description
	Available Ingredients	Displays the list containing the Ingredients used for the product configuration. Select an ingredient from the list displayed in Available Ingredients and click Add/Remove to add/remove the ingredient.
You can select multiple ingredients at a time.


	Filter	Enter an Ingredient name and click Filter to search for the entered ingredient within the Available list of Ingredients.
	Selected Ingredients	Displays the list of ingredients selected from the Available Ingredients list.
	Indication	This list contains a list of all the indications for the products containing the selected ingredient. The selections made from this list are displayed in the Available Products section.
You can select multiple Indications from the list at a time by pressing the CTRL key and clicking the different Indication entities.


	Formulation	This list contains the Formulations configured for the product containing the selected ingredient and indication. The selections made from this list get displayed in the Selected Products section.
You can select multiple Formulations from the list at a time by pressing the CTRL key and clicking the different Indication entities.


	Available Licenses	This list is automatically populated with the licenses from the Indication section.
	Selected Licenses	This list contains licenses selected by the user from the Available Licenses list. When a product is selected, the Trade Name and International Birth Date fields are auto-populated with the license trade name (formulation, concentration) and earliest License Award Date for the product.









Select Inclusion Criteria

The Inclusion Criteria tab allows you to select search parameters for inclusion of cases in a periodic report.


	Field	Description
	Case Creation Date	Allows you to specify a range of cases by the date when the case was created.
	Case Receipt Date	Allows you to specify a range of cases by the initial receipt date.
	Use Current Version	Allows you to use the latest revision to populate the data within the selected reports.
	Use DLP Version	Allows you to use the case data of the version as of the specified DLP Version.
	Age Groups	Allows you to include or exclude cases based on the patient's age group. Select the Age Groups checkbox to activate the age groups and select all the age group categories that apply.
	Options - Domestic/Foreign Cases	This option allows the user to include domestic and foreign cases within the periodic report. Select Domestic if Country of Incidence is USA and Foreign if Country of Incidence is not USA.
	Expeditable Only	This checkbox is available only when an agency is selected in the Subject of Report tab. If you check this checkbox, only the cases classified as submitted expedited reports to the primary agency are used.
	Include Unlocked Cases	Allows you to include unlocked cases in the periodic report.
	Advanced Condition	Allows you to specify an advanced condition that must be satisfied by each case that is included in the report. Ensure that the advanced condition or the advanced condition query set that is specified here does not contradict any other criteria specified in the dialog box.









Include Line Listing


	Field	Description
	Report All Events	Select this option to report all events.
	Report only Diagnosis Events	Select this option to report only diagnosis events (only the diagnosis events that are either explicitly marked as diagnosis or are non-related symptoms).
	List cases only once, under the primary event	Select this option to view the details of cases in the Main Line Listing only once under the Primary Event
	List cases under all events, details under the primary event	Select this option to view the details of cases in the Main Line Listing only once under the Primary Event, while non-primary events are listed under their respective event hierarchy with a reference to the primary event body system. Therefore, use this option when grouping on Main Line Listing is by the Event Body System.
	Create a Sub Report for Death Cases	Check this checkbox to separate death cases from the main IND listing. If the checkbox is checked, all death cases (Identified by any event marked as death in Seriousness Criteria or any event having a Event Outcome as Death) are filtered out from the IND Line Listing. All death case show up in a sub report, called IND Line Listing (Death Cases).









Specify Summary Tabulations for Line Listing

The Summary Tabulations tab enables you to specify which summary tabulations will appear along with the line listing.


	Field	Description
	Include these summary tabulations/listings based on the set of cases presented in the line listing	Allows you to select from pre-configured summary tabulations/listings. These tabulations are based only on the data included in the line listing. Select the Exclude Follow-up Cases checkbox to filter out follow-up cases from the attached report.
If the Exclude Follow-up Cases option is selected on the Inclusion criteria tab, this option is ignored and follow-up cases are always filtered out.


	Include these summary tabulations based on all cases	Allows for additional sub-reports based on the 'Case Data Analysis' template, to be included as an output for the all cases in the database that meet the IND Report inclusion criterion for all dates.
	Add	Displays a list of memorized Case Data Analysis Reports that have been marked for availability in a periodic report.
	Remove	Click this button to remove a selected report.
	Additional Separate Page Numbering for Summaries	Enables you to include additional separate page numbering for summaries.
	Include Summary of Unlocked Cases	Enables you to print the list of Case Numbers that are included in the Periodic Reports but are not locked.









Schedule the Report

See Schedule the Report.





Configure Security Level of the Report

See Configure Security Level of the Report.







Prepare Content for an NDA Periodic Report

The NDA Periodic Reports enable you to define an NDA Periodic report. You can add a new report as well as copy, modify and delete existing reports.

	
You can print an Index of Cases included in the NDA report.


	
If you select this option, the system lists the cases from the following sections once at the end of the configuration pages:

	
Sequential List of cases


	
Serious Listed Initial/Follow up


	
Non Serious Listed Initial/Follow up


	
Non Serious Unlisted Initial/Follow up


	
15 Day Submission





	
The page numbering for this sub-report continues from the configuration pages.


	
You can separate initial case events from follow-up case events in the Summary Tabulation tab of the NDA Report.

	
If you select this option, the system counts events in the Initial section if the case is in the Serious Listed, Non-Serious Listed, or Non-Serious Listed/Unlisted sections.


	
If you select this option, the system counts events in the Follow-up section if the case is in the Serious Listed or Non-Serious Listed/Unlisted follow-up sections of the NDA report.


	
For the 15 Day events, if the case has not been previously reported in a NDA, the system counts it in the Initial section then the Follow-up section.


	
If you select List cases once under the Primary Event System Organ Class (SOC), the system displays a footnote with an asterisk ( * ) printed across all the System Organ Classes on the report and the following statement: Primary Event System Organ Class.





	
If you select the Print FDA-3500A/VAERS form at the end option, the system prints the report sections in the following order:


	
Configuration (Including Case Indices (e.g. Sequential Case Listing, Listing by Seriousness/Listedness, Listing of Cases Missing Analysis)

	
Line Listing


	
Summary Tabulations


	
MedWatch/VAERS reports at the end of the report





	
Page numbering for the MedWatch reports continue from the last page of the NDA report.


	
The configuration pages have been updated to reflect the updates made to the NDA Reports


	
The configuration pages are printed at the beginning of the NDA report.


	
By default, these are unchecked on all the existing configured reports.





Create NDA Summary Report

	
Select Reports > Periodic Reports > NDA Reports to open the NDA Subject of Report view.


	
Click New Report to create an entirely new report,

OR

Select an existing report from the list and click Copy or Modify.


	
When you click New Report, the NDA Line Listing Reports dialog box opens.


	
Enter an appropriate report name in the Report Name field


	
Use the tabs in this dialog box to configure the NDA Report.


	
From each tab in the NDA Report, you can choose to Print all configuration criteria on separate cover pages (PDF Only).








Enter Common Fields Information

See Enter Common Fields Information.





Configure Subject in the Report Header

On the Subject of Report tab you can select multiple Ingredients for a configured NDA Report per allowable variations of product and license configuration and periodic reporting requirements for the FDA. Select multiple ingredients to view the multiple licenses to be selected for the report.


	Field	Description
	Available Reporting Destinations	Displays the list of configured Regulatory Agencies. Select an agency from the list displayed in Reporting Destination and click Add to add the report to the Selected Destination list.
Select multiple agencies by holding the CTRL key when you click them.


	Selected Reporting Destinations	Displays the list of agencies where the report is being sent. Select an agency from the list displayed in Reporting Destination and click Add to add the report to the Selected Destination list.
Select multiple agencies by holding the CTRL key when you click them.

Likewise, select an agency from the Selected Destination list and click Remove to prevent it from being sent to the selected destination.


	Company Name	If a regulatory agency is selected, the company name associated with the regulatory agency (this association is created by the Administrator) is automatically entered in this field.
	Ingredient	This field is populated with ingredient selected in the Subject of Report tab.
Check the checkbox corresponding to this field to choose whether you want this field to appear on the report.


	Approval	This field is automatically filled with License numbers, separated by commas. This is an editable field.
	Trade Name	Automatically displays the Trade Name.
Multiple trade names are also populated from license trade name (formulation, concentration) of selected licenses, separated by commas.

Check the checkbox corresponding to this field to choose whether you want this field to appear on the report.


	Award Date	Automatically displays the earliest license awarded date, when a user selects an Ingredient and a Product.
Check the checkbox corresponding to this field to choose whether you want this field to appear on the report.


	Print all configuration criteria on separate cover page	Click this checkbox to print out the configuration of this report when the report is printed. This is only available when the PDF option is selected during printing.
	Print page numbers on reports	When checked, this option enables the user to print page numbers on a periodic report. This is the default for all report configurations.
If this checkbox is not checked, the following occur.

	
The Use Periodic Numbering on the reports option in the NDA Line Listing tab is grayed out and inactive


	
The Additional Separate Page Numbering for UD Summaries in the NDA Summary Tabulations tab is grayed out and inactive.


	
The system removes all existing report page numbering and the option to check page number checkboxes on the report configuration tabs are grayed out and inactive.





	Allow access to report cases through Hit List	When the report is run as final, it creates a Hit List, which can be retrieved from other areas of the application where advanced conditions can be selected. Click this checkbox to report cases through the Hit List.









Select Products to Generate the Report

The Product Selection tab enables you to select product information to include on the report.


	Field	Description
	Available Ingredients	Displays the list containing the Ingredients used for the product configuration. Select an ingredient from the list displayed in Available Ingredients and click Add/Remove to add/remove the ingredient.
You can select multiple ingredients at a time.


	Filter	Enter an Ingredient name and click Filter to search for the entered ingredient within the Available list of Ingredients.
	Selected Ingredients	Displays the list of ingredients selected from the Available Ingredients list.
	Indication	This list contains a list of all the indications for the products containing the selected ingredient. The selections made from this list are displayed in the Available Products section.
You can select multiple Indications from the list at a time by pressing the CTRL key and clicking the different Indication entities.


	Formulation	This list contains the Formulations configured for the product containing the selected ingredient and indication. The selections made from this list get displayed in the Selected Products section.
You can select multiple Formulations from the list at a time by pressing the CTRL key and clicking the different Indication entities.


	Available Licenses	This list is automatically populated with the licenses from the Indication section.
	Selected Licenses	This list contains licenses selected by the user from the Available Licenses list. When a product is selected, the Trade Name and Award Date fields are auto-populated with the license trade name (formulation, concentration) and earliest License Award Date for the product.









Select Inclusion Criteria


	Field	Description
	Case Creation Date	Allows you to specify a range of cases by the date when the case was created.
	Case Receipt Date	Allows you to specify a range of cases by the initial receipt date.
	Use Current Version	Allows you to use the latest revision to populate the data within the selected reports.
	Use DLP Version	Allows you to use the case data of the version as of the specified DLP Version.
	Age Groups	Allows you to include or exclude cases based on the patient's age group. Select the Age Groups checkbox to activate the age groups and select all the age group categories that apply.
	Option (Applicable to Non-15-Day Selection Only)- Domestic/Foreign Cases	This option allows the user to include domestic and foreign cases within the periodic report. Select Domestic if Country of Incidence is USA and Foreign if Country of Incidence is not USA.
	Option (Applicable to Non-15-Day Selection Only)-
Exclude Literature Cases/Study Cases

	This option allows the user to exclude Literature and Study Cases from being considered for the NDA Report. Select Exclude Literature Cases to exclude literature cases and select Exclude Study Cases to exclude study cases.
	Advanced Condition	Allows you to specify an advanced condition that must be satisfied by each case that is included in the report. Ensure that the advanced condition or the advanced condition query set that is specified here does not contradict any other criteria specified in the dialog box.
	Add Cases not Included in a previous reporting period Start Date	Enter the start date. This adds cases not included in a previous reporting period with the specified start date.
	Include Unlocked Cases	Allows you to include unlocked cases in the periodic report.
	Evaluate Primary Suspect Drug Only	Allows you to select only the Primary Suspect Drug.









Include Line Listing

The NDA report comprises of three tabs. The options for these tabs can be configured in the Line Listing tab.


	Field	Description
	Tab 1: FDA - 3500/VAERS Forms	Check this checkbox to generate the MedWatch 3500A (Drug) or VAERS reports which are serious listed or non-serious
	Suppress printing of non-serious listed reports	Check this checkbox to prevent printing the non-serious listed reports but print their case numbers in the main NDA report indices
Tab 1 of the NDA Line Listing report cannot be generated without Tab 2. However, Tab 2 can be generated without Tab 1


	Tab 2: Index of Submitted Forms in Tab 1	Check this checkbox to generate an index of the forms from Tab 1 It prints all MedWatch/VAERS forms for the following cases:
	
Serious Listed


	
Non-Serious Unlisted


	
Non-Serious Listed




Previously expedited 15-day reports that are Serious and Unlisted that have already been submitted to the FDA do not need to be re-submitted with this periodic report


	Tab 3 Part 1: NDA Line Listing of 15 Day Reports Submitted	Check this checkbox to generate a list of all serious unlisted expedited reports within the specified time period.
The dates in these reports are in GMT.


	TAB 3 Part 2: Tabulation by System Organ Class (SOC) of All Event Reports Submitted	Check this checkbox to generate a tabulation by System Organ Class (SOC) of all events reported during the specified time period. This includes the cases for which expedited reports were previously generated, as well as the cases that are submitted as part of the current report
	TAB 3 Part 3: Cases sent to FDA under another NDA	Check this checkbox to print a list of all the serious unlisted events for which reports were submitted to the FDA previously
Note: If you select to print out the Tab 3 Part 3 section, the NDA report looks for other submissions (E2B, MW, MW Drug, VAERS, eVAERS, eMDR) to the same agency for the same case against other (not included in selection criteria for this report) marketed licenses. Any submission matching this criterion is listed on the Tab 3 Part 3 section of the NDA report. If there are multiple submissions against different licenses, then each one is listed. Each license is listed only once


	Include Periodic Submissions	Check this checkbox to include all cases that have been sent under another NDA
	Start Page Number	Select the page number for the first page of the report
	Listing Options	These options for List cases only once, under the primary event body system and List cases under all events body systems only apply to the NDA Line Listing of Expedited Reports Submitted report
	List cases only once, under the primary event System Organ Class	Select this option to list cases only once
	List cases under all events System Organ Classes	Select this option to list cases under each SOC for each event
	Include Summary of Cases Missing Assessments	Check this checkbox to include a Summary of Cases missing Assessments at the end of the report
	Include Summary of Unlocked Cases	Select this option to include a summary of unlocked cases
	Include Listing of Nullified 15-day Alert Cases Submitted During the Reporting Period	Any case that was deleted which has submitted report within the reporting period after an expedited submission was made to the FDA (primary agency) for the license specified in the NDA Periodic report, regardless of the report form used, e.g., it could be MedWatch or Expedited E2B (E2Bs with MESSAGETYPE tag value configured as Expedited in Message Type Code List) or eVAERS.
	Use Periodic numbering on the Reports	Select this option to use periodic numbering on reports
	Custom Case Summary Tabulation	Enter the Summary Report Title
	Advanced Condition	Select the Advanced Condition from the drop-down list









Specify Summary Tabulations for Line Listing

The Summary Tabulations tab allows you to specify which summary tabulations will appear along with the line listing.


	Field	Description
	Include these summary tabulations/listings based on the set of cases presented in the line listing	Allows you to select from pre-configured summary tabulations/listings. These tabulations are based only on the data included in the line listing. Select the Exclude Follow-up Cases checkbox to filter out follow-up cases from the attached report.
Note: If the Exclude Follow-up Cases option is selected on the Inclusion criteria tab, this option is ignored and follow-up cases are always filtered out.


	Include these summary tabulations based on all cases	Allows for additional sub-reports based on the 'Case Data Analysis' template, to be included as an output for the all cases in the database that meet the NDA Report inclusion criterion for all dates.
	Add	Displays a list of memorized Case Data Analysis Reports that have been marked for availability in a periodic report.
	Remove	Click this button to remove a selected report.
	Additional Separate Page Numbering for Summaries	Enables you to include additional separate page numbering for summaries.
	Case Count Summary Report	Enables you to print the list of Case Numbers that are included in the Periodic Reports but are not locked.









Schedule the Report

See Schedule the Report.





Configure Security Level of the Report

See Configure Security Level of the Report.









View Scheduled Periodic Report Information


Available User Options

Common features on the Period Reports page. Click the icon associated with each report to view the following options:


	Option	Description
	Description	Displays the report name. Click this to open the selected report in PDF format.
	Status	Opens the Report Details dialog box for the selected report.
	Print List	Allows the user to print the current Periodic Reporting for referencing the current view of the Periodic Reporting.
	View Report	Opens the Individual Periodic Report selected by the user.
	Report Details	Displays specific information about the report as entered in the Regulatory Reports section.
The information displayed in the fields of the Report Details dialog box is fetched from the data entered in the Regulatory Reports section of Case Form.











View Report Details

The Report Details > General tab displays the general information about the report. The information on this tab cannot be modified.


	Field	Description
	Agency	Displays the Reporting Destination for which the report is scheduled.
	Responsibility	Displays the User Group to which the report is assigned.
	Case Nullification Date	Displays the date when the case was nullified.
	Case Nullification Reason	Displays the reason entered when a case is logically deleted in Argus.









View Report Schedule Details

The Scheduling tab displays a reason for scheduling this report. It also shows the date on which the report was scheduled.

All fields in this tab are auto-populated as per records entered in Argus.





View Report Routing History

The Routing tab displays the routing history of the report. To route the report, click Route.


	Field	Description
	Group	Displays the group of the report. This button is enabled when you click the Route button.
	User	Displays the state of the report. This button is enabled when you click the Route button.
	Comments	Displays routing comments entered before routing the report.











Submit a Periodic Report


Specify Submission Details

The Submission tab enables you to specify whether submission is required and enter a reason for not submitting the report.


	Field	Description
	Submission Required	Enables you to select if this report is not required to be submitted to the regulatory authority.
	Reason for Non-Submission	Click Select to select the reason for non-submission.









Add Comments

The Comment tab enables you to enter a local comment that prints out on that specific report when generated. Each report has its own Local Comment section.





Transmit a Report

	
Click the icon associated with a report and select the Transmission tab from Report Details.


	
When the system opens the Report Details The Report Details dialog box opens.


	
Click OK or Cancel to approve the transmission or discard any changes, respectively.


	
Click the Transmit button to transmit a report. The Transmit to Recipients dialog box is displayed.


	
Select the recipients of the report, as applicable from the Available Recipients list.


	
Select the method of transmission from Method, as applicable.


	
Enter remarks in Comments.


	
Click Transmit.


	
The selected report is transmitted to the specified recipients.








View Report Generation Status

The Report Generation Status tab is displayed for users who have been configured by the Argus Safety administrator in Argus Console, under Access Management > Groups > Menu > Reports > Periodic Reports and for users who have access to the System Library.

[image: Surrounding text describes prdtbt.gif.]


	Field	Description
	Run At Date	Displays the date and time when the report generation started.
For English users, it is displayed in DD-MMM-YYYY HH:MM:SS (GMT offset) format.

For Japanese users, it is displayed in YYYY/MM/DD 00:00 (GMT offset) format


	Status	Displays the current status of report generation in the form of hyperlinks, with the options listed below:
	
Executing


	
Error


	
Pending


	
Generated




On clicking the Generated status, the Periodic Report is displayed.

On selecting any status other than Generated, the Background Periodic Report Execution Status dialog box is displayed, as shown below:

[image: Surrounding text describes bpres.jpg.]
This dialog box displays the different stages of Periodic Report status. A grey tick mark is denotes Pending state, a Green tick mark denotes Completed State, and a Red cross mark denotes an Error.


	Context Menu > View Report	This option is displayed in the context menu only when PDF/CSV/RTF Report Creation is Generated. On clicking View Report, the selected report is displayed. Applicable only for Periodic reports.






The Report Status screen displays the report outputs for the logged in user with the last report run as the first report. The reports can be filtered using:

	
Report Name


	
Draft/Final


	
Report Type


	
Scheduled By


	
Scheduled On


	
Run At Date


	
Status








Create Unscheduled Periodic Reports

	
Click Reports > Compliance > Periodic > Create Unscheduled Report.


	
The system opens Periodic Reports dialog box that provides a list of configured reports of the following types:

	
PSUR - Containing ICH PSUR Line Listing Reports


	
IND - Containing US IND Periodic Reports


	
NDA - Containing US NDA Periodic Reports


	
CTPR - Containing CT Periodic Reports





	
Click the (+) icon against the desired category to view all the reports within that category.


	
Select the report you wish to create from this list and click Select.


	
When the system opens the Report Batch Printing dialog box, select Run Now or Run at, as appropriate.




	
Note:

If you select Run Now, specify PDF, RTF, or CSV from the drop-down list for the report output option to generate the PSUR or CTPR report in the selected format.
If you select Run at, specify the date/time to schedule the PSUR report to be generated by Argus Safety Service. This enables only Final and disables all other Print As options.










	
In the Email field, enter the email ID of the user to whom the periodic report should be emailed, once completed. By default, this field lists the email address (if configured) of the current user.


	
Select what you want printed on the report: Final, Draft, Internal, or enter Other information.


	
Run Using allows users to select between Argus Native Periodic report and BI Publisher.


	
Report Form Type allows users to select the Report Templates and these options are dependent on the value selected in Run Using. If Run Using is selected as Argus Native, the Report Form Type drop-down list displays PBRER and PSUR. The option selected from this drop-down list is used as Report Form Type for follow-up algorithm.


	
The options displayed in the Report Form Type are configurable through the flexible codelist Report Template.


	
Click OK.


	
The system generates the periodic report.








Approve and Submit a Report

Before you can mark a report as submitted, the report must first be approved.

	
Open the case for which the report has to be approved.


	
Open the Regulatory Reports tab in the Case Form.


	
When the system opens the Regulatory Reports details for the selected case, click the icon associated with the report you wish to approve.


	
Select View Report Details.




	
Note:

The Case Nullification Date is the date when the case is deleted, the Case Nullification Reason is the comment entered when the case is logically deleted in Argus.








	
Select Submitted from the State list in the Routing tab and click Route.


	
When the system opens a dialog box, enter the required details and click OK.


	
The report is approved.







	
Note:

A user who has Workflow Manager rights can undo the submission of a report, if necessary.











View Submitted Reports

	
Select the Reports > Compliance > Submitted Reports.


	
When the system opens the Submitted Reports page, enter the appropriate search criteria and click Search.


	
The system displays the Search Results.





Submitted Reports—Fields and Field Descriptions


	Field	Description
	Case ID	Enter the specific case number.
Tip: Use wild cards such as 2007% to search for cases starting with 2007.


	Include these Reports	Select the required report type or case status to be displayed.
	Product	Select the product as required. The reports scheduled for these products will be displayed.










Use Bulk Report

Bulk Reporting enables you to print, transmit or submit reports in bulk.

	
Select Reports > Bulk Reporting to view the Bulk Report screen.


	
The system displays the screen.





Filter Bulk Reports

The Bulk Reporting Filter sections enables you to filter reports.


	Field	Description
	Destination	
	To filter reports by agency, select an Agency.
The agencies that have reports in the Scheduled, Approved and Generated states are displayed.


	
Click Filter to select multiple agencies from the Reporting Destinations dialog box.

The previous filtering criteria is saved and retained when the user invokes this dialog box. By default, all agencies are displayed.





	Report Status	From the drop-down list, select one of the options:
	
Generated Only—Displays the reports that have been generated (Generated, Approved, Disapproved and New Data Available states)


	
Scheduled/Generated—Retains the existing behavior as it does today when this value is selected


	
Pending


	
Failed


	
Printed/Transmitted




Note that to display Generated Only or both Scheduled and Generated reports, configure the common profile switch "Allows Bulk Reporting screen to show Generated Reports Only" as follows:

	
For Generated Only reports, set the profile switch as "Bulk Reporting will allow filtering on generated reports only".


	
For Scheduled/Generated reports, set the profile switch as "Bulk Reporting will allow filtering on both scheduled and generated reports".





	Report Status	Choose either Scheduled/Generated, Pending, Failed, or Printed/Transmitted from the drop-down list.
	Print Regulatory Report	Prints the report as Draft or Final. The Draft option is disabled when the printing option is set to Transmit.
Select Medical Summary to view the list of only medical summaries of distinct cases in a PDF.


	Approved Reports Only	Filters reports for only approved reports.
	View All	Displays the bulk reports applicable to your filter selections.
	Product Family	Enter a Product family to view all cases where the scheduled reports belong to the searched Product family.
	Study ID	Filters reports on the basis of the Study ID.
	Product Group	Filters reports on the basis of the Product Group. If a value is selected in the Product Group filter, the Product Family drop-down list's values automatically narrow down to the product families which belong to the selected Product Group filter.
	Specific Case #	To search a case, enter the Case Number, and click Retrieve.









View Bulk Report Filter Results

The filter search results appears in the Total Number of Rows section.


	Field	Description
	Suspect Product	Displays the Trade Name for which the report has been scheduled. If more than one Suspect Company Product exists for the case, an (+) is placed at the end of the product name.
For Reports which were scheduled for the Device, the Device name is displayed.


	Diagnosis	Displays the Primary Event Diagnoses PT
	(Event Verbatim)	Displays the (Verbatim as reported) of the Primary Event.
	S/U/R	
	Displays the Case Level Assessments:
- Serious (Y/N)

- Unlisted (Y/N)

- Causality (Y/N)


	
Unknown is treated as a "?"


	
The SUR link displays the Case Summary for the selected case.





	F or LT	Fatal / Life Threatening
	
If any of the events in the case are Fatal or Life Threatening F or LT is displayed.


	
If the case is both F and LT, only F is displayed.


	
If the case is neither F nor LT, only No is displayed.





	7/15	Number of days for which the report is due.
	
7—if the report is within 7 days


	
15—if the report is due for more than 7 days





	Blind Study Product	Transmits and prints study cases with blinded information.
	Mark as Submitted	
	Select this option to mark reports as Submitted when the transmission or e-mail has been sent.
A confirmation dialog box appears if this option is not selected.


	
Select Yes or No.

This selection is remembered for the next time when you print a report.





	Report Form	1. Displays the Description of the report
2. Click the Report form link to view the DRAFT Report as a PDF.


	Destination	Displays the report destination (agency) for which the report is scheduled.
	Downgrade	Allows the user to view if the report is downgrade.
Displays Yes if the report is a downgrade report else.


	View All	Allows administrator and workflow manager to see all items in the system.









	
Tip:

The icon (displayed in the lock state) in the Reports > Bulk Reporting screen denotes a SUSAR (Suspected Unexpected Serious Adverse Reaction) case.











Print Reports in Bulk


	Field	Description
	Blind Study Product	Check this checkbox to print study cases with blinded information.
	Mark as Submitted	Check this checkbox to mark reports as Submitted when the transmission/email has been sent.
A dialog box is displayed is this checkbox is not selected. This dialog box prompts you to confirm if the report is to marked as submitted or not.

Select Yes or No, as required. This selection is remembered for the next time when you print a report.


	Print Medical Summary	Allows the user to print the Medical Summaries.
	Print	Allows you to choose the printer for the selected report from the Select Site Printer dialog box.
Select the Site and Printer Name where you wish to print the report and click OK.


	Print List	Allows the user to print the current view of the Bulk Reporting.









Sort Cases

To sort the cases based on the case status, click the Lock State header row.

	
Lock State


	
SUSAR


	
Exp/Per




These options enable you to sort cases based on the case categorization.




	
Tip:

The icon (displayed in the lock state) in the Reports > Bulk Reporting screen denotes a SUSAR (Suspected Unexpected Serious Adverse Reaction) case.











Lock State Icon Options

Click the Lock State icon to view the list of available options.


	Field	Description
	View Report	Displays the Draft report.
	Report Details	Displays specific information about the report as entered in the Regulatory Reports section.
	Case Summary	Displays the Case Summary dialog box.
	Remove Report	Deletes the report from the case on being asked for a justification.
	Mark for Non-Submission	Displays the Submission tab in the Report Details dialog box.
Select No for Mark for Non-Submission and enter the reason for the non-submission.















Track your Periodic Report Submission


Use Submitted Reports Search Results


	Field	Description
	Time Frame (I/F-u)	Displays the whether the report was initial or follow-up.
	Product	Displays the first suspect product for the case on which the report is based (expedited reports).
	License Type	Displays the license type of the report.
	Primary Event	Displays the first event term for the case on which the report is based (expedited reports).
	Reason for Scheduling	Displays the reason provided for scheduling the report.
	Report Form	Displays the type of report scheduled (form) and initial/follow-up status (e.g. "Initial Report" or "Follow-up #3").
	Submitted Date	Displays the report's submission date.
	Case Del. Date	Displays the date when the case was deleted.
	Blind Study Product	Enables you to mark the study product as blinded. When you manually schedule a report, the system enables you to check Blind Product Study on the Schedule New Expedited report dialog box to blind the study products if they are in the case.
	Print All Submitted Reports	Enables you to print all the submitted reports.









Reopen Submitted Reports

Cases that are archived while unsubmitting reports can be reopened from the Archived Case dialog box.

	
Enter the password and notes required in the Archived Case dialog box.


	
When the system opens the Report Unsubmit dialog box, enter the reason for unsubmitting the report and click OK.


	
The system unsubmits the report.







	
Tip:

The icon (displayed in the lock state column) in the Reports-> Compliance - Expedited and Submitted screens denotes a SUSAR case.











About Initial and Follow-up Cases in Periodic Reports

A case is categorized as follow-up only if it has been previously submitted to the same regulatory agency, report form type and configured product/licenses or study. Otherwise, it is considered initial.





View Batch Reports Scheduled for Generation

	
To view this list of System, Expedited, and Periodic reports that scheduled for generation, from the Utilities drop-down menu, select Batch Reports.


	
To delete a batch report, select the corresponding checkbox, and click Delete.













9 Multi-Tenancy

This chapter describes multi-tenancy and the Global Portlets in Argus Safety that are used to manage work across multiple clients in a multi-tenant environment.


Know more about Multi-tenancy

Multi-tenancy refers to a principle in software architecture where a single instance of the software runs on a server, serving multiple client organizations (tenants).With a multi-tenant architecture, the software application is designed to virtually partition its data and configuration so that each client organization works with a customized virtual application instance.


Use Multi-tenancy in Argus Safety

In Argus Safety, multi-tenancy allows an organization to use a single database for multiple clients. For example, Contract Research Organizations (CROs) offer a range of global safety and pharmacovigilance services, from limited case management activities to full clinical trial and post-marketing services.

The multi-tenancy feature achieves the following:

	
Allows multiple pharmaceutical clients of a CRO to reside as separate and unique tenants in a single database, with their data completely segregated and restricted to authorized users.


	
Enables the CRO to achieve standard configuration across clients while at the same time provides the ability to a CRO to have differentiation in configurations to specific clients as required. CROs use this feature to quickly set up a new client based on existing configuration and authorize users to the new client.


	
Provides the ability to CRO users who have access across multiple clients to view their work across clients, understand their sum of work across clients and make decisions based on the priority.




Argus Safety assists manufacturers of pharmaceuticals and devices by providing a simple and efficient way to comply with international and domestic regulatory safety reporting requirements. It also facilitates internal company safety surveillance by providing tools for signal detection and for analyzing the overall safety profile of both investigational compounds and marketed products.

Contract Research Organizations (CROs) provide services to pharmaceutical and device manufacturers, which range from case management activities to clinical trials. The multi-tenancy feature allows an organization to provide services to many clients while keeping client data isolated.

Multi-tenancy is enabled during the Argus Safety installation. Policies and rules are centrally administrated and shared, with the option to personalize for each client.





Perform Data Segregation

Multi-tenancy allows an organization to use a single database for many clients, which reduces the amount of hardware needed for an implementation. Fewer patches and dictionary upgrades are required, which decreases the resources necessary to support an implementation. This also allows administrators to use standard configurations, such as code lists, workflow steps and user/new client setup.

The entire Argus Safety application and all of its components and data are partitioned by Enterprise ID. The Enterprise ID is a unique identifier for a customer's client and contract. The appropriate context of the Enterprise ID selected by the user that the user has access to, is set by the system and operates within the partition of this context.


Data Segregation by Module

The following table describes how each module in the Oracle Health Sciences Safety suite provides data segregation in a multi-tenant environment.




	
Note:

It is not recommended that you open the Argus Safety application for multiple enterprises at the same time. Close the Argus Safety application for the previous enterprise before opening it for the next enterprise to avoid data issues.
It is recommended that you use the Application Access portlet to open the Argus Safety application for different enterprises, as it takes care of closing the previous enterprise before opening the new one.










	Module	Cross Enterprise?	Accessed Via Portal?	Notes
	Global Worklists	Yes	Yes	Displays data from across multiple enterprises
	Global User Management	Yes	Yes	Displays data from across multiple enterprises
	Global Enterprise Management	Yes	Yes	Displays data from across multiple enterprises.
	Applications Access	Yes	Yes	Displays Application Access options from across multiple enterprises
	Argus Safety	No	No	Displays data for one enterprise at a time to the logged-in user based on the selected enterprise.
	Argus Console	No	No	Displays data only for the enterprise for which Argus Safety was opened by the user.
	Argus Affiliate	No	No	Displays data for one enterprise at a time to the logged-in user, based on the selected enterprise.
	Argus Unblinding	No	No	Displays data for one enterprise at a time to the logged-in user, based on the selected enterprise.
	ESM Mapping Utility	No	No	Displays data for one enterprise at a time to the logged-in user, based on the selected enterprise.
However, the screens related to ESM Service Configuration display data related to all the active enterprises, irrespective of the user access rights to those enterprises.


	Argus Interchange Service	Yes	No	ESM Service process data from all the enterprises, as it is a background service.
	ESM Service Configuration	Yes	No	As ESM Service is common across all the enterprises, hence its configuration tool is also common.
	Argus Safety Service	Yes	No	Argus Safety Service processes data from all the enterprises as it is a background service.
	AG Service Configuration Tool	Yes	No	As AG Service is common across all the enterprises, hence its configuration tool is also common.
	MedDRA Re-code Tool	Yes	No	Allows the option to perform recoding of MedDRA terms across the enterprises.
	MedDRA Dictionary Load	Yes	No	Single instance/version of the loaded MedDRA dictionary is available for all the enterprises.
	Who Dictionary Load	Yes	No	Single instance/version of the loaded WHO Drug dictionaries (B2 as well as C formats) is available for all the enterprises.
	MedDRA/WHO Web Services	Yes	No	These web services remain common to be used across all the enterprises. Their configuration is maintained in a common XML file on the web server(s).
	J Drug Dictionary	Yes	No	Single instance/version of the loaded J Drug dictionary are available for all enterprises.
	Case Intake	No	No	Case Intake messages for separate enterprises are segregated and loaded into appropriate enterprise partitions.
	Literature Intake	No	No	Literature Case Intake data for separate enterprises are segregated and loaded into appropriate enterprise partitions.
	New Case from Image	No	No	Scanned Image folder paths for separate enterprises are segregated and loaded into correct enterprise partitions.
	PSL	No	No	The PSL interface segregates the incoming requests for each enterprise partition.
	DLP	No	No	Partitions the case revisions by enterprises.
	TMS Integration	No	No	TMS integration for single-pharma installations only.
	Argus Dossier	No	No	As this module is linked to Periodic Reports, hence it partitions the periodic reports data by enterprise.









Data Segregation impact on system-level configuration items

The following table specifies some specific system-level configuration items which are configured through Argus Console. It specifies the impact on these configuration items due to data segregation design for multi-tenant installations and also specifies the recommendations for customers on these items.


	Configuration Item	Application Design	Recommendation for Customers
	Enable/Disable MedDRA/WHO Web Service Encoding	System keeps it segregated for each enterprise.
However, the underlying web service used for MedDRA/WHO is common for all the enterprises as their configurations are maintained in common XML file on the web server(s).

	None
	Lot Number Web Service configuration	System keeps it segregated for each enterprise.	As this is related to the product, Oracle recommends you keep it specific for each enterprise.
	Documentum Configuration	System keeps it segregated for each enterprise.	All parameters except for Cabinet Name are expected to be maintained as same for different enterprises.
	Enable/disable LDAP
&

LDAP Server configuration

	This will be maintained by application as common for all enterprises.	None
	Enabled Modules	The system keeps it segregated for each enterprise.	None
	Enable/disable SSO
&

SSO Header Configuration

	This will be maintained by application as common for all enterprises.	None
	Argus Insight URL	System keeps it segregated for each enterprise.	It is expected to be maintained same for across all enterprises by the customer.
	Argus Safety Load Balancer Server	System keeps it segregated for each enterprise.	It is expected to be maintained same for across all enterprises by the customer.
	User Information	System keeps it segregated for each enterprise.	For multi-tenant installations, user attributes can be synchronized for all the enterprises through Global User Management.
However, user attributes can also be updated for a specific enterprise through Console as well.


	Default Enterprise	System keeps it segregated for each enterprise.	This is a new internal common profile switch that marks an enterprise as the Default enterprise. This is set during the time of install. Default enterprise once created during database creation is fixed. This is required to avoid the data synchronization issues that may occur for AG Service users in different enterprises.
	SMTP Configuration	System keeps it segregated for each enterprise.	None









Dictionaries

All dictionaries are stored in database schema separately outside Argus Safety and Interchange schema. The Argus-supported dictionaries are:

	
MedDRA


	
MedDRA J


	
WHO Drug


	
J Drug




Only one copy of each dictionary version is maintained in the database and it is not segregated by enterprise. The dictionary version that is applicable for a particular enterprise/client is defined in these common profile switches: Case Form Configuration' Auto Encoding, Dictionary & Central Encoding. Since these switches are segregated by each Enterprise, these dictionaries can have different versions for different enterprises, as required.J Drug dictionary is not configured through Console common profile switches (Case Form Configuration' Auto Encoding, Dictionary & Central Encoding), and is internally maintained as single version, therefore, it remains a common J Drug dictionary for all enterprises.


Coding Web Service

The Case Processing Dictionary Browser common profile switches are segregated by enterprises to allow different configurations for different enterprises.

However, the URL and other configuration for WHO Drug and MedDRA web services remain in configuration XML on the Web Servers as per existing design and hence remain common across all enterprises.

In a multi-tenant installation, if the provider chooses to operate using Coding via web service, they should use the same web service across all enterprises.











Filter Worklists

Global Worklists allows you to filter the worklist to a specific enterprise where you have access. When filtered to a specific enterprise, any further operation on the retrieved worklist items are restricted to that enterprise.

For unauthorized users, the Global Worklist is not visible and their access remains restricted based on portal privileges. The context menu on the Global Worklist displays menu items according to rights and permissions of a user in a particular enterprise.

The user preferences of each Global Worklist are saved for the user each time the Worklist is loaded.


Use Options in Global Worklists Tab

	
Worklist New: displays the list of new cases across all the enterprises or a specific enterprise, that the user has access, as well as cases assigned to user/ group but not yet accepted.

[image: Surrounding text describes ghpgw-worklistnew_sm.png.]

	
Worklist Open: displays the list of new cases across all the enterprises or a specific enterprise, that the user has access, as well as cases assigned to user/ group but not yet accepted.


	
Worklist Contacts: displays the list of pending letters and allows you to generate the letters.


	
Worklist Action Items: allows the owner of the action item and workflow managers to view and/or close the selected action item.





Link to Argus Safety

	
Case number - hyperlink on the case number allows you to open the case in the Argus Safety application, with context set to the enterprise that the case belongs to.


	
Enterprise - hyperlink on the Enterprise Short Name allows you to open Worklist-Open in the Argus Safety application, with context set to the enterprise that the case belongs to. The Worklist opens with preferences configured for you in that enterprise.










Perform Case Actions

	
Open Read-only - opens the case in read-only mode in the Argus Safety application, with context set to the enterprise that the case belongs to.


	
Accept Case - accepts the case and assigns your user name as responsible for that case


	
Adjust Priority - modifies the priority level of the case


	
Adjust Assignment - modifies the user assigned to the case, limited by your access to the enterprise and the case


	
Adjust Case Owner - modifies the owner of the case, limited by the your access to the enterprise and the case


	
Close Case - closes the case after entering the Case Closure details


	
Coding Review - opens the exiting Argus Safety Coding Review screen as a dialog box and supports all existing actions within this dialog box


	
Medical Review - opens the Argus Safety Medical Review screen as a dialog box and supports all the existing actions within this dialog box


	
Print/Print List - prints the current Worklist







	
Note:

Multiple case actions are not supported, such as: Close Multiple Cases, Route Multiple Cases, Print Multiple Cases and Assign Multiple Cases











Search for a Case

The list of cases displayed in the worklist include active enterprises where you have access. Your view is restricted to the search criteria result set, entered into the Value search field. You may filter the content of this worklist to a specific enterprise. When there is no filtering applied, all cases across enterprises are displayed.


Filter

You can filter your search by the following:

[image: Surrounding text describes ghpgw-worklistnewfilter.png.]





	
Note:

Items that are unavailable will not appear in the filter list.








Value

Once you have selected an item to filter by, the Value field loads the corresponding choices. For example, select Product and the list of Products loads into the Value field. You can also type into the field to search the list.


Only view locked Cases requiring Follow-up

Select the Only view locked Cases requiring Follow-up option to limit your search to these types of cases.

[image: Surrounding text describes ghpgw-searchcase.png.]


View Options

Your view options for Worklist New are Individual, Group or All. Individual is the default selection.

	
Select Group to list all cases across authorized enterprises, which are assigned to any other member of groups that you are a member of and that have not yet been accepted by the assigned user.




[image: Surrounding text describes ghpgw-worklistnewview.png.]

	
Select All to view every open case across all user groups and enterprises (or specific enterprises) where you have access.





List Actions

	
Sorting - sort by any list header


	
Pagination - select page size and number of displaying rows.












Manage Global Enterprises

From the Global Enterprise Management tab, you can:

	
Add a new enterprise


	
Define new enterprise attributes


	
Copy configuration from an existing enterprise


	
Associate users to the new enterprise








Add a New Enterprise

	
Click Add New Enterprise.


	
Enter information about your Enterprise. Enterprise Name and Enterprise Short Name are required fields.


	
Click Next.


	
Select an Enterprise to use as a template for your new Enterprise from Copy Configuration Data Source. You can makes changes to the configuration once the enterprise has been set up.


	
Click Setup.


	
Click Finish.









Manage Global Users

Global User Management is intended to configure users across multiple enterprises. When user configuration changes need to affect only a specific enterprise, it needs to be done from the Argus Safety Console: User Management screen for that enterprise. Your access is restricted depending on your access to this Portlet at the Portal server level.

This release allows local users (Argus J user in this release) to locally lock a case for which local Japan data entry/assessment is complete, triggering the scheduling and/or generation of the applicable local reports. The system has also been enhanced to allow a local user to locally unlock the case after a local lock is done and modify local data.

A new checkbox called Allow Local Locking has been provided under Argus Console > Access Management > Users to allow a local user to be set up with the privilege to locally lock or unlock a case. By default, the checkbox is unchecked.

See the Oracle Argus Safety Administrator Guide for more information.


Browser

The browser displays a left hand pane that lists the existing users (distinct users based on Login User ID) in the system, in a tree view. The tree displays users from the enterprise partitions for which the user has access.

[image: Surrounding text describes ghpgum-browser.png.]


Associate Users to an Enterprise

To associate existing users from one enterprise to other enterprises:

	
Select an enterprise from Copy User Attributes From. The enterprise selected is used to set the attribute values for the user in the new enterprise to which the user is being associated. The attribute values for the already associated enterprises remain the same.


	
Add an Available Enterprise or Add All available enterprises.


	
Select Save.




[image: Surrounding text describes ghpgum-associate.png.]

During Save, all the user attributes are copied from the Enterprise selected in the Copy User Attributes From to all the newly associated Enterprises.


Print

Click Print and select Current User or All Users. Based on the selection, you can print the User details of the current User or all Users.







Apply Synchronizable User Attributes

The purpose of the Synchronizable User Attributes section is to allow you to apply updates to user attributes displayed in this section, and keep them in sync across all enterprises.

The users that are listed to be administered in this screen are restricted by the following rules:

	
Admin, System users and the users for which the Service User is checked in Console are not listed.


	
Only the users from the enterprises for which you have access to the Console User management screen, i.e. you should have access to all of the following in those enterprises:




	
Console User Management screen ' Application Access field ' Console checkbox is checked.


	
Console Group Management screen ' Menus section ' Console, Access Management and User radio options are set to enabled at least for one user group in the respective enterprise partition.


	
Is not marked as "Account Disabled"




[image: Surrounding text describes ghpgum-main.png.]

When you select the Synchronize User Attributes tab, the right hand pane displays a list of enterprises to which the user being administered belongs to. The right hand pane displays a list of Synchronizable user attributes in a grid.




	
Note:

If you make changes to the data on one of these tabs and attempts to move away from this current tab without saving the changes, then the warning message "You have made changes to the existing item, if you press OK, changes will be lost." displays. Click OK to ignore changes. Click Cancel to stay on the current tab.











Modify User Attributes

The value of the Synchronizable fields can be modified for a specific enterprise using Argus Console>User Management>Access Management so that these attributes can be different for that enterprise as compared other enterprises.

If User Name and Email address fields are updated in Argus Safety Console for a user which belongs to multiple enterprises, an error displays.







Provide Access to the Application

Application Access allows you to launch Argus applications for any enterprise where you have access.

[image: Surrounding text describes appacc.png.]

It is recommended that you should NOT open the Argus Safety application for multiple enterprises at the same time. Close the Argus Safety application for the previous enterprise before opening it for the next enterprise to avoid data issues.

It is recommended that you use the Application Access portlet to open the Argus Safety application for different enterprises, as it takes care of closing the previous enterprise before opening the new one.


Enterprise

Select Enterprise to display a list of active Enterprises to which you have access and is not marked as Account Disabled. The list is alphabetically sorted by Enterprise Short Names. This first Enterprise in your list is selected by default.





Application

Application lists the Argus applications that you can launch from the Application Access tab. The application lists only those options, which are enabled in the selected enterprise in Argus Safety Console >User Management > Application Access.

	
Argus Safety - Opens the Argus Safety application homepage with the context set to the selected Enterprise.




	
Tip:

For an Affiliate user, this opens as Argus Affiliate application for the selected enterprise. This action will not open the Insight application, even if it is configured as the Default Application in Argus Console.








	
Argus Safety Case Book-In - Opens the Case Book-in screen within the Argus Safety application, with the context set to the selected enterprise. This action does not launch the Argus Insight application, even if your default Application is Argus Console.

Argus Safety allows new Case Book-In to be done aided by an image file where an image file can be selected from a pre-defined folder and allows you to fill-in the case book-in parameters manually using the details available on the image file.

In multi-tenant installations, the common profile switch defined as Case Processing - Default Network directory for scanned images is partitioned by enterprise/client, allowing you to define separate image folders to accept company-specific image files for New Case from Image functionality.




	
Tip:

For an Affiliate user, this opens the New LAM Event Entry screen within Argus Affiliate application for the selected Enterprise.













	
Note:

Argus Safety, Argus Affiliate, Argus Safety Case Book-in and Argus Affiliate Event Entry options only display if the user has access to these modules and have User Group menu level access to these screens in the respective enterprises.
Open each of the applications - Argus Safety and Insight in separate windows independent of each other. However, if you attempt to open the same application again for same/different enterprise, then it opens in the same window in which that application is already opened.


















Oracle Legal Notices
Copyright Notice
Copyright © 1994-2013, Oracle and/or its affiliates. All rights reserved.
Trademark Notice
Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.
Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.
License Restrictions Warranty/Consequential Damages Disclaimer
This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.
Warranty Disclaimer
The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.
Restricted Rights Notice
If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:
U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.
Hazardous Applications Notice
This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.
Third-Party Content, Products, and Services Disclaimer
This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.
Alpha and Beta Draft Documentation Notice
If this document is in preproduction status:
This documentation is in preproduction status and is intended for demonstration and preliminary use only. It may not be specific to the hardware on which you are using the software. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to this documentation and will not be responsible for any loss, costs, or damages incurred due to the use of this documentation.
[image: Oracle Logo]
OEBPS/img/ghpgw-worklistnew_sm.png
Glohal Worklsts  Global taterprae Mansgement  Global User Management  Apphcation Access.

Wk okl Open Workdt Contacts Workdst Acton s





OEBPS/img/medra_enterprise.jpg
MedDRA Re-code
Enterprises: Existing MedDRA Version t Re-Cad:
[Mypharma ABC = [

|Workd Pharma
Nete - Cases willhe re-coded to the

'z‘ MedDRA version configured in Console.
forthe respectve Enterries.

~Case Data pdteView Options (Currency detrmined o LT level rly)

I Frocess Current Terms (Using Prinery SO Pty

I Process Non.Curent Tenns (Using Prinry SOC Path)
|- Ut ctionary versio fo et ems where exitng Herarchy i <t
chient

 Upclte Data & View orly

Note - Cases using Study Specific Dictionaries wil NOT be included inthe Re-Cacle

[~Output Log File Options:
Comman Delinter

[ TN —|

" Excel Fie (LS Flle) (Recpires Microsoft Office)

LogDiectory: [

Select Log Directory.

F=]

G Bz

Status:






OEBPS/img/lockedcase.gif





OEBPS/img/glbl2.jpg





OEBPS/img/pendingactionitems.jpg
Personal Argus Status

Case Quick Launch [ [co0pen ]

Cases Assigned (0) =
(Country) Case Number . Report Type L

Contact Log Entries (0) =

Action Htem Entries (8) M Overdue Action Hems.

(US)E20GOLDB ‘Gase Product Doxorubicn or Comparator sent for QC requires folow up o
(us) EXP 02 ‘Gase Product ‘Doxorubicin or Comparator’sent for Q requires follow up

w2 ER K ‘Gase Product Doxoruticin o Comparator’sent for QC fequires follow up

(us)Exe 10 ‘Gase Product Doxorubicin or Comparator’sent for QC requires follow up

ws)conz Based on studies DOXO1, this case satisfies the criera or an investigator alert

(us)coLDza Based on studies DOXO1,this case satisfies the crieria for an investigator alert

(US)GOLD cAsE Gase Product US Markeled Device'sent for OC requires fllow up.

(UZ) MAX REP AND LIT CASE ‘Case Product Doxorubicin or Comparator’ sent for QC requires follow up.





OEBPS/img/icsrcheck.gif





OEBPS/img/glbl3.jpg





OEBPS/img/closecase.gif





OEBPS/dcommon/oracle-logo.jpg
ORACLE

Argus Safety User's
Guide, Release
8.1.2





OEBPS/img/wthoutnf.gif





OEBPS/dcommon/oracle-logo.jpg
ORACLE

Argus Safety User's
Guide, Release
8.1.2





OEBPS/img/utilities.gif
Local Affiliate






OEBPS/img/glbl1.jpg





OEBPS/dcommon/oracle.gif





OEBPS/img/opencase.gif





OEBPS/img/stop.gif





OEBPS/img/opencase.jpg
ORACLE" Argus Safety

[ otve Coses | Woriet | _CaseActions | _Repors | Locatamiats | _uuites | Deshboaras ||_Argus ConsoreJ|_Araus wigne
ase Actions > New Case

o New Cttoatony

Initial Case Entry New Case fom image__(CuAteG)

‘Weicome Administrator, Thursday, November 17, 2016 (AS_TOPGUNS)






OEBPS/img/susar.gif





OEBPS/img/printcasetab.gif





OEBPS/img/savecase.gif





OEBPS/img/dupsearch.jpg
/egn Suey D Susy DSy UNTED STATES

180

faawne OrgnalCese umber Tessage tumber
e Ueseisvsarmesr i
T prosucttume (e ™ hosortTime e — T
T Generctume (8007 T o ™ cortero
o © ristome [ © coumtr otcidence T sue
s © Lnttome ane e races ¥ T posuicose
™ patenitime e T aperonis B s 9] T ewoon
™ tventoosc ™ Omsettute C [ —
T Reference T Keyword L
[ e i
itcsson esson
= =] e e e
. - =8 —
Lock | Case umber - ProjectiD. Oste. ‘Product Report Type
50 | it Sty Comt0) e Reporer
& oz Sorbom S
= prescesety an FEET
[
& — SIS, L e e
fiorpel a5 et 8ot Ot 8 Raras et 30U D SABh ot a4
- I s RepEng END begin iast name ast name st
ey
ign Proci O Propct © ‘bagn Study name Study name Study name Stugy nama Stugy 2497 RepertType Repart ENO
S e ovsszan pecsbedery it i
=

Begr Descroton a8 Reporss escratn s Rgorss

Dekecion s Resors encoion e 18 N






OEBPS/img/ghpgw-worklistnewfilter.png





OEBPS/img/japaneseflagicon.gif





OEBPS/img/wait.gif





OEBPS/img/quicklaunchtbr.gif
) () = B 22 )






OEBPS/img/glbl.jpg





OEBPS/img/codingreviewtab.gif





OEBPS/img/unlockedcase.gif





OEBPS/img/verbatiam.gif





OEBPS/img/ghpgw-worklistnewview.png
Group Membership

Al [v]

View @ Individual O Group O Al





OEBPS/img/forwardcase.gif





OEBPS/img/newcase.gif





OEBPS/img/withnf.gif





OEBPS/img/wrklistnew.jpg
Reports Local Affliate Utiiies | Dashboards ||  Argus Console.

i

Bulk Transmit
Bulk Print

Buk ICSR Transmit i) Product

Local Labeiing
Coding Status
Letiers
Intake






OEBPS/img/newcaseform.gif





OEBPS/img/lettericons.jpg
Icon  Status
Letter scheduled is awaiting to be sent
Letter is overdue (Date Open > System Date)

Clicking on the email button should open a message editor

KRR

Indicates Mail success status.





OEBPS/img/medicalreview.gif





OEBPS/img/bpres.jpg
Background Periodic Report Execution Status

SSSSSIS






OEBPS/img/globalflagicon.gif





OEBPS/img/lockcase.gif





OEBPS/img/codereview.gif





OEBPS/img/appacc.png
Emerprise | DFLT > Apphcaton  Wiois Safetv v| [ Ooen ]






OEBPS/img/verbatimy.gif





OEBPS/img/ghpgum-browser.png





OEBPS/img/casesassigned.jpg
| ActiveCases | Worklist | CaseActions | Reports | LocalAffiiate | Ufiliies | Dashboards || ArgusConsole || Argus Insight

Home > Personal Argus Status.

Personal Argus Status

Case Quick Launch Open

(Country) Case Number . Report Type Product





OEBPS/img/acs.jpg
2 Advanced Condition, - Webpage Dialog,

Advanced Condition Set

tame [ Description

HitList
Properties
" Case Centra Safely e
{0} Case Classifcation ot equalto
= greater than
{0 case creaton Time: 7| -

) case Foouup s o Eesinen

R oo A e Sarnrsne

13 Case Last Undals Dot and i oy

) case Last Upcate User

r———"

[ Cose Repor Type 8
fed  [CaasRepertives ] ofm...caum,
Value B

SromeiT

Jontancous e with other users =N

. Value






OEBPS/img/printcase.gif





OEBPS/img/worklist.gif





OEBPS/img/overduereps.jpg
Due Date
Days Past Due
Days Open.





OEBPS/img/draftreport.gif





OEBPS/img/personal_argus_status.gif
Active Cases ‘Worklist Case Actions Reports Local Affiliate Utilities Dashboards Argus Console
Home > Personal Argus Status HE=)
Personal Argus Status
‘Case Quick Launch Open
=]
(Country) Case Number . Report Type Product Workflow State Event
(=)
(Country) Case Number - Contact Date Description
L]
(Country) Case Number . Due On Description

(Us)
Us)
vz)
(Us)
(Us)
Us)
Us)
vz)

Case Product ‘Doxorubicin o Comparator sent for QC requires follow up
Case Product ‘Doxorubicin of Comparator sent for QC requires follow up

Case Product ‘Doxorubicin o Comparator sent for QC requires follow up

Case Product ‘Doxorubicin of Comparator sent for QC requires follow up

Based on studies DOX001, this case satisfies the criteria for an investigator alert
Based on studies DOX001, this case satisfies the criteria for an investigator alert
Case Product 'US Marketed Device' sent for QC requires follow up

Case Product ‘Doxorubicin of Comparator sent for QC requires follow up






OEBPS/img/validacheck.gif





OEBPS/img/ghpgum-associate.png





OEBPS/img/newcase.jpg
Home

Welcome Administrator, Thursday, November 17, 2016 (AS_TOPGUNS) Sl

.
e o s O 0 —

ORACLE" Argus Safety
[ et con | o | Gonenctoms | epors | Cocarmmioe | e
Home > Personsl Argus Status | OPen L

Personal Argus Status

New: mimage _ (Cii+Al+G)

]






OEBPS/img/imagej.jpg
viii.

ix.

ERREE FIHEET 1 - 2 (Mktd1,2)
HEEEFEREE FFFELS - 4 Oktd 3, 4)
SETOBERE BIEERS - 6 (ktd 5, 6)
 EMEEE RN - 2 (ol O
HEEEFEREE AEFELS - 4 (w3,
L SETOBRERE BIRRERS - 6 (lays, 6)
EHNS: BEEMETES FEEAIREE

EHN0: ERUEORREESHERSE SEEERERS

E2B

&





OEBPS/img/prdtbt.gif
PERIODIC REPORTS

oo

vy [V
ResorDenss

ar

m

0509209 124502
05002008 124502
06002008 124502
5002008 124502

Dispiayng s

John ierL
Antrew Smith Poter
sormsm
e

s 1





OEBPS/img/locking.jpg





OEBPS/img/ghpgum-main.png
¥ Userld

o
[ Enable LOAP Login
1 LOAP Senver Alas
[ Appicaton Access

Defult Appication
Accowt Disabied

‘Worklst to display at Login
User Roles

oooo

7/ Console

s

o






OEBPS/img/ghpgw-searchcase.png
Filter

Case Number






OEBPS/img/english.gif





OEBPS/img/codingreviewactionitem.gif





OEBPS/img/devpmda17.jpg
soc estgsions
HLeT [ ————
T tommnty ssyses

Pr [orE——

ur Poson

svn

Seicted:

soc wsogsons

HeT R —
hr [ —

Pr et sty st

ur

svn






OEBPS/img/greynf.gif





OEBPS/img/medreviewtab.jpg
w - Case Form - 13US000012

|icaeaaR] rempors view, [ Acton s  ddtinio |

[vical Review ¥][iewpan ]

e s B M o] [CoseConvent ]
T |

[y T—

EBEl .
TLico01_US_Mirkbrg. pain (pain)
L caaune L panlsd]

|

[ FommoGme | ssesmoCine ][ GCancei ]






OEBPS/img/periodicsub.gif





OEBPS/img/returncase.gif





